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Safety Notices

Read all product manuals and consult with Beckman Coulter-trained personnel before attempting 
to operate instrument. Do not attempt to perform any procedure before carefully reading all 
instructions. Always follow product labeling and manufacturer’s recommendations. If in doubt as 
to how to proceed in any situation, contact us.

Beckman Coulter, Inc. urges its customers to comply with all national health and safety standards 
such as the use of barrier protection. This may include, but it is not limited to, protective eyewear, 
gloves, and suitable laboratory attire when operating or maintaining this or any other automated 
laboratory analyzer.

This manual assumes that users have basic knowledge of the Windows operating system, as well as 
experience working with laboratory testing technology. Users are invited to consult the 
appropriate documentation for such information.

Alerts for Danger, Warning, and Caution

DANGER

DANGER indicates an imminently hazardous situation which, if not avoided, will 

result in death or serious injury.

WARNING

WARNING indicates a potentially hazardous situation which, if not avoided, could 

result in death or serious injury.

CAUTION

CAUTION indicates a potentially hazardous situation, which, if not avoided, may 

result in minor or moderate injury. It may also be used to alert against unsafe 

practices.
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Safety Notices

Safety Precautions  
Safety Precautions

WARNING

Risk of operator injury if:

 • All doors, covers and panels are not closed and secured in place prior to and 

during instrument operation.

 • The integrity of safety interlocks and sensors is compromised.

 • Instrument alarms and error messages are not acknowledged and acted upon.

 • You contact moving parts.

 • You mishandle broken parts.

 • Doors, covers and panels are not opened, closed, removed and/or replaced 

with care.

 • Improper tools are used for troubleshooting.

To avoid injury:

 • Keep doors, covers and panels closed and secured in place while the 

instrument is in use.

 • Take full advantage of the safety features of the instrument.

 • Acknowledge and act upon instrument alarms and error messages.

 • Keep away from moving parts.

 • Report any broken parts to your Beckman Coulter Representative.

 • Open/remove and close/replace doors, covers and panels with care.

 • Use the proper tools when troubleshooting.

CAUTION

System integrity could be compromised and operational failures could occur if:

 • This equipment is used in a manner other than specified. Operate the 

instrument as instructed in the product manuals.

 • You introduce software that is not authorized by Beckman Coulter into your 

computer. Only operate your system’s software with software authorized by 

Beckman Coulter.

 • You install software that is not an original copyrighted version. Only use 

software that is an original copyrighted version to prevent virus 

contamination.

CAUTION

If you purchased this product from anyone other than Beckman Coulter or an 

authorized Beckman Coulter distributor, and, it is not presently under a Beckman 

Coulter service maintenance agreement, Beckman Coulter cannot guarantee that 

the product is fitted with the most current mandatory engineering revisions or 

that you will receive the most current information bulletins concerning the 

product. If you purchased this product from a third party and would like further 

information concerning this topic, contact us.
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Safety Notices

Symbol Explanations  
WARNING

This product can expose you to chemicals including phthalates, which are known 

to the State of California to cause cancer and birth defects or other reproductive 

harm. For more information go to www.P65Warnings.ca.gov.

CAUTION

Risk of instrument damage. This device is intended for indoor use only. To avoid 

device damage, do not install the instrument outdoors.

WARNING

Risk of personal injury. Safety protection can be impaired if used in a manner not 

specified by the manufacturer. To avoid personal injury, use the instrument 

according to the manufacturer's instructions only.

Symbol Explanations 

Symbol meanings

Consider all materials (specimens, reagents, controls, and monoclonal antibodies) and 

areas these materials come into contact with as being potentially infectious.

Wear appropriate barrier protection and follow safe laboratory procedures when handling 

any material in the laboratory.
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Introduction

Overview

This introduction contains the following information:

 • How to Use Your Manual

 • About this Manual

 • Conventions Used

 • Graphics

How to Use Your Manual

Your CytoFLEX flow cytometer system includes the manuals listed below:

 • Use this Instructions for Use manual for information on the day-to-day operation of your 
CytoFLEX flow cytometer. You can find detailed step-by-step procedures for Daily Startup and 
Quality Control, configuring settings, running samples, analyzing data, and performing Startup 
and Shutdown. This manual also contains physical and system specifications, safety and 
troubleshooting information, as well as information about what your CytoFLEX flow cytometer 
does and the methods it uses. It also contains procedures for cleaning and replacement.

 • The CytoFLEX Setup Guide provides instructions for unpacking and setting up the CytoFLEX 
flow cytometer system.

 • The CytoFLEX S Special Configuration Specifications package insert contains the sections and 
procedures that are specific to the CytoFLEX S instrument. Use the CytoFLEX S Special 
Configuration Specifications package insert along with your Instructions for Use manual.

About this Manual

The information in your Instructions for Use manual is organized as follows:

CHAPTER 1, System Overview

Provides information regarding the individual components of the CytoFLEX flow cytometer and the 
corresponding functions of these components. 

CHAPTER 2, Using the CytExpert Software

Provides an overview of each aspect of the software’s functions.
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Introduction

About this Manual  
CHAPTER 3, Daily Startup

Provides instructions for starting your CytoFLEX flow cytometer and navigating to the sample 
testing standby state.

CHAPTER 4, Instrument Quality Control and Standardization

Provides instructions for performing daily quality control (QC) on your CytoFLEX flow cytometer to 
confirm the instrument is working correctly and to ensure accurate experimental data 
measurement. Quality control allows you to determine whether your instrument can provide 
adequate signal strength and precision.

CHAPTER 5, Data Acquisition and Sample Analysis

Provides instructions for operating the CytoFLEX instrument, including data acquisition, analyzing 
and exporting results, and manually adjusting the compensation during the acquisition and 
analysis.

CHAPTER 6, Compensation

Describes how to create a compensation experiment and automatically calculate compensation 
values after acquiring the single color data. It also explains how to use these calculations for other 
experiments.

CHAPTER 7, Data Review

Describes how to use the Analysis screen to analyze data that has already been acquired. 

CHAPTER 8, Daily Shutdown

Describes how to keep the instrument in optimal condition through daily cleaning during the 
shutdown procedure.

CHAPTER 9, Troubleshooting

Describes some common problems and their solutions in a basic troubleshooting matrix.

CHAPTER 10, Cleaning Procedures

Describes how to carry out certain routine and nonscheduled cleaning procedures.

CHAPTER 11, Replacement/Adjustment Procedures

Describes how to carry out certain routine and nonscheduled replacement and adjustment 
procedures. 

CHAPTER A, Instrument Installation

Provides the instrument installation procedures for your CytoFLEX flow cytometer.

APPENDIX B, CytExpert Electronic Record Management

Provides the instructions for using the CytExpert Electronic Record Management software option.

APPENDIX C, Sample Injection Mode Control Kit

Provides the instructions for using the CytoFLEX Sample Injection Mode Control Kit.

APPENDIX D, Deep Well Plate

Provides a list of deep well plates suggested for use on the Plate Loader DW.

APPENDIX E, Custom Optical Filters

Describes how to install the custom optical filter. 
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Conventions Used  
APPENDIX F, Table of Hazardous Substances

Provides the table of hazardous substances with the hazardous substance name and concentration.

Conventions Used

This document uses the following conventions:

 • Bold face font indicates buttons or selections that appear on the workstation screen.

 • The term “select” is used to indicate the following action:

— To click with a mouse.

NOTE The verb “press” is reserved for mechanical buttons, such as keys on the keyboard.

 • The software path to a specific function or screen appears with the greater than (>) symbol 
between screen options.

 • Links to information in another part of the document for additional information are in blue and 
are underlined. To access the linked information, select the blue, underlined text.

 • The information in your Instructions for Use manual applies to the CytoFLEX and CytoFLEX S 
instruments equipped with and without a plate loader, and the CytoFLEX LX, unless otherwise 
specified.

NOTE When information in this document only applies to the plate loader configuration, it is marked 

[With Plate Loader]. When information in this document only applies to the configuration not 

equipped with a plate loader, it is marked [Without Plate Loader]. When information in this document 

only applies to one instrument in the series, it is marked either [CytoFLEX] or [CytoFLEX LX].

NOTE There are two kinds of plate loaders, the standard CytoFLEX Plate Loader and the CytoFLEX Plate 

Loader Deep Well (DW). The CytoFLEX Plate Loader DW (hereinafter called as Plate Loader DW) is 

compatible with CytoFLEX, CytoFLEX S, and CytoFLEX LX instruments. When information in this 

document only applies to one plate loader, it is marked either [Plate Loader DW] or [Standard Plate 

Loader].

 • Sections that contain entirely new content are flagged with a New Section icon  at the end 
of the section title.

 • The CytExpert Default software installation screens are shown in all instances unless otherwise 
specified.

IMPORTANT IMPORTANT is used for comments that add value to the step or procedure being performed. 

Following the advice in the IMPORTANT adds benefit to the performance of a piece of equipment or to a 

process.

NOTE NOTE is used to call attention to notable information that should be followed during use, or 

maintenance of this equipment.
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Graphics  
Graphics

All graphics, including screens and printouts, are for illustration purposes only and must not be 
used for any other purpose. For example, software screens that show the CytoFLEX system in the 
background may not depict the latest production version of the system.
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CHAPTER 1

System Overview

Overview

This chapter describes the individual components of the CytoFLEX flow cytometer and the 
corresponding functions of these components. 

This chapter contains information on:

 • Product Description

 • Main Components

 • Optical Components

 • Fluidics System

 • Sample Station

 • Plate Loader Components

 • System Configuration

 • Consumables and Supplies

 • Instrument Specifications

 • Performance Characteristics

 • Reagent Limitations

Product Description

The CytoFLEX and CytoFLEX LX flow cytometers are used for the qualitative and quantitative 
measurement of biological and physical properties of cells and other particles. These properties are 
measured when the cells pass through one or multiple laser beams in a single-file. The CytoFLEX 
flow cytometer can perform up to 13 color marker analysis. The system can be ordered in various 
configurations. The CytoFLEX S may be ordered in various configurations from 2 lasers, 4 colors to 
a maximum of 4 lasers, 13 colors. The CytoFLEX LX flow cytometer can perform up to 21 color 
marker analysis. The system can be ordered in various configurations from a 4 laser, 14 colors, to a 
maximum of 6 lasers, 21 colors. Many of the configurations can be upgraded in the field. For 
Research Use Only. Not for use in diagnostics procedures.

NOTE A CytoFLEX instrument cannot be upgraded to a CytoFLEX S cytometer.
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System Overview

Main Components  
Main Components

CAUTION

Risk of instrument damage and/or instrument stability. Do not place any objects 

on top of the instrument, as this could cause warping of the top cover or affect the 

stability of the optical path. 

The instrument consists of three main components: Fluid Containers/Cubitainers, Cytometer, and 
the Workstation.

Figure 1.1  Main Components [CytoFLEX Without Plate Loader]

1. Fluid Containers. Accommodates sheath fluid and waste liquids as required for 

operation of the instrument.

2. Cytometer. Provides signal generation and collection.

3. Workstation. Displays the content of the workstation and data generated by the 

Cytometer.

b c d
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System Overview

Main Components  1
Figure 1.2  Main Components [CytoFLEX LX]

1. Fluid Cubitainers. Accommodates sheath fluid and waste liquids as required for 

operation of the instrument.

NOTE The CytoFLEX LX does not have a fluid container holder.

2. Cytometer. Provides signal generation and collection.

3. Workstation. Displays and manipulates the contents of the Workstation and displays 

data generated by the Cytometer.

REACTIVE INGREDIENTS: Anti-microbial 
compound

A nonionic, non-flourescent, and azide free sheath 
fluid for use on Beckman Coulter CytoFLEX flow 
cytometers.

10 L

Cyto FLEX
Sheath Fluid

c db
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System Overview

Optical Components  
Optical Components

CAUTION

Risk of operator injury. When operating the instrument, keep the top cover in the 

closed position to prevent the top cover from falling. When opening the top cover, 

be cautious to avoid any possible pinch points.

The optical components are located in the upper portion of the Cytometer and are visible when the 
top cover is open. Three parts are included: an optical bench, detector arrays also known as 
wavelength division multiplexers (WDMs), and optical fibers. Optical components include 
equipment such as lasers and signal detectors that are used to excite, transmit, and collect optical 
signals. 

1. Optical bench. Includes laser light sources, an optical beam combiner, and an integrated optics flow 

cell assembly. The optical bench cover is equipped with a laser interlock that turns the lasers off unless 

the cover is tightly closed. 

2. Wavelength division multiplexer (WDM). Each WDM is a unique detector array that corresponds to 

a different laser, or in some cases two lasers. Each WDM contains optical filters and detectors for 

detecting channel fluorescence or scatter from a particular laser. It is necessary to ensure that the filter 

and software settings match for each channel.

3. Optical fiber. Transmits emitted fluorescence to the specific WDM.

CAUTION

Risk of instrument damage. Do not place sample tubes in the optical filter holder. Liquid spills can 

damage instrument components. Use a tube rack to hold any sample tubes.

4. Optical filter holder. Securely holds additional CytoFLEX optical filters.

CAUTION
CLASS  3B LASER   RADIATION WHEN OPEN AND 

INTERLOCKS DEFEATED. AVOID EXPOSURE TO BEAM

PRÉCAUTION
LASER  CLASSE  3B  RADIATION  LASER QUAND

 L ' INSTRUMENT EXT OUVERT ET NON  VERROUILLE
       ÉVITER   TOUTE  EXPOSITION  AU  FAISCEAU

b
b

e

c d

e

c

c

CytoFLEX CytoFLEX LX

d
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System Overview

Optical Components  1
Wavelength Division Multiplexer (WDM)

Each WDM corresponds to a different laser, or in some cases two lasers. The color of the ring on each 
cap corresponds to the color of the respective laser. Pressing the two release buttons on opposite 
edges of the cap allows you to open the WDM and replace the filters inside. See Figure 1.3. All optical 
filters are designed to be interchangeable. Refer to Replacing the Optical Filter in CHAPTER 11, 
Replacement/Adjustment Procedures to replace an optical filter. 

Figure 1.3  Optical Filter Mounts

Each optical filter mount has an optical filter glass piece. See Figure 1.4.

Figure 1.4  Optical Filter Mount with Optical Filter

1. Optical filter glass piece

b
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System Overview

Optical Components  
Each optical filter mount is labeled with the corresponding laser and band-pass information. See 
Figure 1.5.

Figure 1.5  Optical Filter Mount Labeled with the Band-Pass Information

The top of each optical filter mount has two marks. The color of the dot (1) indicates the color of 
the laser. See Figure 1.6. The color of the line (2) indicates the wavelength range of the optical 
band-pass filter. See Figure 1.6.

Figure 1.6  Optical Filter Mount (Top)

Band-pass filters are used to transmit fluorescence within a specific range of wavelength. These 
ranges are designed to measure fluorescence from fluorochromes such as those listed in Table 1.1. 
(with red and violet laser upgrades installed). You can change the optical filters according to your 
detector configuration. There is no need to realign the optical system when the filters are changed.

1. . Indicates corresponding laser color: Blue indicates a 488 nm laser; Red indicates a 

638 nm laser; Violet indicates a 405 nm laser; Yellow indicates a 561 nm laser; Pink indicates 

a 808 nm laser; White indicates either 375 nm or 355 nm.

2. . Indicates the band-pass wavelength ranges; the midpoint of the band-pass is 

indicated numerically on the lateral side of the mount.

b

c
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System Overview

Optical Components  1
NOTE The CytoFLEX and CytoFLEX S might have the following additional BP filters supplied within WDMs:

 • 405/10 BP

 • 638/6 BP

 • 561/6 BP

 • 488/8 BP

Table 1.1  WDM Optical Filter Mount Color Codes [CytoFLEX]

Laser Fluorescent Channel

CytoFLEX 

Channel 

Names

Commonly used 

Fluorescent Dyes

488 nm 525/40 BP
FITC FITC, Alexa Fluor™ 488, 

CFSE, Fluo-3

585/42 BP
PE PE, PI

610/20 BP
ECD ECD, PE-Texas Red®, 

PE-CF594, PI

690/50 BP
PC5.5 PC5.5, PC5, PerCP, 

PerCP-Cy5.5, PI, DRAQ7™

780/60 BP
PC7 PC7, DRAQ7™

638 nm 660/10 BP
APC APC, Alexa Fluor™ 647, 

eFluor™ 660, Cy5

712/25 BP
APC-A700 APC-A700, Alexa 

Fluor™700, Cy5.5, DRAQ7™

780/60 BP
APC-A750 APC-A750, APC-Cy7, 

APC-H7, APC- eFluor™ 780, 

DRAQ7™

405 nm 450/45 BP
PB450 Pacific Blue™dye, V450, 

eFluor™ 450, BV421

525/40 BP
KO525 Krome Orange, AmCyan, 

V500, BV510

610/20 BP
Violet610 BV605, Qdot® 605

660/10 BP
Violet660 BV650, Qdot® 655

780/60 BP
Violet780 BV785, Qdot® 800
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Optical Components  
Table 1.2  WDM Optical Filter Mount Color Codes [CytoFLEX LX]

Laser Fluorescent Channel

CytoFLEX Channel 

Names

Commonly used 

Fluorescent Dyes

355 nm 405/30 BP
UV405 BUV395

525/40 BP
UV525 BUV496

675/30 BP
UV675 Hoescht Red, BUV661

450/45 BP
N/Aa DAPI

375 nm 450/45 BP
NUV450 BUV395, DAPI

525/40 BP
NUV525 BUV496

675/30 BP
NUV675 Hoescht Red, BUV661

405 nm 450/45 BP
V450-PB Pacific Blue™dye, V450, 

eFluor™ 450, BV421

525/40 BP
V525-KrO Krome Orange, AmCyan, 

V500, BV510

610/20 BP
V610 BV605, Qdot® 605

660/10 BP
V660 BV650, Qdot® 655

763/43 BP
V763 BV785, Qdot® 800

488 nm 525/40 BP
B525-FITC FITC, Alexa Fluor™ 488, 

CFSE, Fluo-3

610/20 BP
B610-ECD ECD, PE-Texas Red®, 

PE-CF594, PI

690/50 BP
B690-PC5.5 PC5.5, PC5, PerCP, 

PerCP-Cy5.5, PI, DRAQ7™

561 nm 610/20 BP
Y610-mCherry mCherry, ECD, PE-CF594

763/43 BP
Y763-PC7 PC7

585/42 BP
Y585-PE PE, DsRed

675/30 BP
Y675-PC5 PC5, mPlum

710/50 BP
Y710-PC5.5 PC5.5, PE-AF680
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NOTE The CytoFLEX LX might have the following additional BP filters supplied within WDMs:

 • 405/10 BP

 • 638/6 BP

 • 561/6 BP

 • 488/8 BP

638 nm 763/43 BP
R763-APCA750 APC-A750, APC-Cy7, 

APC-H7, APC- eFluor™ 780, 

DRAQ7™

660/10 BP
R660-APC APC, Alexa Fluor™ 647, 

eFluor™ 660, Cy5

712/25 BP
R712-APCA700 APC-A700, Alexa 

Fluor™700, Cy5.5

808 nm 840/20 BP
IR840-A790 Alexa Fluor®790

885/40 BP
IR885 PromoFluor-840, IR fixable 

viability dye

a. Only used as an alterative for other BPs like 405/30 BP.

Table 1.2  WDM Optical Filter Mount Color Codes [CytoFLEX LX] (Continued)

Laser Fluorescent Channel

CytoFLEX Channel 

Names

Commonly used 

Fluorescent Dyes
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Optical Components  
Optical Fiber

CAUTION

Risk of data integrity damage.

 • During use, verify that the optical fibers are securely connected to the WDM. 

A loose connection can alter the optical path and affect fluorescence 

detection.

 • Do not disconnect the fiber as this could contaminate the tip and weaken the 

signal. 

 • Do not kink the optical fibers.

Fluorescence emitted by laser-excited fluorochromes is picked up and delivered by each optical 
fiber to the corresponding detector module. Each optical fiber has a colored ring on the end that 
connects to the WDM, indicating the color of the corresponding laser. Ensure that the correct fiber 
is properly connected to the corresponding WDM.

1. Red laser fiber

2. Violet laser fiber

3. Blue laser fiber

4. Infrared laser fiber

5. Blue laser fiber

6. Yellow laser fiber

7. Red laser fiber

8. Violet laser fiber

9. NUV or UV laser fiber

CAUTION
CLASS  3B LASER   RADIATION WHEN OPEN AND 

INTERLOCKS DEFEATED. AVOID EXPOSURE TO BEAM

PRÉCAUTION
LASER  CLASSE  3B  RADIATION  LASER QUAND

 L ' INSTRUMENT EXT OUVERT ET NON  VERROUILLE
       ÉVITER   TOUTE  EXPOSITION  AU  FAISCEAU

c d

e

f

g

h i

CytoFLEX CytoFLEX LX

j
b
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Fluidics System

The fluidics system consists of two parts: the Fluid Containers/Cubitainers and the Fluidics module. 
The Fluidics module is located on the right side of the Cytometer. You need to open the right-side 
cover of the instrument (see Right-Side Cover Removal and Reinstallation in CHAPTER 11, 
Replacement/Adjustment Procedures) to perform maintenance operations. The fluidics system 
helps to transmit the sheath fluid at a stable rate into the flow cell, forming a laminar fluidics 
system that ensures that the tested particles go through the detection area sequentially.

NOTE The 10 L sheath fluid and waste cubitainers are available from Beckman Coulter as an alternative to 

the 4 L Fluid Containers (refer to Figure 1.7) provided with your CytoFLEX and CytoFLEX S Flow 

Cytometers. Contact us to order the 10 L Sheath/Waste Line Kit. The CytoFLEX LX is only available with 

the 10 L sheath fluid and waste cubitainers. Refer to Figure 1.8.

Figure 1.7  Fluid Containers [CytoFLEX]

1. Fluid Container holder. Holds the Fluid Containers.

2. Fluid sensor holder cutout. Holds the sheath fluid harness and the waste harness when removed from 

their respective containers to protect the sensors from damage and/or contamination.

3. Sheath fluid harness. Connects to the sheath fluid container; conveys the sheath fluid into the 

instrument. The sheath fluid harness includes a level sensor, sheath fluid tubing, and backflush tubing. 

The other end of the harness is connected to the Fluidics module in the Cytometer. When the sheath 

fluid container is near empty, a warning notice is transmitted to the instrument and an audible signal 

sounds as a warning.

4. Sheath fluid container. 4 L capacity, for holding sheath fluid. Beckman Coulter recommends using 

CytoFLEX Sheath Fluid or a similar nonionic sheath fluid to ensure system performance.

NOTE The sheath fluid container must be on the same level as the Cytometer.

5. Waste harness. Connects to the waste fluid container; conveys the waste fluid from the instrument to 

the waste container. The waste harness includes a level sensor. The other end of the harness is 

connected to the Fluidics module in the Cytometer. When the waste fluid container is near full, a warning 

notice is transmitted to the instrument and audible signal sounds as a warning.

6. Waste container. 4 L capacity, for holding waste liquids. Attention to biosafety and waste labeling is 

required.

NOTE The waste container must be on the same level as the Cytometer.

Sheath SheathWaste

f

b

c

d
e
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System Overview

Fluidics System  
Figure 1.8  Fluid Cubitainers [CytoFLEX LX]

Fluid Containers/Cubitainers

On the CytoFLEX, two Fluid Containers are placed in the Fluid Container holder: a sheath fluid 
container and a waste container. See Figure 1.7. On the CytoFLEX LX, two 10-L Fluid Cubitainers are 
placed to the left side of the instrument: a sheath fluid cubitainer and a waste cubitainer. Each 
container/cubitainer cap is fitted with a harness and a level sensor. The blue harness connects to 
the sheath fluid container/cubitainer while the yellow harness connects to the waste container/
cubitainer. The containers/cubitainers do not require additional pressure inside. Take all necessary 
biosafety precautions and use proper personal protective equipment when handling the Fluid 
Containers/Cubitainers. 

1. Sheath fluid harness. Connects to the sheath fluid cubitainer; conveys the sheath fluid into the 

instrument. The sheath fluid harness includes a level sensor, sheath fluid tubing, and backflush tubing. 

The other end of the harness is connected to the Fluidics module in the Cytometer. When the sheath 

fluid cubitainer is near empty, a warning notice is transmitted to the instrument and an audible signal 

sounds as a warning.

2. Sheath fluid cubitainer. 10 L capacity, for holding sheath fluid. Beckman Coulter recommends using 

CytoFLEX Sheath Fluid or a similar nonionic sheath fluid to ensure system performance.

NOTE The sheath fluid cubitainer must be on the same level as the Cytometer.

3. Waste harness. Connects to the waste fluid cubitainer; conveys the waste fluid from the instrument to 

the waste cubitainer. The waste harness includes a level sensor. The other end of the harness is 

connected to the Fluidics module in the Cytometer. When the waste fluid cubitainer is near full, a 

warning notice is transmitted to the instrument and audible signal sounds as a warning.

4. Waste cubitainer. 10 L capacity, for holding waste liquids. Attention to biosafety and waste labeling is 

required.

NOTE The waste cubitainer must be on the same level as the Cytometer.

REACTIVE INGREDIENTS: Anti-microbial compound

A nonionic, non-flourescent, and azide free sheath fluid 

for use on Beckman Coulter CytoFLEX flow cytometers.

10 L

Cyto FLEX

Sheath Fluid

Cyto FLEXSheath Fluid

Beckman Coulter, Inc.

250 S. Kraemer Blvd.
Brea, CA 92821Printed in USA   Made in USA

© 2010 Beckman Coulter, Inc.

Beckman Coulter Ireland Inc.

Mervue Business Park,

Mervue, Galway, Ireland

353 91 774068

Cyto FLEX

Sheath Fluid

������� Cyto FLEX Sheath Fluid

���
���

�
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System Overview

Fluidics System  1
Fluidics Module

The Fluidics module is on the right side of the Cytometer. To access it, you must first open the 
right-side cover. Refer to Right-Side Cover Removal and Reinstallation in CHAPTER 11, 
Replacement/Adjustment Procedures. Inside the module, in addition to working pumps, valves, 
and tubing, there is a sheath filter and a Deep Clean solution bottle. During maintenance, it may be 
necessary to replace the filter (see Replacing the Sheath Fluid Filter in CHAPTER 11, Replacement/
Adjustment Procedures) or to add Deep Clean solution (see Adding the Deep Clean Solution in 
CHAPTER 11, Replacement/Adjustment Procedures).

Figure 1.9  Fluidics Module View

1. Alarm. Emits a warning sound when there is a problem with the Fluid Container/Cubitainer capacity 

or with the performance of certain operations.

NOTE When the alarm sounds, the Mute Alerter icon appears in the status bar. The alarm continues 

for about 30 seconds. To mute the alarm temporarily select the Mute Alerter in the status bar. 

The icon disappears when the waste container/cubitainer is emptied and/or the sheath container/

cubitainer is filled/replaced.

2. Deep Clean solution peristaltic pump. Transfers cleaning solution to the flow cell.

3. Deep Clean solution bottle. Contains the diluted cleaning solution that helps to clean the flow cell.

4. Sheath fluid filter. 0.2 μm filter, for filtering sheath fluid.

5. Sheath damper. Regulates the sheath flow rate and decreases the sheath flow fluctuation.

PV2PV3PV1PV5

CytoFLEX CytoFLEX LX

PV2PV3PV1PV5 PV2PV3PV1PV5

b
b

edc edc

f f
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System Overview

Fluidics System  
Figure 1.10  Fluidic Connections

NOTE Use CytoFLEX Sheath Fluid or other filtered nonionic sheath fluid. Using unfiltered sheath fluid can 

shorten the service life of the sheath fluid filters and increase noise and debris detection.

1. Waste level sensor connector. Connects to the waste liquid sensor cable.

2. Flow cell waste out. Connects to the waste tubing of the wash station.

3. Sheath fluid level sensor connector. Connects to the sheath fluid sensor cable.

4. Waste out. Connects to the waste liquid tubing from the flow cell.

5. Sheath return. Connects to the sheath fluid tubing.

NOTE The sheath fluid is pressurized by a diaphragm pump. To improve pressure stability, a bypass 

line returns some of the sheath fluid back into the sheath fluid container/cubitainer.

6. Sheath fluid in. Connects to the sheath fluid tubing.

gfe

dcb
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Sample Station  1
Sample Station

WARNING

Risk of biohazardous contamination and/or instrument damage. When running 

samples, it is important to insert the sample tube all the way down into the sample 

tube holder, until the bottom of the sample tube touches the base of the holder. 

Failing to do this could cause the sample probe to bend or break on entry. Sample 

tubes must not exceed 80 mm in height and the outside diameter must not exceed 

13 mm.

Figure 1.11  Sample Station with New Tube Holder 

1. Sample tube holder.Supports sample tubes for testing, such 12 x 75 mm, 1.5-mL, and 
2-mL microtubes.

2. Sample probe. Draws and transfers samples into the flow cell.

3. Wash station and mixer. During the sampling process, samples are automatically 
shaken and mixed for a default time of 1 second. The sample probe is automatically 
cleaned when the instrument performs a backflush.

b

d

c
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System Overview

Sample Station  
Sample Tube Holder Positions

Three of the sample tube holder positions are shown in Figure 1.12: sample loading position (1), 
standby position (2), and sample acquisition position (3). You can only distinguish the mixing 
position from the sample acquisition position if you are looking directly at the sample tube holder 
while the Cytometer is processing a sample. The mixing position is about 6 mm lower than the 
sample acquisition position.

Figure 1.12  Sample Tube Holder Positions

b

dc
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Plate Loader Components  1
Plate Loader Components

Figure 1.13  Standard Plate Loader [CytoFLEX Shown]

1. Plate loader door

2. Plate holder stage

3. Plate holder (removable)

d

c

b
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System Overview

Plate Loader Components  
Figure 1.14  Plate Loader DW [CytoFLEX Shown]

NOTE The Plate Loader DW supports both standard 96-well plates, and 96-well deep well plates.

1. Plate loader door

2. Plate holder stage

3. Plate holder (removable)

d

c

b
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System Overview

Plate Loader Components  1
Figure 1.15  Standard Plate Loader (Front Cover Removed)

1. Plate loader PEEK tubing

2. Plate loader sample probe assembly

3. Plate loader wash station

4. Plate holder

e

b

C

d
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System Overview

Plate Loader Components  
Figure 1.16  Plate Loader DW (Front Cover Removed)

1. Plate loader PEEK tubing

2. Plate loader sample probe assembly

3. Plate loader wash station

4. Plate holder

e

b

C

d

B49006AM   1-20



System Overview

Plate Loader Components  1
Plate Holder Components

Figure 1.17  Standard Plate Holder without Groove (Standard Plate Loader)

1. Spring leaves to hold plate

2. Plate holder notches

b

c

A1
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System Overview

Plate Loader Components  
Figure 1.18  Plate Holder with Groove (Plate Loader DW)

NOTE The plate holder is removable and replaceable. Refer to Replacing the Plate Holder [With Plate Loader] 

in CHAPTER 11, Replacement/Adjustment Procedures. 

The plate holder is only used to hold standard 96-well plates. Note that 96-well deep well plates do not 

use a plate holder.

1. Spring leaves to hold plate

b

A1
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Plate Loader Components  1
Figure 1.19  Plate Holder Stage (Standard Plate Loader)

1. Pins

2. Position A1

c

b
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Plate Loader Components  
Figure 1.20  Plate Holder Stage (Plate Loader DW)

1. Position A1

2. Spring Lock

c

b
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System Configuration

CAUTION

Risk of data loss and/or instrument damage. Never shut off the power or 

disconnect a data cable while the Cytometer is in the process of performing a task. 

This could cause data loss or damage to the system.

System Configuration [CytoFLEX and CytoFLEX S]

Figure 1.21  System Connections

1. Monitor

2. Mouse

3. Keyboard

4. Computer

5. Cytometer

6. Fluid Container holder

CLASS 1 LASER PRODUCT
COMPLIES WITH 21 CFR 1040.10 AND 1040.11
EXCEPT FOR DEVIATIONS PURSUANT TO
LASER NOTICE NO. 50 DATED JUNE 24, 2007
MANUFACTURED 

SNSN

SheathSheathWaste
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System Overview

System Configuration  
Figure 1.22  Back Cover Connections

Figure 1.23  Front of Cytometer [CytoFLEX Without Plate Loader Shown]

1. Power switch. Turns Cytometer on and off. An indicator light glows when the power is on. 

2. Fuse. Protects the internal system from damage by high electrical current.

3. Power line socket. Supplies the power to the Cytometer.

1. Load button. In addition to the software controls, this button can be used for automatic sample loading 

and data recording.

NOTE This function is not available in the Plate Loader sample injection mode.

CLASS 1 LASER PRODUCT
COMPLIES WITH 21 CFR 1040.10 AND 1040.11
EXCEPT FOR DEVIATIONS PURSUANT TO
LASER NOTICE NO. 50 DATED JUNE 24, 2007
MANUFACTURED 

SNSN
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System Overview

System Configuration  1
System Configuration [CytoFLEX LX]

IMPORTANT The fluid cubitainers must be on the same level as the Cytometer. Do not place the fluid 

cubitainers on the floor.

Figure 1.24  System Connections

1. Monitor

2. Keyboard

3. Mouse

4. Computer

5. Cytometer

6. Fluid Cubitainers

CLASS 1 LASER PRODUCT
COMPLIES WITH 21 CFR 1040.10 AND 1040.11
EXCEPT FOR DEVIATIONS PURSUANT TO
LASER NOTICE NO. 50 DATED JUNE 24, 2007
MANUFACTURED 

SN

REACTIVE INGREDIENTS: Anti-microbial compound

A nonionic, non-flourescent, and azide free sheath fluid 
for use on Beckman Coulter CytoFLEX flow cytometers.

10 L

Cyto FLEX
Sheath Fluid
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System Overview

System Configuration  
Figure 1.25  Back Cover Connections 

Figure 1.26  Front of Cytometer

1. Power switch. Turns Cytometer on and off. An indicator light glows when the power is on. 

2. Fuse. Protects the internal system from damage by high electrical current.

3. Power line socket. Supplies the power to the Cytometer.

1. Load button. In addition to the software controls, this button can be used for automatic sample loading 

and data recording.

NOTE This function is not available in the Plate Loader sample injection mode.

CLASS 1 LASER PRODUCT
COMPLIES WITH 21 CFR 1040.10 AND 1040.11
EXCEPT FOR DEVIATIONS PURSUANT TO
LASER NOTICE NO. 50 DATED JUNE 24, 2007
MANUFACTURED 

SN

b

c

d

b
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Consumables and Supplies  1
Consumables and Supplies

Reagents

The following reagents are available for the CytoFLEX and CytoFLEX LX instrument:

CytoFLEX Daily QC Fluorospheres

CytoFLEX Daily QC Fluorospheres is a suspension of fluorescent microspheres which may be used 
for daily verification of the CytoFLEX flow cytometer’s optical alignment and fluidics system.

NOTE Not for daily verification of the Infrared optical alignment.

CytoFLEX Sheath Fluid

A nonionic, non-fluorescent, and azide-free sheath fluid for use on Beckman Coulter CytoFLEX flow 
cytometers.

Contrad® 70 Reagent

Diluted 1:1 with DI water for use in the Deep Clean solution bottle.

FlowClean

For use as a cleaning agent for flow cytometer components that come in contact with blood 
samples.

The following reagents are available for the IR laser QC:

CytoFLEX Daily IR QC Fluorospheres

CytoFLEX Daily IR QC Fluorospheres is a suspension of fluorescent microspheres which may only be 
used for daily verification of the CytoFLEX flow cytometer’s Infrared optical alignment.

Material Safety Data Sheets (SDS/MSDS)

To obtain an SDS or MSDS for CytoFLEX Series reagents used on the CytoFLEX Series systems:
 • On the Internet, go to www.beckman.com:

1. Select Safety Data Sheets (SDS/MSDS) from the Support menu.
2. Follow the instructions on the screen.
3. Contact us if you have difficulty locating the information.

 • If you do not have Internet access, contact us.

Ordering Information

Your instrument may be upgraded to a more highly configured model. For information on specific 
upgrades, replacement parts, or supplies, visit: 

 • www.beckman.com/coulter-flow-cytometers/cytoflex/upgrades for CytoFLEX
 • www.beckman.com/coulter-flow-cytometers/cytoflex-s/upgrades for CytoFLEX S
 • www.beckman.com/coulter-flow-cytometers/cytoflex-lx/upgrades for CytoFLEX LX

 Otherwise, contact us.
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Instrument Specifications

Dimensions [CytoFLEX]

Refer to Figure 1.27 for the [CytoFLEX] Plate Loader DW dimensions.

Figure 1.27  Plate Loader DW Dimensions [CytoFLEX] 

Dimensions

Instrument 

dimensions (Length x 

Width x Height)

Cytometer [With or Without 

Plate Loader]

42.5 cm x 42.5 cm x 34 cm

Fluid Containers and Fluid 

Container holder

14 cm x 35.6 cm x 35.6 cm 

Weight Cytometer [Without Plate 

Loader]

23.4 kg

Cytometer [With Standard 

Plate Loader]

28 kg

Cytometer [With Plate 

Loader DW]

28.4 kg

25.4 cm
(10.0 in)

14.5 cm
(5.7 in)

4.3 cm
(1.7 in)

16.3 cm
(6.4 in)

11.5 cm
(4.5 in)
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Instrument Specifications  1
Dimensions [CytoFLEX LX]

Refer to Figure 1.28 for the [CytoFLEX LX] Plate Loader DW dimensions.

Figure 1.28  Plate Loader DW Dimensions [CytoFLEX LX]

Installation Category

Installation Category 2

Dimensions

Instrument 

dimensions (Length x 

Width x Height)

Cytometer [With or Without 

Plate Loader]

60.5 cm x 73.3 cm x 45.1 cm

Fluid Cubitainers 25 cm x 25 cm x25 cm

Weight Cytometer [Without Plate 

Loader]

79 kg

Cytometer [With Standard 

Plate Loader]

83.6 kg

Cytometer [With Plate 

Loader DW]

84 kg

35.3 cm
(13.9 in)

19.4 cm
(7.6 in)

21.2 cm
(8.35 in)

37.5 cm
(14.7 in)

5.5 cm
(2.2 in)
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Instrument Specifications  
Pollution Degree

Pollution Degree 2

Acoustic Noise Level

Measure Level: <65 dBA

Electrical Ratings

Voltage: 100-240 VAC, 50/60 Hz, 250 VA

Cytometer

Optics

Excitation Optics The CytoFLEX system can be configured with up to three spatially-separated lasers. 

The optical system is alignment free. The laser delays are automatically adjusted by 

the daily QC system, if required. No user intervention is required to ensure optimum 

system performance.

The CytoFLEX LX system can be configured with up to six spatially-separated lasers. 

The optical system is alignment free. The laser delays are automatically adjusted by 

the daily QC system, if required. No user intervention is required to ensure optimum 

system performance.

Emission Optics Patent-pending alignment-free integrated optics quartz flow cell design with 

>1.3 NA.

Flow Cell dimensions: 430-μm x 180-μm internal diameter.
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Laser devices Standard wavelengths Blue laser

 • Wavelength: 488 nm, 50 mW

 • Beam spot size: 5 μm x 80 μm

Red laser

 • Wavelength: 638 nm, 50 mW

 • Beam spot size: 5 μm x 80 μm

Violet laser

 • Wavelength: 405 nm, 80 mW

 • Beam spot size: 5 μm x 80 μm

Additional standard 

wavelengths 

[CytoFLEX S or 

CytoFLEX LX]

Yellow laser

 • Wavelength: 561 nm, 30 mW

 • Beam spot size: 5 μm x 80 μm

Near Ultraviolet (NUV) laser

 • Wavelength: 375 nm, 60 mW

 • Beam spot size: 5 μm x 80 μm

Infrared (IR) laser

 • Wavelength: 808 nm, 60 mW

 • Beam spot size: 5 μm x 80 μm

Forward scatter 

detection

Silicon photodiode with built-in 488/8 band-pass filter.

Fluorescence and 

side scatter 

detection

Fluorescence and side scatter light collected by the objective lens is delivered by 

fiber optics to a patent-pending design with high performance, solid-state, high 

efficiency, low-noise detector array.

Reflective optics with a single transmission band-pass filter in front of each detector.

Violet side scatter 

configuration 

(VSSC)

The system offers the ability to configure the violet laser detector to collect side 

scatter to better resolve nanoparticles from noise.

Fluidics System

Sample loading speed Defaults Slow 10 μL/min

Medium 30 μL/min

Fast 60 μL/min

Fluid capacity CytoFLEX: Standard 4-L sheath fluid and waste containers; Optional 10 L 

sheath fluid and waste cubitainers

CytoFLEX LX: Standard 10-L sheath fluid and waste cubitainers

Automated 

maintenance cycles

Startup (initialize), system startup program, sample mix, backflush, prime, 

Shutdown (Daily Clean), Deep Clean

Sample input formats Single Tube Loader 

format

5 mL (12 x 75 mm) polystyrene and polypropylene 

sample tubes

1.5 mL and 2 mL micro-centrifuge sample tubes

Optics
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Fluidics System [With Standard 96-well Plate]

Sample input formats Plate Loader format Flat/U/V bottom standard 96-well plate

Dead Volume 96-well flat bottom plate 20 μL

96-well U bottom plate 10 μL

96-well V bottom plate 10 μL

Minimum Sample 

Volume

50 μL/well

Maximum Sample 

Volume

250 μL/well

Fluidics System [With 96-well Deep Well Plate]a

a. The 96-well deep well plates are only available for use if the Plate Loader DW is installed. The information below is based on the deep well plates manufactred by Beckman Coulter. Refer to 

APPENDIX D, Specimen Collection Plate Specifications.

Sample input formats Plate Loader format U/V bottom 96-well deep well plate

Dead Volume 20 μL

Minimum Sample 

Volume
50 μL/wellb

b. To mix sample throughly, it is recommended to add at least 200 μL sample per well for one time.

Maximum Sample 

Volume

Refer to the related specification of the deep well plates.

Electronics

Signal processing 7 decade data display

Digital sampling rate 25 MHz

Signal Pulse area and height for every channel, width for one selectable channel

Data Management

Software CytExpert software

Language English and Chinese

FCS format FCS 3.0

Minimum 

Workstation/

computer 

requirements 

[CytoFLEX]

Operating system Windows® 7, 8, 10 Professional 64-bit

Processor 4th Gen Intel® Core™ i3 (3MB Cache, 2.90 GHz)

Memory 4 GB RAM

Storage 256 GB

Port 1 GB Ethernet port

USB 5 USB 2.0 and above ports
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Performance Characteristics

Performance Characteristics [CytoFLEX and CytoFLEX S]

Minimum 

Workstation/

computer 

requirements 

[CytoFLEX LX]

Operating system Windows®7, 8, 10 Professional 64-bit

Processor 6th Generation Intel Core i7 (8MB cache 4.0 GHz)

Memory 8 GB RAM

Storage 256 GB 

Port 1 GB Ethernet port

USB 5 USB 2.0 and above ports

Compensation Full matrix compensation, manual and automatic.

Novel Compensation Library for storage of spillover values of dyes to easily 

determine the correct compensation matrix with new gain settings.

Data Management

Performance

Sensitivity MESF FITC: <30 molecules of equivalent soluble 

fluorochrome (MESF-FITC) 

PE: <10 molecules of equivalent soluble 

fluorochrome (MESF-PE) 

Fluorescence 

resolution

rCV <3%

The CytoFLEX LX Flow cytometer is capable of achieving <3% rCV. Using 

CytoFLEX Daily QC Fluorospheres and Daily IR QC Fluorospheres (for 808 nm 

Laser) for daily QC, the pass criteria is ≤5% for the Violet, Blue, Yellow, and Red 

lasers while the pass criteria is ≤7% for NUV, UV and IR lasers.

Blue Side scatter 

resolution

<300 nm

Violet Side scatter 

resolution

80 nm relative to polystyrene particles

Forward and side 

scatter resolution

Scatter performance is optimized for resolving lymphocytes, monocytes, and 

granulocytes as well as nanoparticles.

Carryover Single Tube Loader format ≤1.0%

Signal acquisition 

speed

30,000 particles/second with 15 parameters
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Performance Characteristics [CytoFLEX LX]

Performance [With Standard Plate Loader]

Carryover Plate Loader format <0.5%

Throughput [With 

Plate Loader]a

a. This performance characteristic is different if you have the Sample Injection Mode Control Kit installed on your CytoFLEX flow cytometer. Refer to APPENDIX C, Sample Injection Mode Control Kit.

10 second acquisition without mixing or backflush: <32 min.

10 second acquisition with 3 second mixing and 3 second backflush: <45 min.

Performance [With Plate Loader DW]

Carryover Plate Loader format <0.5%

Throughput [With 

Plate Loader DW]a

a.  The Plate Loader DW is equipped with the Sample Injection Mode Control Kit. Refer to APPENDIX C, Sample Injection Mode Control Kit.

Standard 96-well plate, 10 second acquisition without mixing or backflush: <36 

min.

Deep-well 96-well plate, 10 second acquisition without mixing or backflush: <37 

min

Standard 96-well plate, 10 second acquisition with 5 second mixing and 4 second 

backflush: <54 min.

Deep-well 96-well plate, 10 second acquisition with 10 second mixing and 4 

second backflush: <64 min.

Performance

Sensitivity MESF FITC: <30 molecules of equivalent soluble fluorochrome 

(MESF-FITC)

PE: <10 molecules of equivalent soluble fluorochrome 

(MESF-PE)

Fluorescence resolution rCV <3%

The CytoFLEX LX Flow cytometer is capable of achieving <3% rCV. Using 

CytoFLEX Daily QC Fluorospheres and Daily IR QC Fluorospheres (for 808 nm 

Laser) for daily QC, the pass criteria is ≤5% for the Violet, Blue, Yellow, and 

Red lasers while the pass criteria is ≤7% for NUV, UV and IR lasers.

Blue Side scatter 

resolution

<300 nm

Violet Side scatter 

resolution

80 nm relative to polystyrene particles

Forward and side scatter 

resolution

Scatter performance is optimized for resolving lymphocytes, monocytes, 

and granulocytes as well as nanoparticles.

Carryover Single Tube 

Loader format

≤1.0% 

Signal acquisition speed 30,000 particles/second with 23 parameters
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Reagent Limitations

 • Only use nonionic sheath fluid, like CytoFLEX Sheath Fluid. Do not use sheath fluid containing 
electrolytes.

 • Do not use organic solvents in the system.

Performance [With Standard Plate Loader]

Carryover Plate Loader format <0.5%

Throughput [With 

Standard Plate 

Loader]a

a. This performance characteristic is different if you have the Sample Injection Mode Control Kit installed on your CytoFLEX LX flow cytometer. Refer to APPENDIX C, Sample Injection Mode Control Kit.

10 second acquisition without mixing or backflush: <34 min.

10 second acquisition with 3 second mixing and 3 second backflush: < 47 min.

Performance [With Plate Loader DW]

Carryover Plate Loader format <0.5%

Throughput [With 

Plate Loader DW]a

a.   The Plate Loader DW is equipped with the Sample Injection Mode Control Kit. Refer to APPENDIX C, Sample Injection Mode Control Kit.

Standard 96-well plate, 10 second acquisition without mixing or backflush: <39 

min.

Deep-well 96-well plate, 10 second acquisition without mixing or backflush: <40 

min

Standard 96-well plate, 10 second acquisition with 5 second mixing and 6 second 

backflush: <60 min.

Deep-well 96-well plate, 10 second acquisition with 10 second mixing and 6 

second backflush: <69 min.
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CHAPTER 2

Using the CytExpert Software

Overview

The CytExpert software is a full-feature software package that controls the instrument's operation, 
collection of experiment data, and analysis of the results. This chapter will explain the software’s 
functions and features.

This chapter contains information on:

 • Launching the Software

 • Main Software Screen

 • User Management

 • Role Management

 • Account Policies

 • User Management Operation Log

 • Graphic and Gating Styles

 • Software Settings

Launching the Software

Select the desktop shortcut  to launch the CytExpert software.

If there is no desktop shortcut, run the “CytExpert.exe” software directly from the software 
installation directory. The default installation path is C:/Program Files/CytExpert. Or, select 

> All Programs > CytExpert.

Refer to Logging Into the Software in CHAPTER 3, Daily Startup, for detailed instructions on 
opening the software and confirming the connection status.

Main Software Screen

Hover your cursor over any button to display a text pop-up of the button’s function. 
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Start Page

The start page automatically opens after the software has been launched.

The following operations can be selected from the start page:

 • New Experiment. For creating a new experiment. The process creates a file with the .xit 
extension and a folder with the same file name where the raw data (.fcs files) are kept.

 • New Experiment From Template. For creating an experiment using a template saved from a 
previously saved experiment.

 • New Compensation. For setting up compensation for an experiment.

 • Open Experiment. For opening a previously created experiment.

 • Open Compensation. For opening a previously created compensation experiment.

 • Exit. For exiting CytExpert.
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The Experiment, Template, and Compensation tabs below give you the option of opening one of the 
10 most recently opened experiments.

Acquisition Screen

Selecting New Experiment, New Experiment From Template, or Open Experiment automatically opens 

the Acquisition screen. The Acquisition screen can be accessed by selecting  on the left side of 
the page. 

1. Navigation. Gives the option of accessing the Acquisition screen or Analysis screen.

2. Menu. Allows you to configure settings for sample acquisition, instrument operation, and software 

options.

3. Instrument Operation Controls. Controls sample loading/unloading and data acquisition and 

recording.

4. Collection. Establishes control over data recording options, displays the acquisition status, and 

controls the sample flow rate.

5. Test tubes. Allows you to configure and duplicate sample tubes, set display attributes, manage 

experimental data and compensation.

NOTE The Tube section of the screen can be expanded or retracted by dragging the top border of 

the Tube section of the screen. Expanding this section covers other elements of the screen, 

including: Events to Display, Events/Sec, and the Acquisition buttons.

6. Plot area. Includes plot and gating controls, as well as an area for creating plots and generating 

graphs.

7. Status bar. Displays instrument connection status and system information.
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Acquisition Screen Navigation

The Acquisition screens have two navigation icons, one for the Acquisition screen and the other for 
the Analysis screen.

1. Acquisition screen icon. Accesses the Acquisition screen.

2. Analysis screen icon. Accesses the Analysis screen.
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Collection

Standby state Initialized state

1. Acquisition control. Controls sample loading/unloading and data acquisition and recording.

2. Acquisition status. Displays such information as the acquisition rate (Events/Sec), event count, 

duration, and abort (%).

3. Acquisition conditions. Sets the necessary conditions for recording data.

4. Sample flow rate. Sets the acquisition rate for data collection.

NOTE High acquisition rate may increase the abort rate and measurement CVs.

Custom: The flow rate can be adjusted in 1 μL increments.
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Collection [With Plate Loader]

Standby state Initialized state

1. Acquisition control. Controls sample loading/unloading and data acquisition and recording.

2. Acquisition status. Displays such information as the acquisition rate (Events/Sec), event count, 

duration, and abort (%).

3. Acquisition conditions. Sets the necessary conditions for recording data.

4. Sample flow rate. Sets the acquisition rate for data collection.

NOTE High acquisition rate may increase the abort rate and measurement CVs.
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Test Tubes

Manual/Semi-Automatic Sample Injection 

Mode

Plate Loader Sample Injection Mode Test Tube Status

1. Tube management controls. Manages sample tubes. Used to add, copy, or delete attributes, open 

the tube property, and open the compensation matrix.

2. Test tube status indication. Displays a colored symbol in front of each tube indicating the status of 

the tube processing.

 •  indicates that the tube data was not collected.

 •  indicates that the tube data was acquired by selecting Run but can be overwritten.

 •  indicates that the tube data was saved by selecting Record or Auto Record and that this data 

cannot be overwritten.

 •  indicates imported FCS data.

NOTE  to the left of the test tube status indication symbol indicates that the sample has been 

compensated.

 •  indicates the data file is missing or there is an error in the data file.

3. Test tube list. Displays the sample tubes used in the experiment. Right-click a tube in the list to 

perform additional operations.

NOTE In the Plate Loader Sample Injection mode the well number displays at the end of the tube 

name.
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Plot area

1. Plot controls. For creating single or multiple plots, such as dot plots, histograms, density plots, pseudo 

color plots, and contour plots.

2. Statistics and hierarchy controls. For creating statistical and hierarchical charts.

3. Graphical gating controls. For creating graphical gates.

4. Zoom controls. For zooming in and out within a plot.

5. Pan axis display controls. For scaling axis ranges in the plots.

6. Gain adjustment control. For increasing and lowering gain adjustments on the plots.

NOTE The gain adjustment control only works when a sample is running.

7. Adjust compensation control. For adjusting compensation of either of the parameters on a 2D 

histogram.

8. Threshold control. For setting the minimum particle size limit, scatter value, or fluorescence intensity 

that acquisition will allow.

9. Undo and redo controls. For undoing or redoing an action in the drawing area.

10. Display controls. For controlling how plots and tables are aligned and arranged.

11. Rearrange. For restoring the plots to the default positions.

12. Printing controls. For printing and previewing the plot area.

13. Plot area. For creating plots and displaying statistics and hierarchy tables.
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Status Bar

Analysis Screen

The Analysis screen is similar to the Acquisition screen, without the acquisition control modules.

1. Communication connection status. Displays whether the Cytometer and the Workstation are 

connected. 

2. Instrument status information. Displays the status of the Cytometer.

3. Laser status. Displays the status of each laser.

NOTE The laser status only displays when a required laser is disabled.

4. Sampler status. Displays the sample injection mode state. There are two sample injection modes: 

Semi-automatic sample injection mode and manual sample injection mode. 

NOTE CytoFLEX Cytometers equipped with a plate loader have three sample injection modes: 

Semi-automatic sample injection mode, manual sample injection mode, and plate loader sample 

injection mode.

5. Fluid status information. Displays the liquid level of the Fluid Containers/Cubitainers.
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The Tube management module cannot add new sample tubes. Return to the Acquisition screen to 
add new sample tubes.

Semi-Automatic Sample Injection Mode Shown

Drawing controls (see Figure 2.1) include the multi-data histograms and graphical display data 
controls.

Figure 2.1  Drawing Controls Toolbar (Top of Screen)

Compensation Experiment Screen

The Compensation Experiment screen appears when you open or create a new compensation 
experiment.

Plots Zoom Threshold

Statistics Scale
Undo/

Redo

Hierarchy Gain

Gates Compensation
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Semi-Automatic Sample Injection Mode Shown

The Tube management section of the screen can import saved data (.fcs) files for computational 
purposes.

Compensation Controls

The control area includes the compensation controls, coordinate pan axis display controls, gain 
adjustment controls, and the undo and redo controls. The compensation controls give you the 
option of calculating the compensation value, displaying the compensation matrix, or changing the 
compensation parameters.

1. Tube management. Displays sample tubes required for the compensation experiment.

2. Plot area. Displays compensation plots and gating.

Compensation 

Calculation

Single Side 

Pan

Compensation 

Matrix

Adjust Gain

Compensation 

Setup

Undo/Redo

Add/Delete 

Negative Gate

Alignment

Zoom Print

Pan
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QC Experiment Screen

The Quality Control (QC) Experiment screen appears when you access a QC experiment.

QC Report Screen

Before starting the QC routine, a Settings screen appears.

Figure 2.2  QC Report Screen [CytoFLEX LX Semi-Automatic Sample Injection Mode Shown]

1. Menu. Allows you to configure settings related to QC experiments.

2. Acquisition control. Controls sample loading/unloading and data recording. 

3. Lot selection. Allows you to select the lot number of the QC reagent. 

4. QC results list area. Displays the time and results of completed QC runs. 

5. QC reports area. Displays detailed reports for the selected QC experiment.
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QC Experiment Screen

When acquiring QC samples, the software opens the QC screen.

QC Screen Navigation

The Analysis screens have two navigation icons, one for the QC screen and the other for the 
Levey-Jennings (LJ) charts. Refer to Creating Levey-Jennings Charts in CHAPTER 4, Instrument 
Quality Control and Standardization.

1. QC experiment progress indicator. Displays the QC stage.

2. Plot area. Displays the QC plots.

1. QC screen icon. Accesses the QC screen.

2. LJ screen icon. Accesses the Levey-Jennings (LJ) screen.

c

b
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Software Menu

IMPORTANT All menu items apply to the CytExpert Default software option unless otherwise specified.

The CytExpert software contains the following selectable menu items:

Figure 2.3  Software Menu Tree*

* The menu options for File, Cytometer, Settings, and QC/Standardization change when you select Start QC/

Standardization. Refer to Figure 2.4.

✝ Boost is only active in the Manual Sample Injection mode.

‡ Plate Type Library is only an option if the Plate Loader module is installed and the Plate Loader Sample Injection mode 

is selected.

** Plate Loader is only an option if the Plate Loader module is installed.

†† These options are only available if the CytExpert User Management or CytExpert Electronic Record Management 

software option is installed.

‡‡ Experiment is only an option if either the CytExpert Default or the CytExpert User Management software option is 

installed.

*** These options are only available if the CytExpert Electronic Record Management software option is installed.

††† These options are only available on the CytoFLEX LX flow cytometer.
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Figure 2.4  QC Software Menu Tree

Acquisition and Analysis Screen Menu

CytExpert Default Software Option

CytExpert User Management Software Option 

CytExpert Electronic Record Management Software Option

File Menu

For creating new experiments, opening existing experiments, saving new experiments and data, 
and importing/exporting FCS data files.

* Boost is only active in the Manual Sample Injection mode.

 † Plate Type Library is only an option if the Plate Loader module is installed and the Plate Loader Sample 

Injection mode is selected.

‡ Plate Loader is only an option if the Plate Loader module is installed.

** These options are only available if the CytExpert Electronic Record Management software option is 

installed. 

† †Experiment is only an option if either the CytExpert Default or the CytExpert User Management 

software option is installed.

 ‡‡ These options are only available if either the CytExpert User Management or the CytExpert Electronic 

Record Management software option is installed.

***These options are only available on the CytoFLEX LX flow cytometer.
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CytExpert Default Software Option

CytExpert User Management Software Option 
B49006AM   2-16
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CytExpert Electronic Record Management Software Option

Cytometer Menu

For configuring Cytometer settings and controlling Cytometer functions. Depending on the 
Cytometer state, certain functions may not be available.

CytExpert Default Software Option - 

Standby state

CytExpert Default Software Option - 

Initialized state
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CytExpert User Management Software Option - 

Standby state

CytExpert User Management Software Option - 

Initialized state
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NOTE The Turn On and Turn Off selections are only available on the CytoFLEX LX.

Settings Menu

Used to select and/or change software options and settings.

CytExpert Default Software Option

CytExpert Electronic Record Management 

Software Option - Standby state

CytExpert Electronic Record Management 

Software Option - Initialized state
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CytExpert User Management Software Option

CytExpert Electronic Record Management Software Option 

QC/Standardization Menu

Select Start QC/Standardization from the QC/Standardization menu to start the QC routine.

NOTE The QC/Standardization menu is the same for the CytExpert Default, CytExpert User Management, 

and the CytExpert Electronic Record Management software options.

Advanced Menu

Used to access advanced settings for experienced users. Includes laser time delay settings.
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Account Menu

Used to for user account management settings.

CytExpert User Management Software Option

CytExpert Electronic Record Management Software Option

NOTE The Account menu is not available in the CytExpert Default software option.

CytExpert Default Software Option - 

Semi-Automatic/Manual Sample Injection Mode

CytExpert Default Software Option - Plate Loader 

Sample Injection Mode

CytExpert User Management Option - 

Semi-Automatic/Manual Sample Injection Mode

CytExpert User Management Software Option - 

Plate Loader Sample Injection Mode

CytExpert Electronic Record Management 

Software Option - Semi-Automatic/Manual 

Sample Injection Mode

CytExpert Electronic Record Management 

Software Option - Plate Loader Sample Injection 

Mode
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Log Menu

Used to access logs including the Experiment Operation Log, the System Operation Log, and the 
User Management Operation Log.

CytExpert User Management Software Option

CytExpert Electronic Record Management Software Option

NOTE The Log menu is not available in the CytExpert Default software option.

Signature Menu

Used to sign experiment and view signature details.

CytExpert Electronic Record Management Software Option

NOTE The Signature menu is only available in the CytExpert Electronic Record Management software option.

Backup/Restore Menu

Used to backup/restore databases. Refer to Backup and Restore in CHAPTER 9, Troubleshooting.

NOTE The Backup/Restore menu is not available in the CytExpert Default software option. 

Help Menu

For displaying software version information and system Instructions for Use.

NOTE The Help menu is the same for the CytExpert Default, CytExpert User Management, and CytExpert 

Electronic Record Management software options.
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User Management

IMPORTANT Only an Administrator can manage users. You must have either the CytExpert User 

Management or CytExpert Electronic Record Management software option installed to use this feature. 

Refer to CytExpert Software Installation Options in CHAPTER A, Instrument Installation.

User Management is used to create and manage user accounts.

Select Account > User Manager. The User Manager window appears.

Figure 2.5  User Manager (Card View)
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Figure 2.6  User Manager (Grid View)

1. Search text box: Filters users by username and 

display name.

2. View drop-down: Toggles between Card View 

(see Figure 2.5) and Grid View (see Figure 2.6).

3. New: Used to create a new user profile.

4. Modify: Used to modify an existing user profile.

5. Delete: Used to delete an existing user profile.

6. Unlock: Used to unlock an existing account that 

has been locked.

NOTE An account locks after 3 failed password 

attempts. The number of attempts can be 

changed by the administrator. Refer to 

Account Policies.

NOTE An account automatically unlocks after 

30 minutes. The duration can be changed 

by the administrator. Refer to Account 

Policies.

7. Reset Password: Used to reset an existing user 

password to the default password: password.

8. Close: Closes the User Manager window.
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Creating, Deleting, and Modifying Users in User Manager

Creating a New User in User Manager

1 Select  in the User Manager window. The New window appears.

2 Fill in the new user information.

a. Enter the Username.

b. Enter the Full Name.

c. Select the user Role.

d. Select the Enabled checkbox to enable the user.

NOTE The Enabled checkbox can only be changed by an administrator.

3 Select . The new user displays in User Manager.

4 Select .
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Deleting Users in User Manager

IMPORTANT If an account has been used and log information has been generated related to it, the account 

cannot be deleted, but it can be disabled.

1 Select the user to be deleted in the User Manager window then select .

NOTE The user 'Admin' is a system default user and cannot be deleted.

2 Select .

Modifying Users in User Manager

IMPORTANT If an account has been used and log information has been generated related to it, the 

username cannot be modified.

1 Select  in the User Manager window. The Modify window appears.

NOTE The user 'Admin' is a system default user and cannot be modified.

2 Modify the user information as necessary.

NOTE Uncheck the enabled box to disable a user.

3 Select .

4 Select .
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Unlocking a User Account

Select a Locked user in the User Manager window and select Unlock. 

NOTE You cannot unlock an active user.

Resetting a User Passwords

Select a user in the User Manager window then select . The user password is 
automatically reset as password.

Changing a User Password

1 Select Account > Change Password. The Change Password window appears.

2 Enter the current password, the new password, and confirm the new password.

3 Select .

Role Management

IMPORTANT Only an Administrator can manage users. You must have either the CytExpert User 

Management or CytExpert Electronic Record Management software option installed to use this feature. 

Refer to CytExpert Software Installation Options in CHAPTER A, Instrument Installation.

Role Management is used to manage user account permissions.

NOTE Multiple users can be applied to the same role.
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Select Account > Role Manager. The Role Manager window appears. Refer to Figure 2.7.

Figure 2.7  Role Manager

1. New: Used to create a new role profile.

2. Modify: Used to modify an existing role profile.

3. Delete: Used to delete an existing role profile.

4. Close: Closes the Role Manager window.
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Creating, Deleting, and Modifying User Roles in Role Manager

Creating New User Roles in Role Manager

1 Select . The New window appears.

2 Fill in the new role information.

a. Enter the role name.

b. Enter the role description.

c. Select the permissions applicable to the new role.

3 Select . The new role displays in the role list.

4 Select .
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Deleting User Roles in Role Manager

IMPORTANT If a role has already been assigned to a user, that role cannot be deleted.

IMPORTANT The Administrator and Operator Roles are system defaults and may not be deleted.

1 Select the Role to be deleted in Role Manager then select .

2 Select .

Modifying User Roles in the Role Window

IMPORTANT The Administrator and Operator Roles are system defaults and may not be modified.

1 Select . The Modify window appears.

2 Modify the role information as necessary.

3 Select .
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4 Select .

Account Policies

IMPORTANT Only an Administrator or an account has the Manage user permission can manage users. You 

must have either the CytExpert User Management or CytExpert Electronic Record Management software 

option installed to use this feature. Refer to CytExpert Software Installation Options in CHAPTER A, 

Instrument Installation.

Account policies is used to define the default properties for the password policy, account lockout 
policy, and application inactivity policy.

Select Account > Account Policies. The Account Policies window appears.

Figure 2.8  Account Policies - Password Policy

NOTE The allowable range for each entry is as follows:

 • Password History: 12-24 times

 • Password Length: 8-14 characters

 • Minimum Age for Password: 0-998 days

 • Password Expiration: 1-999 days

 • Reminder for Expiration: 1-90 days
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Figure 2.9  Account Policies - Account Lockout Policy

NOTE The allowable range for each entry is as follows:

 • Invalid Login Attempts: 3-10 times

 • Lockout Duration: 15-1440 minutes

Figure 2.10  Account Policies - Application Inactivity Policies

NOTE The allowable range for each entry is as follows:

 • Inactivity Duration: 1-60 minutes
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User Management Operation Log

IMPORTANT You must have either the CytExpert User Management or CytExpert Electronic Record 

Management software option installed to use this feature. Refer to CytExpert Software Installation 

Options in CHAPTER A, Instrument Installation.

Viewing and Exporting User Logs

1 Select Log > User Management Operation Log. The Logs window appears.

2 Enter the filter conditions: User and Time Range. 

3 To export the log, select .

NOTE User logs are exported as a .pdf or .csv file.
B49006AM   2-33



Using the CytExpert Software

Graphic and Gating Styles  
Graphic and Gating Styles

Plots

The CytExpert software offers a variety of plot formats including:

 • Single-parameter plots and histogram overlays

 • Dual-parameter plots: dot plots, density plots, pseudo color plots, contour plots, and dot plot 
overlays

NOTE Histogram Overlays and Dot Plot Overlays can only be created from multiple samples in the 

Analysis screen. A maximum of 10 samples can be overlaid.

Histogram Multi-sample histogram overlays

Dot plot Density plot
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Gates

Various gating choices are available. 

The software includes the following gate types:

 • For dual-parameter plots: lasso, polygon, rectangle, four-quadrant, hinged gates, and auto 
polygon

 • For single-parameter plots: line-segment, vertical gates, and auto line segment

Pseudo color plot Contour plot Dot plot overlay

Lasso gate Polygon gatea Rectangle gate

Four-Quadrant gate Hinged gate Line Segment gatea
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Plate Type Library

The Plate Type Library is used to manage and calibrate plates. Plates can be added, deleted, 
duplicated, and edited from the Plate Type Library. To calibrate a plate, refer to Calibrating the 
Plate Position [With Plate Loader] in CHAPTER 11, Replacement/Adjustment Procedures.

Select Advanced > Plate Type Library to access the Plate Type Library. Refer to Figure 2.11.

Figure 2.11  Plate Type Library 

Vertical gate

a. This gate can be created using the autogate functionality. Refer to Creating and Adjusting Auto Gates in CHAPTER 5, Data 

Acquisition and Sample Analysis

1. Active. Indicates that the plate type is available 

for use.

2. Default. Applies the default settings.

3. Add. Creates a new plate. 4. Edit. Edits a plate.

5. Duplicate. Duplicates a plate. 6. Delete. Deletes an existing plate.

7. OK. Saves the plate type. 8. Cancel. Cancels the settings.
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Adding a Plate Type

1 Select .

2 Select Advanced > Plate Type Library. The Plate Type Library window appears.

3 Select Add. The Add Plate Type window appears.
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4 Enter the plate name in the Name section of the screen. 

5 Select the Plate Mode. 
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6 Enter the Mix time. 

NOTE The default setting is 5 seconds in Standard Mixing Mode. The default setting is 10 seconds (for 

0.5 mL sample) in Deep Well Mixing Mode. You might need custom the Mix time according to the 

sample volume.

7 Place the new plate on the plate holder. 

8 Select Calibrate to calibrate the plate position. Refer to Calibrating the Plate Position [With 

Plate Loader] in CHAPTER 11, Replacement/Adjustment Procedures.

NOTE It is required to calibrate the plate position when adding a new plate.
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9 Select OK. The plate is added into the Plate Type Library.

10 Select OK.
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Editing a Plate Type

1 Select Advanced > Plate Type Library. The Plate Type Library window appears.

2 Select the plate type to be edited, and select Edit. The Edit Plate Type window appears.

3 Enter the Mix setting. 

4 Optional: Enter any remarks. 
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5 Optional: Select Calibrate to calibrate the plate position. Refer to Calibrating the Plate Position 

[With Plate Loader] in CHAPTER 11, Replacement/Adjustment Procedures

The Calibration can be performed at any time.

6 Select OK.

Duplicating a Plate Type

1 Select Advanced > Plate Type Library. The Plate Type Library window appears.
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2 Select the plate type to duplicate, and select Duplicate. The Duplicate Plate Type window 

appears.

3 Enter the Mix setting. 

4 Optional: Enter any remarks. 

5 Optional: Select Calibrate to calibrate the plate position. Refer to Calibrating the Plate Position 

[With Plate Loader] in CHAPTER 11, Replacement/Adjustment Procedures

The Calibration can be performed at any time. The duplication retains the calibration 
information if the original plate was already calibrated.

6 Select OK.
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Deleting a Plate Type

1 Select Advanced > Plate Type Library. The Plate Type Library window appears.

2 Select the plate type to be deleted, and select Delete. The following message appears:

NOTE The default plate types, shown in bold, cannot be deleted from the Plate Type Library.

3 Select Yes. The selected plate type is removed from the Plate Type Library.
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Software Settings

Select Options in the Settings menu to configure the software settings.

In the experiment settings, you can set the experiment’s default save path.

NOTE The Experiment setting is only available if either the CytExpert Default or the CytExpert User 

Management software option is installed.
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In the tube settings, you can select the columns that display in the tube section of the screen.

In the plot settings, you can define the background of the graphics display area, configure the 
histograms, and set the default signal parameters to either the channel’s area or the channel’s 
height. The default is area. You can also set the default axis display range. 
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In the Gate settings, you can choose to display population percentage on all plots except overlay.

In the Page Setup settings, you can change the page size, orientation, margin size, and display 
options. Select Show page breaks to display page boundaries within the Acquisition or Analysis 
views for simplifying plot arrangement for printing.
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In the plate loader settings, you can select the plate type, sampling sequence, mix, and backflush 
settings for the plate loader.

NOTE This setting is only available in the Plate Loader sample injection mode.

Language Settings

Select Settings > Language Settings to open the Language Settings window. In the Language 
Settings window, you can select which language to use for the software menus and graphical 
statistics. The two options currently offered are English and Simplified Chinese.

Setting Up CytExpert Application Programming Interface (API) Test Client

The CytExpert API is available for external software to control CytoFLEX series instruments. It 
allows external software to perform operations such as running methods and allows for basic 
control of the plate loader. It is also possible to report population statistics as each sample finishes. 
Contact us to request a copy of the CytExpert API Instructions for Use manual.
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CHAPTER 3

Daily Startup

Overview

IMPORTANT Verify that the correct USB configuration key is securely connected to a computer USB port. If 

the USB configuration key is not connected, the following error message appears: CytExpert cannot find 

the license. Please check whether the correct USB configuration key has been plugged in.

This chapter describes the instrument startup procedure.

Workflow:

This chapter contains information on:

 • Pre-Startup Inspection

 • Turning On the Instrument

 • Logging Into the Software

 • Initializing the Instrument

Pre-Startup Inspection

Before using the CytoFLEX or CytoFLEX LX flow cytometer, perform the following system checks.

Pre-startup 

inspection
Ô Turn on power Ô Open software Ô Initialize instrument
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Check Waste and Reagent Levels [4 L Fluid Containers]

CAUTION

Risk of instrument damage. Do not use a saline-based sheath fluid on the 

CytoFLEX instrument. Saline-based sheath fluid could damage instrument 

components. Beckman Coulter recommends using CytoFLEX Sheath Fluid or a 

similar nonionic sheath fluid to ensure system performance.

1 Examine the sheath fluid and waste containers. Verify that there is sufficient sheath fluid in the 

sheath fluid container and that the waste container is empty.

NOTE When the sheath fluid container is near empty or the waste container is near full, a warning 

message is transmitted to the Workstation and audible signals sound as a warning.

CAUTION

Risk of instrument damage. Remove the sheath fluid container from the Fluid 

Container holder before filling the sheath fluid container to avoid damage to 

instrument electronics. 

2 If necessary, fill the sheath fluid container with CytoFLEX Sheath Fluid or a similar nonionic 

sheath fluid while not exceeding the maximum volume indicated (4 L). Refer to Filling the 4 L 
Sheath Fluid Container [CytoFLEX] in CHAPTER 10, Cleaning Procedures.

1. Sheath fluid container

2. Waste container

Sheath SheathWaste

c
b
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WARNING

Risk of chemical injury from bleach. To avoid contact with the bleach, use barrier 

protection, including protective eyewear, gloves, and suitable laboratory attire. 

Refer to the Safety Data Sheet for details about chemical exposure before using 

the chemical.

3 If necessary, empty all waste liquid from the waste container. If biohazardous samples are used 

for data collection, add 400 mL of 5 to 6% bleach to the waste container. Refer to Emptying the 
4 L Waste Container [CytoFLEX] in CHAPTER 10, Cleaning Procedures.

4 Verify that the Fluid Containers and the Cytometer are on the same level.

5 Verify that all sheath fluid tubing, waste tubing, and sensor cables are properly connected, as 

shown in the figure:

1. Waste level sensor connector. Connects to the waste liquid sensor cable.

2. Flow cell waste out. Connects to the flow cell waste tubing.

3. Sheath fluid level sensor connector. Connects to the sheath fluid sensor cable.

4. Waste out. Connects to the waste liquid tubing.

5. Sheath return. Connects to the sheath fluid tubing.

6. Sheath fluid in. Connects to the sheath fluid tubing.

gfe

dcb
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Check Waste and Reagent Levels [10 L Fluid Cubitainers]

CAUTION

Risk of instrument damage. Do not use a saline-based sheath fluid on the 

CytoFLEX Series instrument. Saline-based sheath fluid could damage instrument 

components. Beckman Coulter recommends using CytoFLEX Sheath Fluid or a 

similar nonionic sheath fluid to ensure system performance.

1 Examine the sheath fluid and waste cubitainers. Verify that there is sufficient sheath fluid in 

the sheath fluid container and that the waste container is empty.

NOTE When the sheath fluid container is near empty or the waste container is near full, a warning 

message is transmitted to the Workstation and audible signals sound as a warning.

2 Confirm that the instrument is in the standby state. 

3 If necessary, replace the sheath fluid cubitainer with CytoFLEX Sheath Fluid or a similar 

nonionic sheath fluid. Refer to Replacing the 10 L Sheath Fluid Cubitainer in CHAPTER 10, 
Cleaning Procedures.

4 If necessary, empty all waste liquid from the waste container. Refer to Emptying the 10 L Waste 

Cubitainer in CHAPTER 10, Cleaning Procedures.

5 Verify that the Fluid Cubitainers and the Cytometer are on the same level.

REACTIVE INGREDIENTS: Anti-microbial compound

A nonionic, non-flourescent, and azide free sheath fluid 
for use on Beckman Coulter CytoFLEX flow cytometers.

10 L

Cyto FLEX
Sheath Fluid
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6 Verify that all sheath fluid tubing, waste tubing, and sensor cables are properly connected, as 

shown in the figure:

Power Source Inspection

Check the power cable located below the power switch on the back of the Cytometer, and verify it 
is securely connected to both the Cytometer and the power source.

Workstation Connections Inspection

Check that the monitor, mouse, keyboard, and the Cytometer are properly connected to the 
computer. Refer to Figure 1.21.

1. Waste level sensor connector. Connects to the waste liquid sensor cable.

2. Flow cell waste out. Connects to the flow cell waste tubing.

3. Sheath fluid level sensor connector. Connects to the sheath fluid sensor cable.

4. Waste out. Connects to the waste liquid tubing.

5. Sheath return. Connects to the sheath fluid tubing.

6. Sheath fluid in. Connects to the sheath fluid tubing.

gfe

dcb
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Turning On the Instrument

CAUTION

1. If the Cytometer or Workstation fails to start properly, check first to see 

whether the power cable and connection cables are properly connected.

2. Never shut off the power or disconnect a data cable while the Cytometer is 

performing a task. Doing so can result in data loss or damage to the system.

1 Turn on the main power switch located on the back of the Cytometer.

2 Wait for the Cytometer to finish powering on, then turn on the Workstation.

Logging Into the Software

1 Log in to the Windows operating system and double-click the CytExpert desktop icon  to 

open the software.

If you are running the CytExpert Default software installation, login is not required. Proceed to 
Step 4.

If you are running either the CytExpert User Management or the CytExpert Electronic Record 
Management software installation, the login window appears.

NOTE The default software shortcut appears on the desktop. If you do not see the icon, the default 

installation path is under C:/Program Files/CytExpert. Double-click CytExpert.exe to run the software.

2 Enter your username and password.
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3 Select .

NOTE The display name of the user that is currently logged in displays in the top, right corner of the 

software screen.

4 Confirm that the software and the Cytometer are properly connected.

a. Open the software. The Startup screen appears.

[CytExpert Electronic Record Management Software Option Shown]

b. Verify that the connection indicator light in the lower left corner of the software screen is 
green, and Connected is displayed. The left side shows the connection status, the middle 
shows the instrument status, and the right side shows the status details.
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c. Verify that the Sheath and Waste flow indicators in the lower right corner of the software 
screen are green indicating that the fluidics system is normal. 

NOTE

 • A red connection indicator light indicates that there is a faulty connection. Ensure that the 

instrument is properly turned on and connected. If necessary, restart both the Cytometer 

and the Workstation.

 • After the instrument initializes, a warning beep sounds if there is a problem with the fluidics 

system. If a flow indicator is red and blinking, it means that the fluidics system requires 

attention.

 • When the waste fluid sensor is disconnected, the waste flow indicator shows that the waste 

container is full or nearly full.

 • Select the status information in the lower left to open the system log. Send a copy of the 

system log to your Beckman Coulter Representative for support if a service call is 

requested.
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Logging Out of the Software

If you have the CytExpert User Management or the CytExpert Electronic Record Management 
software option installed, select the username displayed in the top-right corner of the software 
screen and select Log out.

If you have the CytExpert Default software option installed, log out is not required. Select File > Exit 
to close the CytExpert software.

Locking the Account

If you have the CytExpert User Management or the CytExpert Electronic Record Management 
software option installed, select the username displayed in the top-right corner of the software 

screen and select .

The account locks automatically if it remains inactive for a specified duration. Refer to Account 
Policies - Application Inactivity Policies in CHAPTER 2, Using the CytExpert Software.

Selecting the Proper Sample Injection Mode

Select Sample injection Mode in the Cytometer Menu to change between the Semi-Automatic 
Injection mode and the Manual Injection mode. The Semi-Automatic Injection mode is 
recommended under most circumstances. The Manual Injection mode can be used for two 
B49006AM   3-9



Daily Startup

Logging Into the Software  
purposes: running 1.5-mL and 2-mL microcentrifuge sample tubes and a backup mode that allows 
you to continue to collect data if the Semi-Automatic Injection mode is not working correctly.

Using Semi-Automatic Injection Mode

1 Select Sample Injection Mode >Semi-Automatic in the Cytometer menu to change the Sample 

Injection mode selection. The sampler status icon located in the bottom right side of the screen 
changes to display Semi-automatic Sampler. 

2 Select Initialize. The sample tube holder swings out from the standby position to the sample 

loading position (see Figure 1.12) so that you can load the sample tube.

NOTE You can also swing out the sample tube holder manually, load the sample tube, then select 

Initialize.

3 Select Run. The sample tube holder automatically swings back to the standby position and 

raises the sample tube to the sample acquisition position (see Figure 1.12), where the 
instrument mixes the sample and transfers the sample to the flow cell.
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At the flow cell, the sample runs at the designated flow rate and the Cytometer begins to 
acquire data.

NOTE You can also push the load button on the front of the instrument to automatically start the run 

and record the data.

4 When you are satisfied with the data, select Record to record the data.

5 Wait for the data acquisition to finish or select Stop. The sample tube holder automatically 

lowers the sample tube and moves it to the sample loading position (see Figure 1.12) and the 
Cytometer backflushes the sample probe.

WARNING

Risk of biohazardous contamination. When using 1.5-mL and/or 2-mL sample 

tubes, always cut the cap off and do not exceed 300-μL sample volume. Running 

samples with a cap attached to the sample tube or with volumes exceeding 300 μL 

can result in sample splashing.

Using the Manual Injection Mode

1 Select Sample Injection Mode > Manual in the Cytometer menu to change the Sample Injection 

mode selection. The sampler status icon located in the bottom right side of the screen changes 
to display Manual Sampler. 

2 Manually swing the sample tube holder out from the standby position to the sample loading 

position (see Figure 1.12).
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3 Select Initialize.

4 Load the sample tube.

NOTE The sample tube holder accommodates 1.5-mL, 2.0-mL, and 12 x 75 mm sample tubes.

5 Manually swing the sample tube holder gently back to the standby position (see Figure 1.12). 

6 Manually raise the sample tube holder gently to the sample acquisition position (see 

Figure 1.12) and hold the tube in that position.

7 Select Boost to transfer the sample to the flow cell.

8 Select Run.

The sample runs at the designated flow rate and the Cytometer begins to acquire data.

9 When you are satisfied with the data, select Record to record the data.

10 Wait for the data acquisition to finish or select Stop. Then, manually lower the sample tube 

holder and move it to the sample loading position (see Figure 1.12).

11 Select Backflush to clean the probe.

Selecting the Plate Loader Sample Injection Mode [With Plate Loader]

Select Sample injection Mode in the Cytometer Menu to change between the Semi-Automatic 
Injection mode, the Manual Injection mode, and the Plate Loader Injection mode. The Plate Loader 
Injection mode can be used for running small volumes using the following plates: 96-well 
flat-bottom, 96-well V-bottom, and 96-well U-bottom.
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[CytoFLEX Shown]

Using Plate Loader Injection Mode

1 Select Sample Injection Mode > Plate Loader in the Cytometer menu to change the Sample 

Injection mode selection. 

2 The restart warning prompt appears on screen. Select OK. 

NOTE The restart warning only appears when switching to and from the Plate Loader sample injection 

mode.

3 Turn the Cytometer's main power switch off.

NOTE If you have a CytoFLEX LX instrument, you can turn the Cytometer’s power off by selecting 

Cytometer > Turn Off.
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IMPORTANT If you have the Sample Injection Mode Control Kit installed on your CytoFLEX or CytoFLEX LX 

instrument, refer to APPENDIX C, Sample Injection Mode Control Kit for detailed instructions on switching 

from the single tube sample probe to the Plate Loader.

IMPORTANT If you have the Sample Injection Mode Control Kit installed on your CytoFLEX Series 

instrument, refer to CHAPTER A, Instrument Installation for detailed instructions on switching from the 

single tube sample probe to the Plate Loader.

4 Remove the single tube sample probe and replace it with the plate loader PEEK tubing. Refer to 

Changing the Sample Probe from the Plate Loader to the Single Tube Sample Station [CytoFLEX 
With Plate Loader] in CHAPTER 10, Cleaning Procedures.

5 Turn the Cytometer’s main power switch on.

The sampler status icon located in the bottom right side of the screen changes to display Plate 
Loader.

NOTE If you have a CytoFLEX LX instrument, you can turn the Cytometer’s power on by selecting 

Cytometer > Turn On.

6 Select Initialize.

7 Select Eject.

8 Place the plate flat on the plate holder and ensure that it is secure.

[Standard 96-Well Plate in the Plate Holder (Without Groove)]

A1
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[Standard 96-Well Plate in the Plate Holder (With Groove)] 

[96-Well Deep Well Plate Only]

NOTE Ensure that plate well A1 aligns with position A1 on the plate holder.

9 Select Load to load the plate.

10 Select Run. The plate loader automatically loads the plate holder stage and begins to acquire 

data.

11 When you are satisfied with the data, select Record to record the data.

A1

A1
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12 Wait for the data acquisition to finish or select Stop. The Cytometer backflushes the sample 

probe.

13 Select Eject to eject the sample loader.

Running the System Startup Program [with the Single Tube Loader]

IMPORTANT Instructions on the software window vary depending on whether you are in semi-automatic 

injection mode or manual injection mode.

The system startup program takes approximately 10 minutes if the fluidic self-check is enabled. The 
system startup program takes approximately 8 minutes if the fluidic self-check is not enabled.

NOTE The fluidic self-check is an optional feature only available when the sheath damper upgrade is 

implemented.

1 Select Initialize.

2 Select System Startup Program in the Cytometer menu.

[CytoFLEX LX Shown]
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3  If the confirm window appears, select Yes.

4 The System Startup Program window appears. Select Initialize.

System Startup Program Window in Semi-Automatic Injection Mode

System Startup Program Window in Manual Injection Mode
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5 Wait for the system to initialize. Follow the on screen software prompts, then select Start.

The instrument begins to prime or run the fluidic self-check. This process takes about 4 minutes 
if the fluidic self-check is enabled. This process takes about 1 minute if the fluidic self-check is 
not enabled.

After priming or running the fluidic self-check, the system initializes again. The sample is 
loaded automatically. This process takes about 3 minutes.
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The sample tube is unloaded after sample acquisition has finished. The system uses the 
remaining time to warm up.

6 When warm up is finished, select Close to quit the startup program. The system is now 

initialized.

Running the System Startup Program [With Plate Loader]

The system startup program takes approximately 10 minutes if the fluidic self-check is enabled. The 
system startup program takes approximately 8 minutes if the fluidic self-check is not enabled. 

NOTE The fluidic self-check is an optional feature only available when the sheath damper upgrade is 

implemented.

1 Select Initialize.
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2  If the confirm window appears, select Yes.

3 Select System Startup Program from the Cytometer menu to open the System Startup Program 

window.

[CytoFLEX LX Shown]
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The plate loader automatically ejects the plate holder stage and the System Startup Program 
window appears.
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4 Select the desired plate type from the Plate Type drop-down menu.

NOTE The available plate types included in the drop-down menu depend on the settings selected in the 

Plate Library. To activate a plate type, refer to Plate Type Library in CHAPTER 2, Using the CytExpert 

Software.
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5 Follow the on screen software prompts and select the desired wells and select Set As Deionized 

Water Well.

NOTE To deselect water wells, select the desired well and select Set As Empty Well.

NOTE Prepare two to six sample wells with deionized water.

6 Select Load to load the plate.

7 Select Start to start the program. The message Please confirm that the correct plate is placed 

properly and press OK appears. Select OK.
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Wait for the system to initialize. The instrument begins prime or run the fluidic self-check. This 
process takes about 1 minute if the fluidic self-check is not enabled. This process takes about 4 
minutes if the fluidic self-check is enabled.
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After priming or running the fluidic self-check, the system initializes again. The sample is 
loaded automatically. This process takes about 1 minute per well.
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When the system finishes acquiring the selected sample well, it uses the remaining time to 
warm up.
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8 When warm up is complete the plate loader ejects the plate holder stage. Select Close to quit 

the startup program. The system is now initialized.

Selecting Experiments from the Start Page

Refer to Start Page in CHAPTER 2, Using the CytExpert Software.
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Initializing the Instrument

1 Select Initialize in the Data Acquisition Control screen or select Initialize in the Cytometer Menu 

to initialize the instrument.

NOTE The system prompts you to initialize if the instrument remains in standby for over 24 hours. 

NOTE If the instrument is in Semi-Automatic Injection mode during the initialization process, the sample 

tube holder automatically shifts into the sample loading position (see Figure 1.12).

2 Wait for the beep indicating that the instrument properly initialized.

NOTE In the initialized state, the enabled lasers power on to achieve operating status, and the sheath 

fluid flows. Refer to Laser Settings in CHAPTER 5, Data Acquisition and Sample Analysis.

 • If you need to execute a task with the Fluid Containers, do so with the instrument in standby 

state.

 • If the instrument remains idle for 10 minutes, the Cytometer automatically enters the standby 

state.

NOTE After approximately 30 seconds, there should be a continuous flow of waste liquid from the 

Cytometer to the waste container.

3 Proceed to the subsequent operations or select Standby to put the instrument in standby state.
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CHAPTER 4

Instrument Quality Control and
Standardization

Overview

This chapter provides information on performing daily quality control (QC) on the CytoFLEX and 
CytoFLEX LX flow cytometer and how to confirm that the instrument is working properly within 
the specified parameters. Quality control allows you to determine whether your instrument can 
provide adequate signal strength and precision.

This chapter also provides information on performing standardization. CytoFLEX Daily QC 
Fluorospheres or any other reference material that is relevant for your application(s) may be used 
as the standardization sample(s). The system can only recognize a single peak. 

Standardization can be used to monitor the Median Fluorescent Intensities (MFI), or target values 
for scatter and fluorescent parameters that have been defined and optimized for a specific 
application. All channels in the current configuration, those with/without an assigned QC target, 
can be tracked as necessary via Standardization since this portion of the CytExpert Software is used 
to assess application specific settings. Standardization, however, does NOT replace QC as the 
Cytometer's optical alignment (rCV statistical analysis), Laser Power and Laser Delay outputs are 
not measured during the run. 

Ensure that the standardization sample has been run at optimized experiment settings to 
determine the standardization sample threshold setting as well as median values for all relevant 
channels.

The QC process verifies important system functions. The system:

1. Verifies that the unit hardware configuration matches the default configuration specified in 
the software. Refer to Verifying, Selecting, Editing, and Creating Detector Configuration in 
CHAPTER 5, Data Acquisition and Sample Analysis. 

2. Measures the laser power of each individual laser and ensures that each laser meets the system 
specifications.

3. Loads the QC sample and begins to acquire data.

4. Verifies that the actual laser delays match those set in the software and will adjust the delay 
accordingly.

5. Notifies you if laser delay is >2 μs from the previous setting. The software automatically 
changes the laser delay setting.

OR

Notifies you if laser delay is >5 μs from the previous setting. Manual laser delay adjustments are 
required. Refer to Setting Laser Delay in CHAPTER 11, Replacement/Adjustment Procedures.
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6. Verifies and calibrates the gain settings. If any of these parameters are outside of the operating 
limits, the system automatically adjusts these parameters. If the system is unable to adjust 
these parameters to fall within the operating limits, the system notifies you.

NOTE Beckman Coulter recommends performing QC on a daily basis.

NOTE QC can only be run in channels with the standard detector sets including, laser and band-pass. Refer 

to Verifying, Selecting, Editing, and Creating Detector Configuration in CHAPTER 5, Data Acquisition and 

Sample Analysis to verify that the default factory detector configuration is selected before running QC.

NOTE CytExpert QC includes auto daily QC routine with Levey-Jennings (LJ) charts tracking and logging.

NOTE CytExpert standardization allows for application-specific settings to be established and applied to 

future experiments.

QC Workflow:

Standardization Workflow:

This chapter contains information on:

 • Preparing the QC Sample

 • Preparing the QC Sample [With Plate Loader]

 • Importing Lot-Specific Target Values

 • Collecting QC Data

 • Collecting QC Data [With Plate Loader]

 • Confirming Results

 • Standardization

Prepare the QC 

sample
Ô

Enter the QC 

experiment
Ô

Select QC 

target values
Ô Acquire data Ô Confirm results

Prepare the 

standardization 

sample

Ô

Enter the 

standardization 

experiment

Ô
Select target 

values
Ô Acquire data Ô

Import 

standardization 

settings into 

associated 

experiments
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Preparing the QC Sample

Required Materials

The following materials are required to complete the QC process:

 • CytoFLEX Daily QC Fluorospheres

 • CytoFLEX Sheath Fluid or another nonionic sheath fluid

 • Sample tubes (12 x 75 mm).

 • Vortexer

 • CytoFLEX Daily IR QC Fluorospheres (for systems configured with an IR laser)

Preparation Process CytoFLEX Daily QC Fluorospheres

1 Take one sample tube and label it as the QC sample tube.

2 Add approximately 1 mL of deionized water to the sample tube.

3 Use the vortexer or shake vigorously to thoroughly mix the bottle of CytoFLEX Daily QC 

Fluorospheres.

4 Add three drops of CytoFLEX Daily QC Fluorospheres to the sample tube.

5 Vortex the sample tube until a uniform mixture is achieved. 

6 Place the sample tube in a dark location at 2-8 �C until ready to load the tube into the 

instrument for QC.

NOTE Tubes containing diluted CytoFLEX Daily QC Fluorospheres should be stored and sealed in a dark 

location at 2-8 �C for up to 5 days.

Preparation Process CytoFLEX Daily IR QC Fluorospheres

1 Take one sample tube and label it as the QC/IR sample tube.

2 Mix the CytoFLEX Daily IR QC Fluorospheres by inversion.
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3 Add ten drops of CytoFLEX Daily IR QC Fluorospheres to the sample tube.

4 Place the sample tube in a dark location at 2-8 �C until ready to load the tube into the 

instrument for QC.

NOTE Tubes containing diluted CytoFLEX Daily IR QC Fluorospheres should immediately be sealed and 

sealed in a dark location at 2-8 �C for up to 5 days.

Preparing the QC Sample [With Plate Loader]

Required Materials

The following materials are required to complete the QC process:

 • CytoFLEX Daily QC Fluorospheres

 • CytoFLEX Daily IR QC Fluorospheres (for systems configured with an IR laser)

 • CytoFLEX Sheath Fluid or another nonionic sheath fluid

 • Standard 96-well plate

— 96-well flat-bottom

— 96-well V-bottom

— 96-well U-bottom

 • 96-well deep well plate

— 96-well V-bottom

— 96-well U-bottom

 • Vortexer

Preparation Process CytoFLEX Daily QC Fluorospheres

1 Take one 96-well plate and label one well as the QC sample well.

2 Use the vortexer or shake vigorously to thoroughly mix the bottle of CytoFLEX Daily QC 

Fluorospheres.

IMPORTANT Do not overfill the sample well.

3 Add one drop of CytoFLEX Daily QC Fluorospheres to the sample well.
B49006AM   4-4



Instrument Quality Control and Standardization

Importing Lot-Specific Target Values  4
4 Add approximately 200 �L of deionized water to the sample well.

5 Place the well plate in a dark location at 2-8 �C until ready to load the well plate into the 

instrument for QC.

NOTE Well plates containing diluted CytoFLEX Daily QC Fluorospheres should be stored sealed in a dark 

location at 2-8 �C for up to 5 days.

Preparation Process CytoFLEX Daily IR QC Fluorospheres

1 Take one 96-well plate and label one well as the QC/IR sample well.

2 Mix the CytoFLEX Daily IR QC Fluorospheres by inversion.

IMPORTANT Do not overfill the sample well.

3 Add 3-4 drops of CytoFLEX Daily IR QC Fluorospheres to the sample well.

4 Place the well plate in a dark location at 2-8 �C until ready to load the well plate into the 

instrument for QC.

NOTE Well plates containing CytoFLEX Daily IR QC Fluorospheres should immediately be sealed and 

stored  in a dark location at 2-8 �C for up to 5 days.

Importing Lot-Specific Target Values

Import lot-specific target values for each new lot of CytoFLEX QC Fluorospheres and CytoFLEX Daily 
IR QC Fluorospheres.

CAUTION

Risk of erroneous QC results. Different target value information correspond to 

different lot numbers. Selecting the wrong lot number will lead to erroneous QC 

results.

1 Open the CytExpert QC screen.
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2 Select Target Library from the Settings menu. The Target Library window appears. 
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IMPORTANT The Beckman Coulter website may prompt you to select your Region and Country prior to the 

Beckman Coulter Technical Documents and Software page.

3 Select Download Target File. The Beckman Coulter Technical Documents and Software 

Downloads page appears.

NOTE If your CytoFLEX Workstation does not have access to the internet, navigate to https://

www.beckmancoulter.com/wsrportal/page/softwareDownloadSearch using a computer with access 

to the internet and save the file to a USB drive. If the website is not accessible, contact us.

4 If necessary, register and log in to the Beckman Coulter website.

5 In the Search By Product section of the screen, select the following:

a. Select Research & Discovery from the Market Segment drop-down menu.

b. Select Flow Cytometry from the Product Line drop-down menu.

c. Select Instruments from the Product Series drop-down menu.

d. Select CytoFLEX from the Product drop-down menu.

e. Select CytoFLEX QC Fluorospheres Target or CytoFLEX IR QC Fluorospheres Target from the 
Software Name drop-down menu.

f. Select All from the Lot Number drop-down menu.

g. Select English from the Language drop-down menu.
B49006AM   4-7

https://www.beckmancoulter.com/wsrportal/page/softwareDownloadSearch
https://www.beckmancoulter.com/wsrportal/page/softwareDownloadSearch


Instrument Quality Control and Standardization

Importing Lot-Specific Target Values  
[CytoFLEX QC Fluorospheres Target]

[CytoFLEX IR QC Fluorospheres Target]

6 Select Search.

7 The search results appear below the Search By Lot Number tab.

[CytoFLEX QC Fluorospheres Target]
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[CytoFLEX IR QC Fluorospheres Target]

8 Select CytoFLEX QC Fluorospheres Target Values under the Software Name column. The 

CytoFLEX QC Fluorospheres Target Values page appears.

9 Select Download under the correct lot number from the CytoFLEX QC Fluorospheres Target 

Values page. 
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10 If the File Download pop up window appears, select Save and browse to the desired file path.

11 Select Import from the Target Library window in the CytExpert software.

12 Navigate to the file saved in step 10 and select Open.

13 Select Close to exit the Target Library window.
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Collecting QC Data

QC data and reports are saved by default. Select QC/Standardization Setting in the Settings menu to 
change the default save settings or modify the file path these files are saved to.

1 Double-click  to start the CytExpert software.

a. Ensure that the Connected icon on the Status Bar near the bottom-left side of the display is 
green.

b. If the icon is not green, ensure that the Cytometer USB is securely connected to the 
Workstation and restart the Workstation.

2 Verify the detector configuration. Refer to Verifying, Selecting, Editing, and Creating Detector 

Configuration in CHAPTER 5, Data Acquisition and Sample Analysis.

NOTE Ensure that the instrument configuration is properly configured for the QC experiment. The QC 

experiment may not be completed or may end in erroneous results if incorrect settings are chosen. 

Beckman Coulter recommends using the factory configuration and ensuring that the proper optical 

filters are in place.

3 Verify the laser settings. Refer to Laser Settings in CHAPTER 5, Data Acquisition and Sample 

Analysis.
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Collecting QC Data  
4 Select Start QC/Standardization in the QC/Standardization menu to access the QC experiment. 

[CytoFLEX LX Shown]

Ensure that the QC bead lot number is selectable in the Lot No. drop down menu. If the lot 
number is not selectable, refer to Importing Lot-Specific Target Values, then select the proper 
lot number.

5 Select Initialize.

6 Insert the prepared QC sample tube (see Preparation Process CytoFLEX Daily QC Fluorospheres) 

into the tube holder.

7 Select Start to load the sample and begin to run the QC procedure.

Completed processes appear on the left. Plots appear on the right. The QC experiment 
sequentially detects the system configuration, laser power, laser delay, signal strength, and 
coefficient of variation.
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Collecting QC Data  4
During QC, the software automatically seeks the CytoFLEX Daily QC Fluorospheres and 
computes the results. The software returns to the QC Report screen after the QC run is 
complete. 

8 If the sampling rate is too low, the Cytometer stops the QC run and displays a prompt alerting 

you that the QC run failed to reach the required event flow rate. This is not considered a QC 
failure. If this situation occurs, increase the sample concentration by adding one drop of 
CytoFLEX Daily QC Fluorospheres to the sample tube and then perform the experiment.

9 Run Daily Clean to remove any residual fluorosphere particles. Refer to Daily Clean in 

CHAPTER 10, Cleaning Procedures.
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Collecting QC Data [With Plate Loader]  
Collecting QC Data [With Plate Loader]

QC data and reports are saved by default. Select QC/Standardization Setting in the Settings menu to 
change the default save settings or modify the file path these files are saved to.

1 Double-click  to start the CytExpert software.

a. Ensure that the Connected icon on the Status Bar near the bottom-left side of the display is 
green.

b. If the icon is not green, ensure that the Cytometer USB is securely connected to the 
Workstation and restart the Workstation.

2 Verify the detector configuration. Refer to Verifying, Selecting, Editing, and Creating Detector 

Configuration in CHAPTER 5, Data Acquisition and Sample Analysis.

NOTE Ensure that the instrument configuration is properly configured for the QC experiment. The QC 

experiment may not be completed or may end in erroneous QC results if incorrect settings are 

chosen. Beckman Coulter recommends using the factory configuration and ensuring that the proper 

optical filters are in place.

3 Verify the laser settings. Refer to Laser Settings in CHAPTER 5, Data Acquisition and Sample 

Analysis.

4 Select Start QC/Standardization in the QC/Standardization menu to access the QC experiment.
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Collecting QC Data [With Plate Loader]  4
[CytoFLEX LX Shown]

Ensure that the QC bead lot number is selectable in the Lot No. drop down menu. If the lot 
number is not selectable, refer to Importing Lot-Specific Target Values in CHAPTER 4, 
Instrument Quality Control and Standardization, then select the proper lot number.

5 Select Initialize.

6 Select Eject.

7 Insert the prepared QC well plate (see Preparation Process CytoFLEX Daily QC Fluorospheres) 

into the plate holder.
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Collecting QC Data [With Plate Loader]  
8 Select . The Plate Settings window appears.

IMPORTANT Ensure the well position on the plate matches the well position selected in the software.

9 Select the appropriate QC well.
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Collecting QC Data [With Plate Loader]  4
10 Select the desired plate type from the Plate Type dropdown menu.

NOTE The available plate types included in the dropdown menu depend on the settings selected in the 

Plate Library. Refer to Plate Type Library in CHAPTER 2, Using the CytExpert Software.

11 Select the Mix and Backflush settings in the top of the Plate Settings window.

12 Select OK.

13 Select Start to load the sample and begin to run the QC procedure. The message Please confirm 

that the correct plate is placed properly and press OK appears. Select OK.

Completed processes appear on the left. Plots appear on the right. The QC experiment 
sequentially detects configuration, laser power, laser delay, signal strength, and coefficient of 
variation.
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Confirming Results  
During QC, the software automatically seeks the CytoFLEX Daily QC Fluorospheres and 
computes the results. The software returns to the QC screen after the QC run is complete.

14 If the sampling rate is too low, the Cytometer stops the QC run and displays a prompt that the 

QC run fails to reach the required event flow rate. This is not considered a QC failure. If this 
situation occurs, increase the sample concentration by adding one drop of CytoFLEX Daily QC 
Fluorospheres to the sample tube and then perform the experiment.

15 Run Daily Clean to remove any residual fluorosphere particles. Refer to Daily Clean [With Plate 

Loader] in CHAPTER 10, Cleaning Procedures.

Confirming Results

Select Start QC/Standardization in the QC/Standardization menu to return to the QC Setting screen 
at any time to review completed experiment results.

1 Select the desired default configuration and date range from the drop-down menus located on 

the left side of the QC screen to sort by the configuration used during the specified date range.

NOTE At least one date range must be specified.
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2 Select a QC run from the QC Process list on the left and a QC report appears on the right.

NOTE The results column indicates a passing QC result with a  and a failed QC result with . 

QC results must meet the following criteria to pass:

 • The gain differences must be �20% from the target gain. 

 • The median fluorescence intensity (MFI) differences must be �5% from the target MFI.

 • The rCV must be within the range.

NOTE The CytoFLEX Daily QC Fluorospheres / Daily IR QC Fluorospheres (808 Laser) rCV must 

meet the following criteria to pass:

— The rCV for channels of the 405 nm, 488 nm, 561 nm, 638 nm lasers must be ≤5%.

— The rCV for channels of the 355 nm, 375 nm, 808 nm lasers must be ≤7%.
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Instrument Quality Control and Standardization

Confirming Results  
The report area on the right displays detailed experiment results, including laser power, delay, 

testing conditions, and signal results. The same  and  symbols are used to indicate each 
result. For items that fail, values falling outside the prescribed range are displayed in red font. 
In the Comment area, an explanation appears for each failed item.
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Confirming Results  4
Laser-filter combinations that are not part of a default configuration may not have a target 
value defined in the QC target file and therefore will not generate a result during QC. Use the 
Target Library in the QC screen of CytExpert Software to view the list of laser-filter 
combinations that have target values assigned within a target file and therefore will return a 
result for QC.
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Confirming Results  
If QC fails, follow the procedure below:

a. Verify whether the beads used were within their shelf life and stored in accordance with 
the appropriate instruction manual.

b. Verify whether the allocated sample tube was prepared as required and correctly 
positioned.

c. Run Priming the Flow Cell in CHAPTER 11, Replacement/Adjustment Procedures, and 
retest.

d. Run Daily Clean in CHAPTER 10, Cleaning Procedures, and retest.

e. Run Deep Clean Procedure in CHAPTER 10, Cleaning Procedures, and retest.

f. Repeat Steps c-d.

NOTE If QC fails two times in a row on the same day after repeating Steps a-f, contact us.

3 If necessary, you can select  (for CSV format) or  (for PDF format) in the top left corner 

of the report area to export the QC results.

4 Select Close QC/Standardization in the File menu to exit the QC screen.

Creating Levey-Jennings Charts

1 Select Start QC/Standardization in the QC/Standardization menu to open the QC screen.

2 Select LJ chart  on the left side of the screen.
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Confirming Results  4
IMPORTANT When there are multiple lots, select which lot to create the LJ charts from.

3 Select LJ Chart Settings  on the top of the LJ Chart screen. The LJ Chart Settings screen 

appears. 
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Confirming Results  
4 Select the Laser tab, and select the power and/or delay checkboxes for each laser as needed.

5 Select the Channels tab, and select each channel checkbox as needed.
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Instrument Quality Control and Standardization

Confirming Results  4
6 Select Apply.

7 Select OK.

8 Select the Levey-Jennings plot and select the start and end date from the drop down boxes at 

the top of the LJ Chart screen to specify the desired date range.

NOTE Select the desired configuration and date range from the drop-down menus located at the top of 

the LJ Chart screen to sort by the configuration used during the specified date range.

9 Select Close QC/Standardization in the File menu to exit the QC screen.

QC Result Manager

The QC Result Management window can be used to search, delete, print, and export QC results.
B49006AM   4-25



Instrument Quality Control and Standardization

Standardization  
To access the QC Result Manager, right-click the desired QC result and select Result Manager in the 
QC screen. The QC Result Manager window appears.

Standardization

Use Beckman Coulter CytoFLEX Daily QC fluorospheres or any other reference material that is 
relevant for your application. Ensure that either the Beckman Coulter CytoFLEX Daily QC 
fluorospheres or other reference material has optimized settings appropriate for your experiment. 
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Standardization  4
Adding, Editing, Importing, and Deleting Standardization Laser Target Values in 

the QC Experiment

Select Standardization Target Library... from the Settings menu. The standardization Target Library 
window appears.

NOTE The Item name displays in the Acquisition Setting Catalog window as the saved acquisition setting 

name.
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Standardization  
Adding a New Standardization Item

1 Select . The Add Standardization Target Value window appears.

NOTE Select  to create a duplicate copy of an existing standardization item.

NOTE Unchecking the Use the same threshold setting for acquisition setting checkbox allows you to 

specify custom threshold settings and when to save the test item into the Acquisition Setting 

Catalog.

2 Enter the Item, Lot No., and Expire date from the drop downs located at the top of the Add 

Standardization Target Value window.

NOTE A single Lot No. can include several Items, but you cannot add duplicate Items under the same 

Lot No.

NOTE If the Lot No. selected already exists, the Expire date cannot be edited.
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Instrument Quality Control and Standardization

Standardization  4
3 Choose either Manual or Automatic threshold from the Standardization Test Setting or 

Acquisition Setting section of the screen.

NOTE If you select Manual threshold, enter a value greater than 0, but less than 8,388,600.

4 Set the channels, median, and median tolerance values.

NOTE The contents of channel, laser and filter column come from current detector configuration setting.

NOTE Do not set the median tolerance range any lower than 5%.

NOTE FSC is a required channel.

5 Select OK to save the target value.

The saved results display in the Standardization Target Library window.

6 Select  to exit the Standardization Target Library window.

Editing Standardization Item Parameters

1 Select an item from the Item column on the Standardization Target Library window and select 

.
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Standardization  
2 Edit the parameters for that item and select OK.

NOTE Task Item, Lot No., and Expire date cannot be edited.

3 Ensure the item parameters are correct then select  and save the file.

4 Select  to exit the Standardization Target Library window.

Importing a Standardization Item

1 Select  on the Standardization Target Library window.

2 Browse for the Item to import and select .

The imported item displays at the top of the list in the Standardization Target Library window.

3 Select  to exit the Standardization Target Library window.

Deleting Standardization Items

Select an item from the Item column on the Standardization Target Library window and select 

. Select  to exit the Standardization Target Library window.

Applying the Standardization in QC

1 Open the CytExpert QC screen.
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Standardization  4
2 Select the Standardization radio button.

3 Select the Lot No. and the Items to be applied.
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Instrument Quality Control and Standardization

Standardization  
4 Select .

The Process section of the screen displays the process details.

Once the process is complete, the Standardization Report displays.
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Instrument Quality Control and Standardization

Standardization  4
5 Verify the gain settings.

a. Select Acq. Setting Catalog from the Cytometer menu. The Acq. Setting Catalog window 
appears.

NOTE  designates test items from Standardization.

b. Select the desired Test Item, from the list in the Gain, Threshold, and Width tabs.
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Standardization  
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CHAPTER 5

Data Acquisition and Sample Analysis

Overview

This chapter contains information on how to use your CytoFLEX and CytoFLEX LX flow cytometer, 
including data acquisition, analyzing and exporting results, and compensation procedures that will 
be executed manually during the process.

Workflow:

This chapter contains information on:

 • Creating an Experiment 

 • Creating an Experiment [With Plate Loader]

 • Load Sample and Record Data

 • Configuring Acquisition Settings

 • Analyzing and Exporting Data

 • Saving the Experiment

Creating an Experiment

CAUTION

Risk of file corruption. When modifying experiment (*.xit) file names in Windows 

Explorer, ensure you modify the corresponding experiment folder name to match 

the new file name.

1 Open the CytExpert software and confirm that the instrument is connected. Refer to Logging 

Into the Software in CHAPTER 3, Daily Startup. 

2 Verify the detector configuration. Refer to Verifying, Selecting, Editing, and Creating Detector 

Configuration.

Create 

experiment
Ô

Load 

sample 
Ô

Adjust instrument 

settings and 

gates

Ô
Record 

Data
Ô

Analyze and 

export data
Ô

Save 

experiment
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Data Acquisition and Sample Analysis

Creating an Experiment  
3 Verify the laser settings. Refer to Laser Settings in CHAPTER 5, Data Acquisition and Sample 

Analysis. 

4 Create or open an experiment using one of the following methods:

 • Create a new experiment:
— Select New Experiment on the Start page, specify the file path, and save the experiment.

Or
— Select New Experiment in the File menu, specify the file path, and save the experiment.

 • Create a new experiment from a template:
— Select New Experiment from Template on the Start page. Select Browse next to New 

Experiment and specify the file path for the new experiment, then select Browse next 
to Template and specify the file path to the existing template.
Or

— Select New Experiment from Template in the File menu, specify the file path and save 
the experiment.
Or

— Select the Template tab on the Start page and select the template from the list of 
recently used templates. Specify the file path and save the experiment.

 • Open an existing experiment:
— If you are using either the CytExpert Default Software Option or the CytExpert User 

Management Software Option: Select Open Experiment on the Start page, specify the 
file path and save the experiment.
If you are using the CytExpert Electronic Record Management Software Option: Select 
Open Experiment on the Start page, specify the experiment file and open the 
experiment.
Or

— If you are using either the CytExpert Default Software Option or the CytExpert User 
Management Software Option: Select Open Experiment in the File menu, specify the 
path and save the experiment.
If you are using the CytExpert Electronic Record Management Software Option: Select 
Open Experiment in the File menu, specify the experiment file and open the 
experiment.
Or

— If you are using either the CytExpert Default Software Option or the CytExpert User 
Management Software Option: Select the Experiment tab on the Start page and select 
the experiment from the list of recently opened experiments. Specify the file path and 
save the experiment.
If you are using the CytExpert Electronic Record Management Software Option: Select 
the Experiment tab on the Start page and select the experiment from the list of 
recently opened experiments. Specify the experiment file and open the experiment.

NOTE Experiments are saved as an .xit file. Template are saved as an .xitm file. 
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Creating an Experiment [With Plate Loader]  5
NOTE If you are using either the CytExpert Default Software Option or the CytExpert User 

Management Software Option: If you need to change the default save path, select Options in the 

Settings menu and modify the Default Path displayed to the right of the Experiment tab. Then select 

OK.

If you are using the CytExpert Electronic Record Management Software Option: Select File > 

Experiment Explorer to modify any Experiment Directory sub folders for the Experiment. Refer to 

Experiment Directory Management in APPENDIX B, CytExpert Electronic Record Management.

NOTE If desired, import saved settings/standardization settings from the catalog.

Creating an Experiment [With Plate Loader]

CAUTION

Risk of file corruption. When modifying file names in Windows Explorer, ensure 

you modify the corresponding folder name to match the new file name.

1 Create an experiment. Refer to Creating an Experiment in CHAPTER 5, Data Acquisition and 

Sample Analysis 
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Creating an Experiment [With Plate Loader]  
2 Select . The Plate window appears.

[CytoFLEX LX Shown]
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Creating an Experiment [With Plate Loader]  5
3 Select the Add Plate dropdown and select Add Plate.

[CytoFLEX LX Shown]
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Data Acquisition and Sample Analysis

Creating an Experiment [With Plate Loader]  
The Add Plate window appears.

NOTE Select Add Plate from Template to add a plate template with preset plate settings.

NOTE Select Duplicate Current Plate without Data to create a copy of the selected plate without data.

NOTE Select Add Plate from Layout to create a plate from a preset .csv file. The CSV file can be 

generated by selecting , or self-defined by other tools like Excel or Notepad. 

When you create a CSV file, make sure to follow the example:

1. In the first row, enter the following column titles WellLabel, TubeName, SampleID, Group in 

sequence as shown in Figure 5.1. The table header cannot be customized. 

2. In the WellLabel column, a maximum of 96 wells can be defined, beginning with A1-A12, B1-B12, 

and so on.

Figure 5.1  CSV template

4 Select the Plate type from the dropdown.
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Creating an Experiment [With Plate Loader]  5
5 Select the direction of the workflow from the sampling sequence from the plate section of the 

window. The Plate window appears.

[CytoFLEX LX Shown]

6 If you need to automatically turn off the cytometer after auto acquisition is complete [CytoFLEX 

LX Only]:

a. Ensure you set the last sample wells with the appropriate number of cleaning agent wells 
and deionized water wells.
B49006AM   5-7



Data Acquisition and Sample Analysis

Creating an Experiment [With Plate Loader]  
b. Select .

NOTE A gray background ( ) indicates autoshutdown is disabled. A yellow background ( ) 

indicates autoshutdown is enabled.

NOTE Select Save Plate Template to save the acquisition settings as a template in SCTM format. 

Select Save Plate Layout to save the name, sample ID, or metadata as a layout in CSV format.

7 Select OK.
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Setting Sample Wells

Once the plate protocol is created, the plate window appears. Refer to Figure 5.2.

Figure 5.2  Plate Window [CytoFLEX LX Shown]

Empty well

The well with color is set as sample well, but is not set for Auto Record

The well is set as sample well, and is ready for Auto Record. The number labeled at the right 

bottom shows the order of auto record.

Cleaning Agent well

Deionized water well

A blue check mark means the data is acquired, not recorded.

A green check mark means the data is recorded.

A red cross mark means the data is recorded by Auto Record mode. But the acquisition is 

terminated abnormally. For example, the well is skipped or the acquisition is manually stopped.
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Creating an Experiment [With Plate Loader]  
1 Left-click and drag your mouse to highlight the desired wells or hold the Control key and select 

each desired well.

2 Select  or right-click the selected wells and select Set As Sample Wells. The Set As Sample 

Wells window appears.

NOTE Select  or right-click and select Set as Empty Wells to reset selected wells as empty.

3 Enter the name in the Prefix box in the Naming Rules section of the window.

4 Select the desired Mix and Backflush duration from the Mix/Backflush section of the window. 

5 Enter the Group Name in the Name box in the Group section of the window.

6 Select the sample well color using the color dropdown under the Group section of the window.
B49006AM   5-10



Data Acquisition and Sample Analysis

Creating an Experiment [With Plate Loader]  5
7 Select the desired acquisition settings under the Acq. Setting tab.

NOTE Select Import from File to import the settings from a FCS file.

NOTE If desired, import saved settings/standardization settings from the catalog.
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Creating an Experiment [With Plate Loader]  
8 Select the channels and create label names under the Channel tab. 

9 Set compensation under the Compensation Matrix tab. Refer to CHAPTER 6, Compensation for 

detailed instructions on setting compensation. 
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Creating an Experiment [With Plate Loader]  5
10 Select Events to record, time to record, or volume to record under the Stopping Rules tab. 

NOTE Beckman Coulter recommends setting an acquisition time limit to stop the acquisition if the event 

limit cannot be reached.

11 Create the desired name and value under the Custom Metadata tab. 

12 Select OK.
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Creating an Experiment [With Plate Loader]  
Modifying Well Settings

If any well settings require modification, right-click the sample well and select the setting to 
change.

[CytoFLEX LX Shown]
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Applying Existing Well Settings to Additional Wells

1 Right-click the well with the desired settings and select Apply Well Settings to. The Apply Well 

Settings of window appears.

NOTE The Convert Compensation Matrix by the Gain of Tube checkbox is only available when Acq. 

Setting is deselected. Selecting the Convert Compensation Matrix by the Gain of Tube checkbox 

converts the compensation matrix automatically by the gain of the well selected.

2 Select the wells to apply the well settings to.

NOTE Select the Customize option to select individual wells to apply the settings to. Select the All 

Empty Wells option to apply the settings to all remaining empty wells. Select the All Sample Wells 

option to apply the settings to all existing colored sample wells. You cannot apply settings to wells 

that already contain data.

3 Checkmark which settings to apply from the Select Items to Apply section of the window.

NOTE

 • If Group and Name Rule are selected, the settings can be applied to any wells, and empty wells 

will be set as sample wells after applied.

 • If Group and Name Rule are not selected, the settings can only be applied to sample wells.

Copying, Cutting, and Pasting Wells

1 Left-click and drag your mouse to highlight the desired wells or hold the Control key and select 

each desired well.
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2 Right-click and select Copy or Cut.

NOTE When Copy or Cut is selected, the well displays as follows: 

3 Right-click an empty well and select Paste.

NOTE The same number of wells will paste in the same orientation the wells were selected.

Moving the Location of a Well

1 Right-click the desired well to move and select Move location.

NOTE When Move location is selected, the well displays as follows: 

2 Select the new well location. The well will automatically move to the new selected location.

Running Samples

IMPORTANT Ensure the sample plate is loaded properly before acquiring the samples.

1 To run a single well:

a. Select the well in the Plate window.

b. Select Run to prompt the system to begin sample aspiration.

NOTE Acquisition settings can be adjusted during acquisition. 

c. Select Record to save the data.

d. Select Eject to prompt the plate loader to eject.

To run a set of wells:

a. Select the desired wells.
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Creating an Experiment [With Plate Loader]  5
b. Select  or right-click and select Auto Record to set the selected wells for auto record. 
Number labels appear in the bottom right corner of each well set for auto record. Sample 
acquisition occurs in the order indicated by the numbers.

[CytoFLEX LX Shown]

NOTE Select  to remove the auto record setting from the selected wells.

2 Select  to begin sample acquisition.

NOTE Select  to skip the current well and move to the next well for acquisition.

NOTE Select  to pause acquisition. The software completes the current sample well 

acquisition and pauses when the current well is complete. The plate can be loaded and unloaded 

while the sample acquisition is paused.

NOTE Select  to continue the acquisition.
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Creating a Heat Map

1 Select  from the Tube management controls (refer to Test Tubes in CHAPTER 2, Using the 

CytExpert Software). The Heat Map window appears.
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2 Select  from the Heat Map window. The New Heat Map window appears.

NOTE You must have at least one plate that contains data in at least two wells to create a new heat map.

NOTE Select Display Value to display the value within the heat map well on the Heat Map window. 

Display Value is only selectable when using a single parameter.

3 Enter the heat map name, select the Display Name checkbox if you want the name to display in 

the heat map view, and select the heat map data set from the Plate drop down menu.

NOTE The plate drop down menu only displays plates that contain data.
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4 Select the desired color mode.

NOTE Select Same setting for all parameters to use the same color for all parameters.

Select Different settings per parameter to use different colors for different parameters.

5 Select  to add a parameter item to the Parameter section of the New Heat Map 

window.

NOTE A maximum of 6 parameters can be added to a single heat map.

NOTE Select a parameter then select  to delete a parameter. Select Yes when the 

following message appears.
B49006AM   5-20



Data Acquisition and Sample Analysis

Creating an Experiment [With Plate Loader]  5
6 Change the Parameter elements in the Parameter section of the New Heat Map window.

a. Change the Label name if needed. 

b. Select  from the Statistic Expression section of the Parameter list. The Expression 
window appears.

c. Enter the desired expression for the selected parameter then select OK. The Actual Range 
displays in the Parameter section of the Heat Map window.

d. Select the Use Custom Ranges checkbox if needed and enter the Min and Max ranges.

NOTE The Actual Range displays when the statistics parameter can be calculated.
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7 Select any wells that should be excluded from the heat map in the Wells section of the New Heat 

Map window then select .

NOTE  designates that a well is included. All wells are included by default.

NOTE  designates that a well is excluded. Select any wells that should be included and select 

.
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8 Edit the color elements in the Color section of the New Heat Map window. 

a. Select a color from the base color drop down menu.

b. Select the number of color bands desired from the Bands drop down menu. The window 
refreshes to display the appropriate number of bands.

NOTE You can choose between 2 and 10 color bands.

c. Select Percentile to assign colors based on a percentage range.

NOTE If Use Custom Range is selected, the percentile is calculated according to “Min” and “Max”. 

If Use Custom Range is not selected, the percentile is calculated according to “Actual Range”.
B49006AM   5-23



Data Acquisition and Sample Analysis

Creating an Experiment [With Plate Loader]  
Or 

Select Fixed Range to assign colors based on a fixed range specified by the user. The heat 
map is created directly based on the result of the expression. The color of the heat map 
displays according to the legend range.

NOTE Fixed Range can only be used with one parameter.

NOTE If Different settings per parameter is selected, repeat Steps a-c to assign the color setting 

to each parameter. 

9 Select OK. The New Heat Map window closes to display the Heat Map window.

Heat Map with 6 Parameters [Same setting for all parameters]

Heat Map with 6 Parameters [Different settings per parameter]

NOTE When viewing more than one parameter, the parameter location relative to the pie chart is visible 

in the top, right corner of the Heat Map screen.
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Heat Map with 1 Parameter 

Refreshing a Heat Map

When data displayed in a heat map is no longer current, the  symbol appears next to the heat 
map name and the message Analysis changed. Please refresh. appears on the Heat Map window.

Select  from the heat map toolbar to refresh the analysis.
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Modifying Existing Heat Map Settings

Select  from the heat map toolbar to modify existing heat map settings. The Modify Heat Map 
Settings window appears.
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Deleting an Existing Heat Map

To delete a single heat map, select the heat map to be deleted from the list of heat maps in the Heat 

Map window then select  from the heat map tool-bar.

To delete multiple heat maps, select  from the heat map toolbar. The Delete Multiple Heat 
Maps window appears.

Select the heat maps to be deleted then select OK.

NOTE The Select All checkbox allows you to delete all of the heat maps listed.

Exporting a Heat Map

Heat maps can be exported as a graphics file (.bmp or .emf) or to a clipboard (.bmp).

To export a heat map as a graphics file, select  from the heat map toolbar.

To export a heat map to a clipboard, select  from the heat map toolbar.
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Before Running Samples

CAUTION

Risk of erroneous results if the Cytometer has been idle for an extended period of 

time. Perform a prime if the system has been idle for an extended period of time 

(see Priming the Flow Cell in CHAPTER 11, Replacement/Adjustment Procedures.)

1 Run the Daily Startup procedure.

2 Run the Instrument Quality Control and Standardization procedure.

3 Create an experiment. Refer to Creating an Experiment.

4 Verify mixer settings. Refer to Changing Sample Mixing and Backflush Settings in CHAPTER 11, 

Replacement/Adjustment Procedures.

5 Ensure that there is sufficient space on your hard drive for sample processing and data 

acquisition.

6 Verify the detector configuration. Refer to Verifying, Selecting, Editing, and Creating Detector 

Configuration.

7 Verify the laser settings. Refer to Laser Settings in CHAPTER 5, Data Acquisition and Sample 

Analysis.
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Verifying, Selecting, Editing, and Creating Detector Configuration

CAUTION

Risk of erroneous results. The system will read the selected Detector 

Configuration even if the optical filters do not match the selected Detector 

Configuration. You must verify the installed optical filters match the selected 

Detector Configuration.

1 Select Detector Configuration in the Cytometer menu to verify the correct detector 

configuration is selected. To change the configuration:

a. Select the desired configuration.

b. Select Set as Current.

A green checkmark appears in front of the selected configuration.

[CytoFLEX Shown]

NOTE A configuration is locked when  appears to the left of a configuration. A configuration locks for 

two reasons:

 • QC was run using the configuration.

 • The compensation library contains data for the configuration.

Locked configurations can be deleted, but not edited. 

2 Select OK to close the Detector Configuration screen.

3 Proceed to Step 4 if you need to edit the Detector Configuration settings, or skip to Step 5 if you 

need to create a new Detector Configuration, or skip to Step 12 if you need to delete a Detector 
configuration.
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4 If a saved configuration requires changes, edit that configuration.

NOTE The factory configuration is in bold and cannot be edited.

a. Select the configuration, then select Edit to access the Edit Detector Configuration screen.

b. Channels with a white background can be edited. Drag the names of the appropriate 
fluorescence channels and optical filters on the left to the correct channels.

c. Continue to Step 6.

5 If an appropriate configuration is not saved, create a new configuration.

a. Select Detector Configuration... in the Cytometer menu. 

b. Select New... and name your configuration.

You can also select a previously saved configuration and select Save As to create a copy. 

c. Select OK.
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d. Ensure the new configuration is highlighted, then select Edit. The Edit Detector 
Configuration window appears. 

e. Customize the new configuration. Channels with a white background can be edited. Drag 
the names of the appropriate fluorescence channels and optical filters on the left to the 
correct channels.

f. Continue to Step 6.

6 If a required channel name or filter is not listed on the left, select Fluorescence or Filter to add 

or modify the channel name or the filter.
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7 When finished, select OK.

8 Select the appropriate configuration.

9 Verify that the correct optical filters are installed in the Cytometer and match the newly 

created configuration.

10 Select Set As Current.

11 Select OK.

12 To delete a configuration created in error, select Delete. The following confirmation message 

appears. Select OK.
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Setting Up Violet Side Scatter (VSSC) Channel

For microparticles, a VSSC option can be added to better separate side scatter signals from noise. 
Beckman Coulter recommends using this channel to detect particles smaller than 500 nm.

NOTE Since the total available channel numbers remain the same when the VSSC channel is used, the 

number of fluorescent channels in the violet WDM is reduced by 1 channel.

CAUTION

Risk of erroneous results. Beckman Coulter recommends using the VSSC channel 

to detect side scatter signals for particles smaller than 0.5 μm. VSSC could be too 

sensitive when large particles are being acquired. Switch back to the original 

detector configuration for particles larger than 5 μm. For particles larger than 

5 μm, set the gain of the VSSC to 1 to increase the threshold and decrease the 

collection of sample noise.

1 Open the Violet WDM lid (see Replacing the Optical Filter in CHAPTER 11, Replacement/

Adjustment Procedures) and remove the 405-nm filter, the 450-nm filter, and a third filter not 
required for the test, for example, the 780-nm filter. 

NOTE Refer to Table 5.1 to identify the WDM filter mount color codes.

NOTE The orientation for position 1 through 6 starts with position 1 located closest to the fiber coming 

into the WDM, and position 6 located on the side furthest from the fiber coming into the WDM.

1. Position 1

2. Position 2

3. Position 3

4. Position 4

5. Position 5

6. Position 6

b

c

d

e

f

g
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2 Place the third filter in position 1, the 405-nm filter in position 2, and the 450-nm filter in 

position 3. 

NOTE For the Violet WDM, Beckman Coulter recommends placing the filters in sequential order from the 

shortest wavelength to the longest wavelength in positions 2 to 6. Position 1 will always contain the 

unused filter.

3 Start the CytExpert software. Refer to Logging Into the Software in CHAPTER 3, Daily Startup.

4 Select Detector Configuration from the Cytometer menu. The Detector Configuration window 

appears.

1. Position 1

2. Position 2

3. Position 3

4. Position 4

5. Position 5

6. Position 6

b

c

d

e

f

g
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5 Select the Default Configuration and select Save As. The Configuration Save As window appears.

6 Name the new configuration VSSC and select OK.

7 Select the VSSC configuration and select Edit. The Edit Detector Configuration window appears.

8 Change the filters and channel names according to the filter order in the violet WDM.
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9 Right-click the VSSC channel, and select Set SSC to set it as the Violet SSC channel.

10 Select OK to save the changes and close the Edit Detector Configuration window.

11 Select Set as Current.

12 Select OK to save the changes and close the Detector Configuration window.

13 Create a new experiment using the VSSC configuration. Refer to Creating an Experiment.

Sampling and Collecting Data

NOTE Settings can be imported from the Acquisition Settings Catalog. Refer to Importing and Exporting 

Instrument Settings.

If compensation settings are desired, import the compensation from the Compensation Library or import 

the compensation file. Refer to Importing and Exporting Compensation in CHAPTER 6, Compensation.

1 Select  from the Test Tube screen to create the new sample tube.

NOTE The first sample tube is already created by default.
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2 Change the tube name if necessary. Refer to Changing the Tube Name.

3 Mix the sample tube intended for testing.

4 Ensure that the sample tube holder is in the sample loading position (see Figure 1.12). If the 

sample tube holder is not in the sample loading position, select Initialize.

WARNING

Risk of biohazardous contamination. When using 1.5-mL and/or 2-mL sample 

tubes, always cut the cap off and do not exceed 300-μL sample volume. Running 

samples with a cap attached to the sample tube or with volumes exceeding 300-μL 

can result in sample splashing.

5 Place the sample tube in the sample tube holder. 

6 Select the desired acquisition parameters (Events/Time to Record/Volume to Record and 

Sample Flow Rate) on the left side of the screen. 

NOTE You can also push the load button on the front of the instrument to automatically start the run 

and record the data.
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7 Select Run to load the sample.

NOTE When you select a tube that only contains acquired data, as indicated by the blue tube  in the 

test tube section of the screen, the following message appears:

 • Create new tube. Saves the current tube and creates an additional tube.

 • Overwrite the data. Overwrites the current tube data with new data.

8 View the plots and establish the gates. Refer to Creating Plots and Gates. Adjust the gate and 

instrument settings as necessary. Refer to Configuring Acquisition Settings.

9 Adjust the gain settings. Refer to Adjusting the Gain.

10 Adjust the threshold settings. Refer to Adjusting the Threshold.

11 Adjust the Acquisition conditions. Refer to Setting Collection Conditions.

12 Select Record to save the data.

Wait for the saving process to finish. The sample tube holder returns to the sample loading 
position (see Figure 1.12).

NOTE When you select a tube that contains recorded data, as indicated by the green tube  in the 

test tube section of the screen, the following message appears:

 • Create new tube. Creates a new tube in the test tube section of the screen for the data.
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 • Append data to existing file. Adds new data to the existing data.

NOTE When you select a tube that only contains acquired data, as indicated by the blue tube  in the 

test tube section of the screen, the following message appears:

 • Create new tube. Creates a new tube in the test tube section of the screen for the data.

 • Overwrite existing data. Overwrites the current tube data with new data.

 • Append data to existing file. Adds new data to the existing data.

13 Repeat steps 1-12 until all sample tube data required for testing has been collected.

NOTE If the rate suddenly appears to drop, check to see if the sample has run dry or the sample probe 

is clogged. Any time the sample probe becomes clogged, immediately select Stop to unload the 

sample. Then select Backflush to clean the sample probe. Refer to Daily Clean in CHAPTER 10, 

Cleaning Procedures to flush out the sample probe. If you are still unable to clear the sample probe, 

contact us.
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Changing the Tube Name

To change the name of a new sample tube or the sample ID, right-click the tube name or the sample 
ID name in the Tube section of the screen and select Edit Name or simply double-click the sample 
tube or sample ID name.

Setting the Channel and Label

1 Select Set Channel in the Settings menu. The Set Channel window appears.
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2 In the Set Channel window, modify which channels are used and how they are displayed.

a. Select the channel signal check box, then you can add the reagent name in the Label 
column. The information you add appears in the corresponding axis of the relevant plot in 
the plot area. Unselected channel signals are not stored in the data file.

NOTE You can select which signal type to use Height or Area.

b. Select Apply to. The Apply Channel Setting window appears.

c. Select the tubes to apply the channel settings to and select OK.
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d. If you only need to modify the label name, select Set Label in the Settings menu to make the 
required changes. The Set Label screen appears. The Set Label screen does not allow you to 
select which channels to use, but it does allow you to apply the modified label to all the 
sample tubes.

e. Select Apply to. The Apply Label Setting window appears.

f. Select the tubes to apply the label settings to and select OK.
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Creating Plots and Gates

IMPORTANT The maximum number of elements allowed in an experiment is 200. Elements include plots, 

statistics tables, and gate hierarchy tables.

IMPORTANT The maximum number of gates allowed in an experiment is 200.

1 Use the plotting controls (see Figure 2.1) in the plot area to create plots and gates and to 

generate graphs as shown.

Use the  icons to generate histograms, dot plots, density plots, pseudo color plots, and 
contour plot.

The experiment uses scatter plots, histograms, polygon gating, four-quadrant gating, and 
line-segment gating.

a. After selecting a plot, click and drag the mouse to adjust the position and select and drag 
the sizing handles at the edge of the graph to adjust the size of the graph.
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b. Select an axis name to change which channel is displayed. An “A” after the channel name 
indicates signal pulse area, while an “H” indicates height. The default setting is "A". 

NOTE To modify the default settings, select Options in the Settings menu. The Options window 

appears. Select Plot on the left side of the Options window. Under the Signal section of the 

window, change the Main Channel default by selecting the Height or Area.

NOTE When using both Height and Area signals, ensure the gain setting is set to where the Height 

signal does not reach its upper range.
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c. Signal width can be used as a tool for doublet discrimination and to differentiate somatic 

cell adhesion. If necessary, select  to open the Acq. Setting window. 
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d. Select the Width tab, and select a channel with the required signal width.

e. Plot properties can be configured to display axes in Log, Log-Linear, or Linear format.

1) Double-click the plot or right-click the plot and select Property from the drop-down 
menu. The Plot Property screen appears.
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2) Select whether to display the axes in logarithmic or linear format for both the X-axis 
and Y-axis. Enter a value for log-linear coefficient if the log-linear view is desired. 

3) Select Close.

Or

Select the logarithmic axis on the plot. The slider appears. Drag the slider along the 
axis to change the log-linear coefficient and view events that are not shown, including 
events with negative values.

NOTE The log-linear slider is also available during data acquisition.

NOTE To reset the axis back to logarithmic, right-click on the axis and select Property. Select 

X axis Default or Y axis Default to reset the axis.

f. You can adjust axis ranges using the pan axis display controls located at the top of the 
screen.

 • Select , to zoom-in and define which area of a plot to enlarge. The selected area 
can be magnified to fill the entire graph. By selecting the zoom-out function, you can 
click on the graph and restore the plot to its original appearance before magnification.

Histogram with logarithmic X-axis Histogram with log-linear X-axis

Dot plot with logarithmic X-axis Dot plot with log-linear X-axis 
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 • Select  to shift the axes. The mouse pointer appears as a hand. It allows you to 
drag the graph to reveal the axis segment you need. 

—  Pan: Modifies the axis display range dimensions when panning both axes. 
When the pan control is selected, you can right-click the graph and select which 
axis you need to adjust when dragging. You can also pan directly to the default axis 
range.

—  Single side pan: Modifies the axis display range dimensions when panning one 
axis.

NOTE Only the low end of the axis can be adjusted by the single side pan tool.

 • Double-click the border area of the plot to open the Plot Property window, or 
right-click the plot, then select Property to open the same Plot Property window.

 • In the Plot Property window, manually enter the minimum and maximum display 
values for the X- and Y-axes. You can also select Fit With Sample to let the software 
automatically adjust the lower limit according to the signal and perform the 
corresponding log-linear transformation. The X- and Y-axes Default settings are the 
default parameters. The default parameters are 100-1,000,000. 

NOTE Select Fit With Sample to identify the signal’s lower limit, adjusting automatically as 

warranted. Selecting this item is recommended whenever the signal appears to be 

relatively low.

NOTE Select Auto to automatically set the upper and lower display limits of the axes based on 

the data already collected.

NOTE Select Options in the Settings menu, then select Plot to modify the default setting of 

the axis range under the Axis Default Setting section of the window.
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2 To create gates, use the  control buttons or right-click the plot 

and select the gate type required. Gates can be set according to different requirements to 
differentiate cell populations.

NOTE To add a vertex to a polygon gate:

1. Select the gate.

2. Hover your cursor over the perimeter of the gate until the cursor changes to the hand icon.

3. Select the desired location for the new gate vertex.

NOTE A newly created gate becomes a subset of the plot where it appears. The relationship between 

parent and progeny/daughter gates can be changed when a displayed gate is subsequently 

modified.

The position of the same gate in different sample tubes may vary. To change the position of a gate 

and apply the change to all sample tubes accordingly, you can right-click the gate and select Apply 

to All Tubes.

You can also apply the change to select tubes by selecting Apply to Tubes.
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3 Select the gates to display.

a. Select the heading area of the plot, select the parent population/gate to display in the plot 
from the drop-down menu. The selected parent gate appears in the tab area of the plot.

NOTE The CytExpert software will not list gates which would create circular gating logic.

Figure 5.3 shows all gates defined in the example experiment below. Note that the only gate 

option in plot 1 of Figure 5.4 is P2 for the following reasons:

 • Plot 1 cannot be gated on P1 because P1 is on that plot.

 • Plot 1 cannot be gated on P2 because P2 is gated on P1. 

 • Plot 1 cannot be gated on the P2 OR P1 combo population because the gate logic contains 

P1.

Figure 5.3  All Gates - Example Experiment

Figure 5.4  Circular Gating Logic - Example Experiment
B49006AM   5-50



Data Acquisition and Sample Analysis

Configuring Acquisition Settings  5
b. If necessary, you can select the Combo Population option from the drop-down menu to 
create a combination gate, using the Boolean relationships “and”, “or”, and “not” to 
produce a new gate. You can also select the population color or change the gate name.

 • “And” indicates that all selections must be satisfied. For example, “P1 and P2” means 
that the data for the newly added gate represent the intersection of P1 and P2.

 • “Or” indicates that only one of the selections need be satisfied. For example, “P1 or P2” 
means that the data for the newly added gate represent the union of P1 and P2.

 •  “Not” indicates exclusion from the selection. For example, “Not P1” means that the 
data for the newly added gate represent the events that are not part of P1.

4 Select to display the population hierarchy.
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The Population Hierarchy function allows you to view how gates rank in relation to one 
another. To change the display color, double-click the default color and select the desired color 
from the drop-down color palette. To change the name of each gate, double-click the name of 
the desired gate. By hovering your mouse pointer over a combo population whose display name 
has just been changed, you can view its corresponding Boolean logical operation.

Creating and Adjusting Auto Gates

There are two types of autogates available in the CytExpert software: auto line segment and auto 
polygon. 

To create an auto line segment gate, select  from the toolbar or right-click on the histogram 
and select Auto Line Segment from the drop down menu. 
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Select the population you want to gate in the histogram to automatically gate that population.

To create an auto polygon gate, select  from the toolbar or right-click on the 2D plot and select 
Auto Polygon from the drop down menu.
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Select the population you want to gate in the 2-D plot. The gate will automatically be drawn to fit 
the population.

NOTE To add a vertex to an auto polygon gate:

1. Select the gate.

2. Hover your cursor over the perimeter of the gate until the cursor changes to the hand icon.

3. Select the desired location for the new gate vertex.

Turning Auto Recalculate On/Off

When auto recalculate is turned on, all autogates will recalculate when:

 • The current tube is changed

 • Compensation is changed

 • Gating is changed

 • Collection stops

 • An FCS file is imported to the tube or well

Auto recalculate turns off after a gate is moved or the size of a gate is altered You must select Auto 

Recalculate from the auto gate menu again to turn auto recalculate back on.

NOTE Auto recalculate turns on after adjusting movement or extent.

Right-click an autogate and select Auto Recalculate from the auto gate menu to toggle auto 
recalculate on and off.
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Adjusting Autogate Movement and Extent

Movement — The distance an autogate can move to find the target population.

To adjust movement, right-click an autogate and drag the Movement handle in the auto gate menu 
left and right.

NOTE The default value setting for movement is 20 units. The minimum value setting for movement is 0 

units and the maximum value setting for movement is 100 units.

If a target population is consistently in the same location, movement is not needed. However, if a 
target population is periodically missing from some samples, or events are rare, movement can be 
used to move the gate within a certain percentage of its axis to capture the correct population. 
Refer to Figure 5.5 for an example of the default movement setting. Refer to Figure 5.6 for an 
example of the maximum movement setting.

Figure 5.5  Movement - Default Setting
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Figure 5.6  Movement - Max Setting

Extent — Shrinks or expands the gate around the population.

To adjust extent, right-click an autogate and drag the Extent handle in the auto gate menu left and 
right.

NOTE The default value setting for extent is 20 units. The minimum value setting for extent is 0 units and 

the maximum value setting for extent is 100 units.

Refer to Figure 5.7 for an example of the default extent setting. Refer to Figure 5.8 for an example 
of the maximum extent setting.

Figure 5.7  Extent - Default Setting
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Figure 5.8  Extent - Maximum Setting

Laser Settings

To access the Laser Setting window, select Advanced > Laser Setting. The Laser Setting window 
appears. Refer to Figure 5.9.

NOTE The instrument must be in Standby mode to access the Laser Setting window.
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Figure 5.9  Laser Setting Window [CytoFLEX LX shown]

1. Enable/Disable: Enables or disables the laser.

2. Target Power (mW): Used to change the laser target power.

NOTE Laser target power can only be adjusted on the CytoFLEX LX system. The power detector has 

±1 mW tolerance. Refer to Table 5.1 for the target power ranges allowed in the Laser Setting 

screen.

NOTE Refer to the target powers listed for each laser in the QC reports area of the QC Report Screen 

(refer to Figure 2.2) for range limits.

3. : Sets the laser target power setting.

IMPORTANT The Actual Power readings are +/- 1 mW.

4. : Reads the current laser power before the flow cell assembly and displays the current 

laser power in the Actual Power (mW) column of the Laser Setting window. Refer to Table 5.1 for a list 

of laser ranges.

Table 5.1  Target Power Ranges in the Laser Setting Screen

Laser Min Power (mW) Max Power (mW)

355 19 21

375 51 69

405 71 119

488 41 59

561 21 39

638 41 59

808 51 69
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Select the Enable or Disable radio button next to each laser on the Laser Setting window to enable 
or disable lasers. The laser status for each laser displays in the software status bar. Hover your 

mouse over  to display details for each laser.

NOTE Lasers can only be enabled and disabled when the system is in standby mode.

Setting Laser Target Power Settings [CytoFLEX LX Only]

IMPORTANT When you change the laser target power, it will impact all of your results including QC and 

standardization.

1 To access the Laser Setting window, select Advanced > Laser Setting. The Laser Setting window 

appears.

2 Ensure that all desired lasers are enabled.

NOTE If a laser is disabled on an experiment that requires that laser, the following message appears:

3 Select Read Power to view the real-time laser power reading.

The laser power displays under the Actual Power (mW) column located in the far right section 
of the Laser Setting window.

4 Adjust the target power for each laser as needed. 

5 Select Set to set the device power.
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6 Standardize your laser target values in the QC Experiment. Refer to Standardization in 

CHAPTER 4, Instrument Quality Control and Standardization.

NOTE Disabled lasers are marked Laser XXX is disabled  in the QC screen and do not provide laser 

power values.

Adjusting the Gain

While the instrument is in use, the signal value can be increased or decreased by adjusting the 
instrument's gain configuration.

1 Select  on the left side of the screen. The Acq. Setting window appears. 

2 Select the Gain tab in the Acq. Setting window. 

Select or edit the instrument’s default gain settings using one of the following methods:

 • Edit the gain settings and select Set as Default to create a new default setting.

 • Select Default to return to your saved default settings.

 • Select Recommended to use the instrument’s QC settings.

NOTE In cases where you do not specify your own default parameters, the recommended settings and 

default settings are identical.
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3 Adjust the gain setting of each channel under the Gain tab in the Acq. Setting window. Raising 

the gain increases the signal. Lowering the gain reduces the signal.

NOTE Optimize the gain settings according to your own experimental goals. The recommended values 

are only for reference.

Another option is to use the Gain Control button  on the tool-bar in the graphic control 
area to adjust the gain values for cell population data to their desired levels, directly on the 
plots where the data appears during data collection.

NOTE Gain adjustments have a predefined range between 1 and 3,000.

4 If necessary, change the coordinate display range and the plot type. 
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Adjusting the Threshold

By adjusting the threshold, the user can remove unnecessary signal noise to ensure that most of the 
data collected consists of desired signal data. After the threshold settings have been configured for 
a given channel, the acquisition of data from this channel will only be triggered by signals that 
exceed the established threshold. Threshold settings have considerable bearing on whether the 
appropriate events can be acquired.

1 Create a plot to view the channels where the threshold will occur. Generally, a bivariate plot 

showing FSC and SSC is used. 

NOTE Threshold can be defined for any of the fluorescence channels.

2 Select  on the left side of the screen.

3 Select the Threshold tab in the Acq. Setting window. 
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4 Set the desired threshold using one of the following methods:

 • Choose the channel that is used for setting the threshold. Manually enter the threshold 
value in the Threshold tab.

NOTE For dual-parameter plots, you can right-click the plot and select both parameters if desired. 

Then, select the desired threshold boundary for the second parameter.

 • Select Automatic in the Primary Threshold Trigger Level section of the Acq. Setting screen 
to seek the target signal based on the background signal. It can quickly help find the target 
population if the signal-to-noise ratio (SNR) of the channel is comparatively good. The 
threshold can be set to either “H” (signal height) or “A” (signal area).

NOTE The automatic threshold value is based on the relative signal difference. When adjusting 

gain, you do not need to update the threshold settings. For channels with a low SNR or an 

excessively impure signal, manually setting the threshold parameters is recommended.

Moreover, “and” as well as “or” can be applied to as many as two channels, so as to allow 
these Boolean logical operators to be used in setting the threshold value.

— “and”: Data is displayed and collected only when two threshold conditions are met 
simultaneously.

— “or”: Data is displayed and collected when at least one of two threshold conditions are 
met.

 • Select  from the plot control area. Move your mouse pointer to the desired threshold 
position in the desired plot and select once.

5 Select Close.

Setting Collection Conditions

1 Check mark the conditions required to set the necessary stop count events on the left side of 

the Acquisition screen. 

Three stop count collection conditions are available for sample recording:

 • Events to Record. Used to set the number of events to record in the specified population.

 • Time to Record. Used to set the collection time duration in seconds.

 • Volume to Record. Used to set the collection volume in μL.
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For example, if the event to record is set to record 1,000 P1 events, the software automatically 
stops recording when P1 events reach 1,000 events. However, the software saves all data 
acquired, including events outside of P1, when 1,000 P1 events is reached. You can also specify 
the time to store if necessary. When multiple acquisition conditions are established, any one of 
these conditions stops the collection process.

2 Select Record and wait for the software to complete collecting the data, at which time the 

sample tube holder returns to the sample loading position (see Figure 1.12).

3 If you made changes to the data acquisition conditions and need to apply these changes to an 

established sample tube, right-click the sample tube and select Apply Acq. Settings To, to apply 
the conditions accordingly.
B49006AM   5-64



Data Acquisition and Sample Analysis

Configuring Acquisition Settings  5
Setting Plot Display Conditions

Select Events Display Setting in the Settings menu. The Events Display Setting window appears.

Three display options are available:

 • Display all events. Used to view all events on the plot.

 • Display first XXXX events. Used to set the set number of events to display.

NOTE The selected number of events displays in the bottom, left corner of the plot. For example if you 

choose to show 5000 events, the bottom, left corner of the plot displays 5000 Show.

 • Display XX percent of events acquired. Used to set the percentage of events to display.

NOTE The selected percentage of events displays in the bottom, left corner of the plot. For example if 

you choose to show 20 percent of events acquired, the bottom, left corner of the plot displays 20% 

Show.
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Setting Customized Parameters

Set custom parameter to create fluorescence calculations.

1 Select Set Customized Parameter from the Settings menu. Or, right-click a test tube from the 

test tube menu and select Set Customized Parameter. The Set Customized Parameter window 
appears.

2 Enter a name for the parameter in the Name section.

3 Select the parameters for calculation in the Parameter dropdowns.

4 Select the equation operations from the Open dropdown menu.

The new parameter name is displayed in the list of parameters and statistic items.
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Setting Custom Statistics

Set custom statistics to create calculations based on populations of interest.

1 Right-click the statistics table and select Statistics Setting. The Statistics Setting window 

appears.

2 Select Expression.
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3 Select Edit. The Expression window appears. 

4 Enter the expression name in the Name section and enter the expression using the equation 

buttons.
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5 Select OK.

NOTE The equation populates in the Statistics Setting window under the Expression selection. 
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Analyzing and Exporting Data

1 Select the sample tube to be analyzed.

2 Establish new gates or adjust the position of existing gates. Refer to Creating Plots and Gates.

NOTE Changing a gate’s position does not affect the positions of other gates already established on a 

given sample tube. Each test tube individually records the positions of its associated gates. If you 

need to make a change that concerns all the tubes, you must select the gate, then right-click the 

correctly positioned gate and select Apply to All Tubes.

3 Select . The Gate Hierarchy screen appears.

4 Check the relationship between the parent and daughter gates in the Gate Hierarchy window. 

NOTE Newly added gates become subsets of populations displayed in plots with existing gates. Name 

and display color can be modified. Right-click directly on a gate plot to change the name and color.

NOTE Select No Color to leave the gated events uncolored while retaining the color of the parent 

populations. By default, the populations defined by a vertical gate, hinged gate, or four-quadrant 

gate are uncolored.
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5 Right-click the plot and select Bring population to front to make the display color of the 

specified gate appear in front of all other colors, or select Send population to back to hide the 
display color of the specified gate behind all other colors.

6 Select  in the plot area to generate a statistical table.

7 Right-click the table and select Statistics Setting to modify the settings of the statistics display 

parameters. The Statistics Setting window appears.
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The Statistics Setting window allows you to change the display of the header, statistical 
elements and cell populations included.
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The final generated plots appear as below.

8 Right-click a plot and select Export to Clipboard or Export to Graphic File from the drop-down 

menu to select an image to export.

 • Export to Clipboard copies the plot to the clipboard, allowing you to paste it directly into 
documents in common file formats.

NOTE Multiple plots can only be copied and pasted into Microsoft® Word. If a single plot is copied, 

this can be pasted into both Microsoft® Word or Microsoft® PowerPoint.

 • Export to Graphic File saves the plot as an image file.

NOTE Export to Graphic File can export plots in two selectable file formats. BMP bitmap format 

and EMF vector format.
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9 To export statistics, right-click a statistical table to select any one of the available export 

options.

 • Export to CSV File exports individual tube statistics as a single CSV file.

 • Export All Samples to CSV File exports all tube statistics as a single CSV file.

 • Export to Clipboard copies the statistics of an individual sample to the clipboard, allowing 
you to paste them directly into a Microsoft® Excel file or other file formats. 

 • Export All Samples to Clipboard assembles the statistics for all the sample tubes of an 
experiment and copies them together to the clipboard. From there they can be pasted as a 
group into a Microsoft® Excel file or other file formats.

 • Copy converts a statistical table into an image format that can be pasted into documents.

10 Export the FCS file if necessary. Refer to Exporting FCS Files. 

NOTE Ensure that any storage devices used with the instrument are free from viruses. To guard against 

data loss, Beckman Coulter recommends backing up data on a frequent and regular basis. Beckman 

Coulter is not liable for any loss of data resulting from computer viruses or damage to hardware.
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Exporting FCS Files

Exporting Single Tube Files

1 Right-click the desired tube from the test tube section of the screen and select Export FCS File. 

The Export FCS File window appears.

2 Select the population from the Population dropdown menu.

3 Select either Area or Height. 
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4 Select the FCS format next to File Version.

NOTE The default setting is FCS 3.0. If FCS 2.0 is selected, select the parameter type (linear or log) from 

the parameter type section of the window.

NOTE The default CytExpert FCS file contains high auto-fluorescence vector values that may not be 

recognized by third party software. Therefore, the data displays differently in third part software 

packages than in CytExpert. Auto-fluorescence values are added for the FCS 3.0 (High 

auto-fluorescence) export option to accommodate the use of third party software. Since both FCS 

3.0 options have the same .fcs file extension, ensure that you save the FCS 3.0 (High 

auto-fluorescence) files to a different folder than the FCS 3.0 files.

5 Select the path to save the FCS file to from the Path section of the window.

6 Select Next to export the file.
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Exporting Multiple FCS Files

1 Select Export FCS File from the File menu. The Export FCS File window appears.

2 Select the tubes to export.

3 Repeat Steps 2-6 from Exporting Single Tube Files.
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Exporting Plots or the Statistics Table of Multiple Tubes as Picture Files

1 Select File > Export FCS File. The Export Tubes to Files window appears.

2 Select the tubes to export.

3 Select the path.

4 Select OK.

NOTE The plots of the selected tubes save as .bmp file.

Importing and Exporting Instrument Settings

The CytExpert software supports importing and exporting instrument settings to facilitate the 
experiment process. Only instrument settings identical to the current configuration can be 
imported with current detector settings.

Select  to edit gain, threshold, and width. These can be imported from an experiment 
file or from a catalog of instrument settings.
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Importing Instrument Settings

1 Select the desired sample tube to import. Then select .

NOTE Instrument settings can only be imported into tubes where data has not yet been recorded.

2 Select Import From File, locate the file with the required instrument settings, or select Import 

From Catalog to import the instrument settings.

[CytoFLEX LX Shown]

3 Select Close.

Exporting Instrument Settings

1 Select the desired sample tube to export. Then select .
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2 Select Export To File to export a current set of instrument settings, stored in a file ending in .acq. 

Or 

Select Export To Catalog, give a name to the settings to be exported, and export the file to the 
software’s Acquisition Setting Catalog, then select OK. 

3 Select Close.

Importing and Exporting Compensation Settings

The software supports unrestricted importing and exporting of compensation data, regardless of 
whether the sample tube data has already been acquired. Imported compensation values only cover 
channels identical with the current instrument configuration. The software automatically adjusts 
compensation values according to differences in the gain level. Refer to Importing and Exporting 
Compensation in CHAPTER 6, Compensation.

Printing Graphics

CytExpert offers printing functionality for the plots and tables that appear in the plot area. The 
software also lets you save these images by converting them into .jpg or .pdf files.
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Select  in the printer control area to print directly. Or, select the print drop-down arrow for 
the following options:

 •  Print Preview. Used to access the Preview screen.

— Select  to select the required format of the file to be exported and to save the file in 
that format.

— Print preview also lets you choose between printing directly (1), modifying the printer 
configuration (2), or adjusting the page settings (3).

 •  Page Setup. Used to adjust the page settings.

b c d
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 •  Batch Print. Used to print data for multiple tubes.

1. Select Batch Print. The Batch Print window appears.

2. Select the tubes to print.

3. Select OK.

 •  Batch Export to PDF File. Used to print a PDF of the data for multiple tubes.

1. Select Batch Export to PDF File. The Batch Export to PDF File window appears.

2. Select the tube to print to PDF.

3. Select OK.
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Saving the Experiment

Selecting Save in the File menu allows you to save the experiment. 

Selecting Save As and saving the experiment under a different name allows you to create a backup. 

Selecting Save As Template in the File menu allows you to save the experiment as a template.

Concluding the Experiment

Conclude the experiment as follows:

 • Select Standby to return the instrument to the standby state.

 • Select File > Close Experiment to clear the experiment and return to the Start Page.

NOTE If changes were made to the experiment, the software prompts you to save the latest changes in 

the experiment before returning to the Start Page.

 • Shut down the system. Refer to CHAPTER 8, Daily Shutdown.
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CHAPTER 6

Compensation

Overview

This chapter describes how to create a compensation experiment and automatically calculate 
compensation values after acquiring the data. It also explains how to use these calculations for 
other experiments.

Compensation involves correction for fluorescence spillover emitted by the primary fluorochrome 
that is detected by the secondary fluorescent channels. For example, the excitation and the 
resulting fluorescence emission for the PE fluorochrome leads to the spillover fluorescence 
detected in the ECD, PC5.5, and PC7 channel. Compensation reduces the spillover fluorescence of 
the PE-positive population to match the background of the PE-negative population in the secondary 
channels. Compensation requires a single positive and a negative population for every single color 
sample.

Properly configured compensation minimizes false data interpretation caused by spillover 
fluorescence from another fluorochrome. Refer to Figure 6.1 and Figure 6.2 for an example of plots 
before and after compensation. Compensation adjustments can be completed during the data 
acquisition process or after the data acquisition process is complete.

Figure 6.1  Before Compensation

Figure 6.2  After Compensation

NOTE CytExpert compensation allows full matrix compensation, manual, and automatic.

CytExpert compensation also includes a novel Compensation Library for storage of spillover values of 

dyes to easily determine the correct compensation matrix with new gain settings.
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Workflow:

This chapter contains information on:

 • Creating a Compensation Experiment

 • Creating a Compensation Experiment [With Plate Loader]

 • Creating the Compensation Matrix from Previously Acquired Data

 • Adjusting Compensation

Creating a Compensation Experiment

Before creating a compensation experiment, you must verify the instrument’s detector 
configuration settings (see Verifying, Selecting, Editing, and Creating Detector Configuration in 
CHAPTER 5, Data Acquisition and Sample Analysis).

1 Select New Compensation in the File menu or on the start page to create a new compensation 

experiment.

NOTE The file name of the newly created compensation experiment has a “.xitc” suffix.

2 Navigate to the desired file path and select Save. The Compensation Setup window appears.

CAUTION

Risk of erroneous results. Select an unstained tube, according to which the 

fluorescence background will be set. If there is not an unstained tube 

available, then each single color tube must have a negative population.

It is important to specify the appropriate sample type. Otherwise, the 

background information could be incorrectly calculated and lead to erroneous 

compensation results.

3 Select the channel requiring compensation calculation and the sample type. 

Prepare 

Compensation 

Samples

Ô

Create 

compensation 

experiment

Ô
Acquire and 

record data
Ô

Calculate 

compensation
Ô

Apply 

compensation 

to sample for 

data analysis
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If a negative population is not present in each single color tube, then an unstained control tube 
is recommended.

NOTE The default selection is Area. The unstained negative control tube can be selected if needed.

NOTE Label and lot number information can be retained in the Compensation Library to facilitate future 

compensation calculations.
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4 Select OK.

After confirmation, the software automatically generates the following compensation 
experiment.

NOTE Select Area to calculate compensation based on the Area measured. Alternatively, select Height 

to calculate compensation based on the Height measured.

Preparing the Compensation Sample

To perform a compensation experiment, prepare:

 • A single positive control tube for each color

 •  A negative control tube (optional)

NOTE A negative control tube is required if a single positive control tube does not contain a negative 

population.

For the negative control sample and single positive control sample, you can use blood, cells, or 
dedicated compensation beads such as VersaComp Antibody Capture Beads. For details, refer to the 
appropriate reagent instructions for use. The negative control tube is used to determine the 
autofluorescence of the sample.

Using Control Samples to Generate the Compensation Matrix

Defining the Negative Population Using Unstained Samples

1 Confirm that the instrument has been initialized. Refer to Initializing the Instrument in 

CHAPTER 3, Daily Startup.
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CAUTION

Risk of erroneous results. Calculations based on excessively small volumes of 

sampled data can be inaccurate. Ensure that more than 1,000 positive events and 

more than 1,000 negative events are sampled. If the ratio of positive cells is 

comparatively low, increase the number of acquisition events to a suitable 

amount.

2 Import the gain setting and apply the setting to all tubes. Refer to Adjusting the Gain in 

CHAPTER 5, Data Acquisition and Sample Analysis. Use the pan tool to adjust the axis scale so 
that the sample signal appears in a suitable position. Adjust the gate so that it encloses the 
target cell population (see Creating Plots and Gates in CHAPTER 5, Data Acquisition and Sample 
Analysis). 

3 Place the negative control tube in the sample tube holder.

4 Select the unstained tube.

5 Select Run to load the sample.
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6 Set an appropriate number of cells to save in Events to Record located on the left side of the 

screen.

7 Select Record to save the data.

Running the Single Positive Control Samples

1 Place the single positive tube in sample loading position (see Figure 1.12).

2  Select the appropriate, corresponding tube. 

3 Select Run to load the sample.
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CAUTION

Risk of erroneous results. Calculations based on excessively small volumes of 

sampled data can be inaccurate. Ensure that more than 1,000 positive events and 

more than 1,000 negative events are sampled. If the number of positive cells is 

comparatively low, increase the number of acquisition events to a suitable 

amount.

4 Move the gate in the FSC/SSC plot so that it encloses the desired population. Move the positive 

gate in the plot so that it encloses the positive population. If necessary, move the positive gate 
so that it encloses the positive population.

NOTE Figure 6.3 shows an example of selecting the positive population when the negative population 

is defined by the unstained sample.

Figure 6.3  Positive Population Selected from the Single-Stained Sample 

1. Positive population
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NOTE Figure 6.4 shows an example of selecting both the positive and negative populations without an 

unstained sample.

Figure 6.4  Positive and Negative Populations Without an Unstained Sample

5 Select Record.

6 Repeat steps 1-5 to acquire data from subsequent single positive sample tubes. 

CAUTION

Risk of erroneous results. While the software automatically adjusts the 

compensation calculation according to gain, excessive manual adjustment of the 

fluorescence gain could lead to inaccurate results.

7 If necessary, adjust gain while acquiring data from single positive sample tubes. Refer to 

Adjusting the Gain in CHAPTER 5, Data Acquisition and Sample Analysis.

Calculating Compensation Values

1 Check all acquired sample tubes and confirm that the gating is appropriate.

1. Negative population

2. Positive population
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2 Select  or select Compensation Calculation in the Compensation menu to calculate the 

compensation values.

The Compensation Matrix window appears, displaying the calculated compensation values.

NOTE The primary fluorescence channels are listed in columns; the secondary fluorescence channels 

are listed in rows.

NOTE In the Compensation Matrix window:

 • The Use checkbox applies the compensation to the selected sample.

 • The Show Autofluorescence checkbox displays the vectors for the autofluorescence.

3 Select Save As to export the compensation matrix as a .comp file and specify where to save it. 

NOTE The compensation matrix can also be imported for use in other experiments.

4 Select Save To Compensation Library to save the single color compensation values in the 

compensation library. 
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5 Specify the key words and select OK.

NOTE The settings stored in the compensation library are specific to the detector configuration. The 

compensation library can only be applied when the detector configurations are the same.

At any time, saved compensation experiments can be reopened and the compensation values 
recalculated.

6 Select Close.

Creating a Compensation Experiment [With Plate Loader]

Before creating a compensation experiment, you must verify the instrument’s detector 
configuration settings (see Verifying, Selecting, Editing, and Creating Detector Configuration in 
CHAPTER 5, Data Acquisition and Sample Analysis).

1 Select New Compensation in the File menu or on the start page to create a new compensation 

experiment.

NOTE The file name of the newly created compensation experiment has a “.xitc” suffix.

2 Navigate to the desired file path and select Save. The Compensation Setup window appears.
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3 Select the plate type and sampling sequence located in the top, right of the Compensation Setup 

window.

CAUTION

Risk of erroneous results. Select an unstained tube, according to which the 

fluorescence background will be set. If there is not an unstained tube, then 

each single marker tube must have a negative population.

It is important to specify the appropriate sample type. Otherwise, the 

background information could be incorrectly calculated and lead to erroneous 

compensation results.

4 Select the channel requiring compensation calculation, and the sample type. 

If a negative population is not present in each single color well, then an unstained control well 
is recommended.

NOTE The default selection is Area. The unstained negative control well can be selected if needed.

NOTE Label and lot number information can be retained in the Compensation Library to facilitate future 

compensation calculations.

5 Select the Mix and Backflush settings in the bottom, right of the Compensation Setup window.
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6 Assign the well locations.

a. Select the fluorochrome.

b. Select the desired sample well location for the fluorochrome.

c. Select Set As Sample Well.

NOTE The well location populates in the location column.

d. Repeat Steps a-c for each fluorochrome.

7 Select OK.

After confirmation, the software automatically generates the following compensation 
experiment.

NOTE Select Area to calculate compensation based on the Area measured. Alternatively, select Height 

to calculate compensation based on the Height measured.

NOTE If the plate settings require modification, select . The Compensation Setup window appears.

8 Before acquiring data, ensure the plate has been loaded properly. Data can be acquired as a 

single well or as a set of wells. Refer to Running Samples in CHAPTER 5, Data Acquisition and 
Sample Analysis.
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Preparing the Compensation Sample

To perform a compensation experiment, prepare:

 • A single positive control well for each color

 • A negative control well (optional)

NOTE A negative control well is required if a single positive control well does not contain a negative 

population.

For the negative control sample and single positive control sample, you can use blood, cell lines, or 
dedicated compensation beads such as VersaComp Antibody Capture Beads. For details, refer to the 
appropriate reagent instructions for use. The negative control tube is used to determine the 
autofluorescence of the sample.

Using Control Samples to Generate the Compensation Matrix

Refer to Defining the Negative Population Using Unstained Samples and Running the Single Positive 
Control Samples in CHAPTER 6, Compensation.

Calculating Compensation Values

1 Check all acquired sample tubes and confirm that the gating is appropriate.

2 Select  or select Compensation Calculation in the Settings menu to calculate the 

compensation values.

The Compensation Matrix window appears, displaying the calculated compensation values.

3 Select Save As to export the compensation matrix as a .comp file and specify where to save it. 

NOTE The compensation matrix can also be imported for use in other experiments.
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4 Select Save To Compensation Library to save the single color compensation values in the 

compensation library. 

5 Specify the key words and select OK.

NOTE The settings stored in the compensation library are specific to the detector configuration. The 

compensation library can only be applied when the detector configurations are the same.

At any time, saved compensation experiments can be reopened and the compensation values 
recalculated.

6 Select Close.

Creating the Compensation Matrix from Previously Acquired Data

The software supports importing single color data acquired from other experiments into a 
compensation experiment to perform compensation calculations. The data to be imported must 
match the active detector configuration at the time that the compensation experiment was created. 
Otherwise, the data cannot be imported. It is important to ensure that imported data comes from 
the same instrument and uses the same configuration and channels. Data originating from a 
different instrument will cause erroneous calculations.

1 Select New Compensation from the File menu or the start page.

2 To create a compensation experiment, select the required channels. Refer to Setting the 

Channel and Label in CHAPTER 5, Data Acquisition and Sample Analysis.
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3 Right-click on the appropriate test tube and select Import FCS File. Locate the corresponding 

data file and import the file. Only files compatible with the detector configuration are 
supported by the software for importing.

 in front of a test tube indicates that the corresponding data have been imported.

4 After importing the data, adjust the gates to properly identify the positive population and the 

negative population for each single-color samples.

5 Calculate the compensation values and export them. Refer to Calculating Compensation Values.
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Adjusting Compensation

Manually Adjusting Compensation

The compensation can be manually adjusted in an experiment in two ways:

 • Select the populations where needs to be adjusted in the bivariate plot. Select  from the 
graphic control area, then click and drag the mouse pointer up and down or left and right inside 
the plot to adjust compensation.

 • Select Compensation Matrix in the Setting menu to open the compensation matrix. Adjust the 
compensation value between the primary channel and the secondary channel. 

Importing and Exporting Compensation

Importing Compensation Settings from Compensation Matrix Files

1 Select the desired sample tube for importing compensation values. 

2 Select Compensation Matrix in the Setting menu.

3 Select Import and locate the path where compensation matrix files are saved. Select the 

corresponding compensation matrix file (.comp) to import the compensation values. 

You can also select Import from Library to import compensation values from the compensation 
library. The Import from Compensation Library window appears. Refer to Importing 
Compensation Settings from the Compensation Library.

Both methods allow you to import the compensation values with or without the adjustment 
based on the gain settings.
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4 After opening the desired compensation file, the Import Compensation window appears. Select 

one of the following:

 • Import compensation matrix and convert it with current gains.

 • Import compensation matrix.

 • Import compensation matrix and gain.

NOTE

 • If the tube does not have any data when importing compensation values calculated from other 

instrument settings, the software prompts you to select whether the gain settings must be 

imported as well. Select Yes to import fluorescence channel gains settings along with the rest 

of the data. Select No to allow the CytExpert software to adjust the compensation matrix values 

based on the current gain settings.

 • If the tube does have data when importing compensation values from other instrument settings, 

the software prompts you to select whether the compensation values are adjusted based on the 

current gain settings. 

 • It is important to note that automatic adjustments to compensation values calculated from 

other instrument gain settings could result in incorrect compensation. Always review the data 

after importing compensation values to ensure the sample is compensated properly.

5 Select OK.

6 If necessary, select Apply to to apply the compensation values to the selected test tubes.

7 Select Close.

Importing Compensation Settings from the Compensation Library

You can choose which single color data to include from the compensation library. Only single color 
data in the compensation library from the same detector configuration can be imported into the 
compensation matrix.

NOTE Files available in the compensation library are configuration-specific. The compensation library only 

displays the files created under the current default configuration.
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1 Select Import From Compensation Library to select which compensation values to import from 

the compensation library.

[CytoFLEX LX Shown]

2 In the Keywords column, the corresponding compensation values can be selected for each 

channel. The compensation values of the same keyword can also be selected using the 
drop-down menus in the Keywords column.

3 Select OK to import the compensation values. 
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Exporting Compensation Settings

1 Select the desired sample tube to export.

2 Select Compensation Matrix in the Setting menu.

3 Select Export to specify a path and filename for the compensation file you are saving.

[CytoFLEX LX Shown]

4 Select Save.

NOTE The generated file ends in .comp.
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Managing the Compensation Library

Compensation values can be managed in the Compensation Library. 

1 Select Compensation Library from the Settings menu. The Compensation Library window 

appears.

NOTE The Compensation Library is arranged by fluorescence detection channels. 

2 Select the desired single color sample. The compensation information appears on the right side 

of the window. 

NOTE Existing compensation values (height and area) can be modified by double-clicking the 

appropriate column in the Compensation Library window.

3 Enter the Label and Lot No. for the specified single color sample.

4 Select OK.
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Adding Channels for Compensation

Channels requiring compensation calculations that have not been previously acquired can be added 
to the compensation experiment by acquiring the necessary positive tubes.

1 In the compensation experiment, select  in the compensation controls, or select 

Compensation Setup in the Compensation menu. The Compensation Setup window appears.

2 Select the channel that needs to be added and select OK.

The software automatically adds a new single positive tube to the compensation experiment. It 
also adds a plot with appropriate parameters in the negative control tube.

NOTE It is important to ensure that the data for the previously acquired negative control now includes 

the data of the newly added channel and that the settings are correct. Otherwise, you must 

reacquire the negative control tube and adjust the gain.

3 Repeat 1-2 to detect and acquire newly added single positive sample data.

4 Repeat Calculating Compensation Values to recalculate and export the compensation results.
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CHAPTER 7

Data Review

Overview

This chapter discusses how to use the Analysis screen to analyze data. Data can be analyzed using 
any computer equipped with the CytExpert software. No online connection is required.

Workflow:

This chapter contains information on:

 • Copying Experiments and Importing Data

 • Setting the Plots and Statistics

 • Calculating Sample Volume and Concentration

 • Adjusting Compensation Settings

 • Exporting Results

Copying Experiments and Importing Data

Copying a Previously Acquired Experiment

Experiments acquired by other CytoFLEX instruments using CytExpert software can be imported to 
your computer for analysis, provided your computer also uses CytExpert software.

Select Open Experiment from the Start page or select Open Experiment in the File menu to open the 
copied experiment. Then, select Save As.

NOTE The .xit and data folder must be stored in the same path.

Importing Previously Acquired Data

The CytExpert software can import and analyze compatible FCS data files acquired by other 
CytoFLEX flow cytometers.

1 Create a new experiment or open a saved experiment. Refer to Creating an Experiment in 

CHAPTER 5, Data Acquisition and Sample Analysis.

Import experiment or data Ô Plot and configure statistics Ô Export results
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Data Review

Copying Experiments and Importing Data  
2 In the new or opened experiment, select Import FCS File in the File menu to import the data 

files.

Imported data files appear in the Tube screen. 

The  symbol in front of each data tube indicates that the data tube is an imported data file. 
Imported data files are copied and saved in the folder where the current experiment data files 
are saved.
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Setting the Plots and Statistics  7
Setting the Plots and Statistics

Opening the Analysis Screen

1 Select  on the left to enter the Analysis screen.

2 Copy plots obtained during data acquisition.

a. If you need original plots used during data acquisition, select  to access the Acquisition 
screen. 

b. Select the appropriate plots.

c. Right-click the selected plots and select Copy from the drop-down menu or press Ctrl+C to 
copy.

d. Select  to return to the Analysis screen. 

e. Select the required test tube from the tube list on the left side of the screen.

f. Right-click the plot area and select Paste from the drop-down menu or press Ctrl+V to paste 
the plot. 

NOTE Pasted plots include all gates, but the gate names are reassigned.
B49006AM   7-3



Data Review

Setting the Plots and Statistics  
3 New plots can be created according to need. After selecting the test tubes requiring analysis, 

use the plotting control buttons at the top of the screen to create a new plot.

NOTE Each graph in the Analysis screen may correspond to different data. Pay special attention to each 

plot’s heading to avoid mistakes during analysis. 

4 Use the sample selection controls in the graphics controls toolbar at the top of the page (see 

Figure 2.1) to change the data displayed in a plot.

a. Select the plot requiring a change to the data displayed. By pressing and holding the Ctrl 
key while selecting plots, you can select several plots at one time.

b. Select one of the two triangular sample selection buttons (  or ) to choose between 

the previous sample and the next sample, or select  to specify which data to display.
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Setting the Plots and Statistics  7
Creating Histogram and Dot Plot Overlays

The CytExpert software supports histogram and dot plot data overlay functionality, allowing you to 
combine data from differing sources onto the same histogram or dot plot.

1 Select Histogram Overlay under the histogram icon drop-down list to create a new multi-data 

histogram.

Or

Select Dot Plot Overlay under the dot plot icon drop-down list to create a new dot plot overlay.
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Setting the Plots and Statistics  
IMPORTANT A maximum of 10 samples can be overlaid.

2 Select  to select samples for overlay display. Or, drag and drop samples from the tube list on 

the left into the histogram or dot plot overlay. The software automatically assigns different 
colors to different data.

To remove a sample, select  and uncheck the sample. Or, right-click the color legend and 
select Remove [sample name] or Remove All Sample. The corresponding data will no longer 
appear on the graph. 

3 To change the color selections, right-click on the sample name in the legend located on the 

right side of the plot and select Color from the drop-down menu. A color pallet appears. 

For configuring gates and generating statistics, refer to CHAPTER 5, Data Acquisition and Sample 
Analysis.
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Calculating Sample Volume and Concentration  7
Calculating Sample Volume and Concentration

The CytoFLEX flow cytometer supports the calculation of the sample concentration based on the 
volume consumed and/or based on the known concentration of reference beads.

NOTE If necessary, calibrate the sample uptake rate (see Calibrating the Sample Flow Rate in CHAPTER 11, 

Replacement/Adjustment Procedures) prior to collecting data for volumetric analysis:

 • Select the cells/μL(V) checkbox to calculate concentration directly.

NOTE The direct calculation of concentration can be affected by several conditions such as, the 

sample’s viscosity and sample mixing. Uncalibrated sample volume uptake rates may lead to 

erroneous results.

 • If using reference beads to calculate the concentration, select the cells/μL(B) checkbox and select 

the gated Beads Population. Enter the total number of reference beads as the Beads Count, as well 

as the sample volume in total. The software automatically calculates the original sample 

concentration based on the input values. (You can also enter the reference bead concentration 

directly in the beads count field and set the sample volume as 1.)

To obtain accurate calculations, throughout the data acquisition process, ensure that:

 • The sample concentration is 2 x 104-107 units/mL.

 • Samples are thoroughly mixed before loading and that they exhibit no apparent subsidence 
throughout the testing process.

 • The detection rate is maintained at less than 10,000 events/second throughout the sampling 
process. When the detection rate does not exceed the stated event rate, running at medium to 
high acquisition speeds are considered more accurate.

 • A constant sampling rate is maintained when recording data.

 • You acquire at least 10 μL of sampling volume.
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Data Review

Adjusting Compensation Settings  
In the Statistics Setting screen, select Volume and the concentration item to see the corresponding 
information in the statistics table.

NOTE While collecting samples, instantaneous data calculation can appear inaccurate. Regard the 

calculation as accurate only after data acquisition has been completed.

Adjusting Compensation Settings

Data compensation can be carried out at any time. You can select the desired tube in the tube list 

on the left side of the screen and select  in the compensation controls, or select Compensation 

Setup in the Compensation menu. Refer to Adjusting Compensation in CHAPTER 6, Compensation, 
for detailed instructions on adjusting compensation settings.

[CytoFLEX LX Shown] [CytoFLEX LX Shown]
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Exporting Results  7
Exporting Results

Refer to CHAPTER 5, Data Acquisition and Sample Analysis.
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Exporting Results  
B49006AM   7-10



CHAPTER 8

Daily Shutdown

Overview

This chapter provides procedures for shutting down the CytoFLEX instrument.

Workflow:

This chapter contains information on:

 • Preparing the Cleaning Solution

 • Shutting Down the Instrument

 • Auto Shutdown [CytoFLEX LX Only]

Preparing the Cleaning Solution

Required materials

Materials to prepare:

 • 12 x 75 mm sample loading tube

 • FlowClean

 • Deionized water

 • Bleach

Set aside 2 mL of FlowClean in one sample tube and 3 mL of the deionized water in a separate sample 
tube.

Shutting Down the Instrument

1 Run Daily Clean to clean the sample line. Refer to Daily Clean or Daily Clean [With Plate Loader] 

in CHAPTER 10, Cleaning Procedures.

2 If necessary, empty all waste liquid from the waste container. Refer to Emptying the 4 L Waste 

Container [CytoFLEX] in CHAPTER 11, Replacement/Adjustment Procedures.

Prepare the cleaning solution Ô Clean the instrument Ô Turn the instrument off
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Daily Shutdown

Auto Shutdown [CytoFLEX LX Only]  
3 Remove the sample tube from the instrument and store according to your laboratory 

procedures.

4 Select Standby.

5 Exit the software. 

6 Optional: Turn the computer off.

7 Optional: Turn the Cytometer's main power switch off.

8 If there are any spills, clean the sample station. Refer to Cleaning the Sample Station in 

CHAPTER 10, Cleaning Procedures.

Auto Shutdown [CytoFLEX LX Only]

You can set up the system to automatically Shutdown the Cytometer. 

To schedule an auto shutdown after acquisition refer to Step 6 of Creating an Experiment [With 
Plate Loader] in CHAPTER 5, Data Acquisition and Sample Analysis.

To schedule an auto shutdown during Daily Clean refer to Step 3 of Daily Clean [With Plate Loader] 
in CHAPTER 10, Cleaning Procedures.
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CHAPTER 9

Troubleshooting

Overview

IMPORTANT In addition to the information stated, never disassemble the instrument or have it repaired by 

unauthorized personnel. Beckman Coulter bears no responsibility for any problems arising from the 

unauthorized repair of the instrument. 

This chapter introduces solutions to common problems. If there is a problem, follow the 
information in this chapter to carry out self inspection. If the problem cannot be resolved, contact 
us.

This chapter contains information on:

 • Precautions/Hazards

 • Hazard Labels and Locations

 • RoHS Notice

 • Disposal Precaution

 • Troubleshooting Table

 • Backup and Restore

Precautions/Hazards

Laser Related Hazards

Beckman Coulter design and manufacture of the instrument complies with the requirements 
governing the use and application of a laser specified in regulatory documents issued by the:

 • U.S. Department of Health and Human Services

 • Center for Devices and Radiological Health (CDRH)

 • International Electrotechnical Commission (IEC)

In compliance with these regulatory documents, every measure has been taken to ensure the health 
and safety of users and laboratory personnel from the possible dangers of laser use.

Use the instrument according to the information in the manuals.

Use controls or adjustments or performance of procedures other than those specified herein might 
result in hazardous radiation exposure.

To ensure your safety, the Cytometer lasers are covered with protective shields. Do not remove 
these shields.
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Precautions/Hazards  
No user-serviceable assemblies are accessible. Do not attempt to remove the laser or open it. The 
instrument has components that are dangerous to the operator. If any attempt has been made to 
defeat a safety feature, or if the instrument fails to perform as described in its manuals, disconnect 
the power and contact us.

Laser Beam Hazards

The CytoFLEX Series flow cytometer can contain up to 6 solid-state diode lasers that are capable of 
producing laser light at the following levels: 

 • 355-nm, 20-mW solid-state diode laser

 • 375-nm, 60-mW solid-state diode laser

 • 405-nm, 80-mW solid-state diode laser

 • 488-nm, 50-mW solid-state diode laser

 • 561-nm, 30-mW solid-state diode laser

 • 638-nm, 50-mW solid-state diode laser

 • 808-nm, 60-mW solid-state diode laser

A laser beam is a unique light source that shows characteristics different from conventional light 
sources. The safe use of the laser depends upon familiarity with the instrument and the properties 
of coherent, intense beams of light.

WARNING

Risk of personal injury. The laser beam can cause eye damage if viewed either 

directly or indirectly from reflective surfaces (such as a mirror or shiny metallic 

surfaces). To prevent eye damage, avoid direct exposure to the laser beam. Do not 

view it directly or with optical instruments.

Indirect contact with the laser beam from reflective surfaces (such as jewelry or a screwdriver) is 
called specular reflection and might also cause damage.

For these reasons, it is important to:

 • Limit access to the Cytometer to trained and experienced personnel.

 • Never attempt to remove a shield housing a laser.

 • Never remove a warning label.

 • Contact us if a label is missing or unclear.
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Troubleshooting

Precautions/Hazards  9
Laser Warning Labels

WARNING

Risk of personal injury from radiation exposure. Never remove the shield 

surrounding a laser. Never remove covers.

CDRH-approved and IEC compliant labels are also placed near or on those covers that when 
removed might expose laser radiation. If necessary, a cover with a CDRH-approved or IEC compliant 
label must be removed by a qualified Beckman Coulter Representative only.

Refer to the following figures for the locations of the CDRH-approved and IEC compliant labels:

See Figure 9.1 and Figure 9.2 for the Laser Warning Label on the Cytometer optical bench.

See Figure 9.3 and Figure 9.4 for the Laser Warning Label on the optical bench (located Inside 
the Cytometer).

See Figure 9.6 and Figure 9.7 for the Laser Warning Labels on the Cytometer Back Cover.

The laser product is classified as CLASS 1 when all protective measures are in place. This product 
complies with 21 CFR Parts 1040.10 and 1040.11 as well as EN60825-1. See Figure 9.1.

Figure 9.1  Laser Warning Label on the Laser Optical Bench [CytoFLEX]

LASER RADIATION
AVOID EXPOSURE TO BEAM
CLASS 3B LASER PRODUCT

CAUTION
CLASS  3B LASER   RADIATION WHEN OPEN AND 

INTERLOCKS DEFEATED. AVOID EXPOSURE TO BEAM

PRÉCAUTION
LASER  CLASSE  3B  RADIATION  LASER QUAND

 L ' INSTRUMENT EXT OUVERT ET NON  VERROUILLE
       ÉVITER   TOUTE  EXPOSITION  AU  FAISCEAU

CAUTION
CLASS  3B LASER   RADIATION WHEN OPEN AND 

INTERLOCKS DEFEATED. AVOID EXPOSURE TO BEAM

PRÉCAUTION
LASER  CLASSE  3B  RADIATION  LASER QUAND

 L ' INSTRUMENT EXT OUVERT ET NON  VERROUILLE
       ÉVITER   TOUTE  EXPOSITION  AU  FAISCEAU
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Troubleshooting

Precautions/Hazards  
Figure 9.2  Laser Warning Label on the Laser Optical Bench [CytoFLEX LX]

Figure 9.3  Laser Warning Label within the Optical Bench (Located Inside the Cytometer) [CytoFLEX]

Figure 9.4  Laser Warning Label within the Optical Bench (Located Inside the Cytometer) [CytoFLEX LX]

CAUTION
CLASS  3B LASER   RADIATION WHEN OPEN AND 

INTERLOCKS DEFEATED. AVOID EXPOSURE TO BEAM

PRÉCAUTION
LASER  CLASSE  3B  RADIATION  LASER QUAND

 L ' INSTRUMENT EXT OUVERT ET NON  VERROUILLE
       ÉVITER   TOUTE  EXPOSITION  AU  FAISCEAU

CAUTION
CLASS  3B LASER   RADIATION WHEN OPEN AND 

INTERLOCKS DEFEATED. AVOID EXPOSURE TO BEAM

PRÉCAUTION
LASER  CLASSE  3B  RADIATION  LASER QUAND

 L ' INSTRUMENT EXT OUVERT ET NON  VERROUILLE
       ÉVITER   TOUTE  EXPOSITION  AU  FAISCEAU

CAUTION
CLASS 3B LASER RADIATION WHEN
OPEN AND INTERLOCKS DEFEATED

AVOID EXPOSURE TO BEAM

LASER RADIATION
AVOID EXPOSURE TO BEAM
CLASS 3B LASER PRODUCT

CAUTION
CLASS  3B LASER   RADIATION WHEN OPEN AND 

INTERLOCKS DEFEATED. AVOID EXPOSURE TO BEAM

PRÉCAUTION
LASER  CLASSE  3B  RADIATION  LASER QUAND

 L ' INSTRUMENT EXT OUVERT ET NON  VERROUILLE
       ÉVITER   TOUTE  EXPOSITION  AU  FAISCEAU

LASER RADIATION
AVOID EXPOSURE TO BEAM
CLASS 3B LASER PRODUCT

CAUTION
CLASS  3B LASER   RADIATION WHEN OPEN AND 

INTERLOCKS DEFEATED. AVOID EXPOSURE TO BEAM

PRÉCAUTION
LASER  CLASSE  3B  RADIATION  LASER QUAND

 L ' INSTRUMENT EXT OUVERT ET NON  VERROUILLE
       ÉVITER   TOUTE  EXPOSITION  AU  FAISCEAU

LASER RADIATION
AVOID EXPOSURE TO BEAM
CLASS 3B LASER PRODUCT

LASER RADIATION
AVOID EXPOSURE TO BEAM
CLASS 3B LASER PRODUCT
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Precautions/Hazards  9
Figure 9.5  Laser Warning Label on the 355-nm Laser [CytoFLEX LX]

Figure 9.6  Laser Warning Labels on the Cytometer Back Cover [CytoFLEX]

CLASS 1 LASER PRODUCT
COMPLIES WITH 21 CFR 1040.10 AND 1040.11
EXCEPT FOR DEVIATIONS PURSUANT TO
LASER NOTICE NO. 50 DATED JUNE 24, 2007
MANUFACTURED 

SNSN

CLASS 1 LASER PRODUCT
COMPLIES WITH 21 CFR 1040.10 AND 1040.11
EXCEPT FOR DEVIATIONS PURSUANT TO
LASER NOTICE NO. 50 DATED JUNE 24, 2007
MANUFACTURED 
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Hazard Labels and Locations  
Figure 9.7  Laser Warning Labels on the Cytometer Back Cover [CytoFLEX LX]

Hazard Labels and Locations

Carefully read the hazard warning labels on the instrument. The hazard labels are located on the 
instrument as indicated. 

NOTE If a label is missing or unclear, contact us. 

Biohazard Label and Location

Figure 9.8  Biohazard Label on the 4 L Fluid Containers

CLASS 1 LASER PRODUCT
COMPLIES WITH 21 CFR 1040.10 AND 1040.11
EXCEPT FOR DEVIATIONS PURSUANT TO
LASER NOTICE NO. 50 DATED JUNE 24, 2007
MANUFACTURED 

SN

CLASS   1   LASER   PRODUCT
 PRODUIT   LASER   CLASSE   1

CLASS 1 LASER PRODUCT
COMPLIES WITH 21 CFR 1040.10 AND 1040.11
EXCEPT FOR DEVIATIONS PURSUANT TO
LASER NOTICE NO. 50 DATED JUNE 24, 2007
MANUFACTURED 

Sheath SheathWaste
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Hazard Labels and Locations  9
Figure 9.9  Biohazard Label on the 10 L Fluid Cubitainers

Figure 9.10  Biohazard Label Located in the Sample Station and on the Back of the Cytometer [CytoFLEX 

Shown]

Electrical Shock Hazard Label and Location

Figure 9.11  Electrical Shock Hazard Label by the Power Switch [CytoFLEX Shown]

REACTIVE INGREDIENTS: Anti-microbial compound

A nonionic, non-flourescent, and azide free sheath fluid 
for use on Beckman Coulter CytoFLEX flow cytometers.

10 L

Cyto FLEX
Sheath Fluid

CLASS 1 LASER PRODUCT
COMPLIES WITH 21 CFR 1040.10 AND 1040.11
EXCEPT FOR DEVIATIONS PURSUANT TO
LASER NOTICE NO. 50 DATED JUNE 24, 2007
MANUFACTURED 

SNSN

CLASS 1 LASER PRODUCT
COMPLIES WITH 21 CFR 1040.10 AND 1040.11
EXCEPT FOR DEVIATIONS PURSUANT TO
LASER NOTICE NO. 50 DATED JUNE 24, 2007
MANUFACTURED 

SNSN
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Hazard Labels and Locations  
Caution Labels and Location

Figure 9.12  Caution Labels [CytoFLEX Shown]

Plate Loader Hazard Labels and Location

Figure 9.13  Plate Loader Hazard Labels

CLASS 1 LASER PRODUCT
COMPLIES WITH 21 CFR 1040.10 AND 1040.11
EXCEPT FOR DEVIATIONS PURSUANT TO
LASER NOTICE NO. 50 DATED JUNE 24, 2007
MANUFACTURED 

SNSN
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RoHS Notice  9
Disposal of Electrical Instrumentation

RoHS Notice

These labels and materials declaration table (the Table of Hazardous Substance's Name and 
Concentration) are to meet People's Republic of China Electronic Industry Standard SJ/T11364-2006 
"Marking for Control of Pollution Caused by Electronic Information Products" requirements.

RoHS Caution Label

It is very important that customers understand and follow 
all laws regarding the safe and proper disposal of electrical 
instrumentation.

The symbol of a crossed-out wheeled bin on the product is 
required in accordance with the Waste Electrical and 
Electronic Equipment (WEEE) Directive of the European 
Union. The presence of this marking on the product 
indicates:

 • that the device was put on the European Market after 
August 13, 2005 and

 • that the device is not to be disposed via the municipal 
waste collection system of any member state of the 
European Union.

For products under the requirement of WEEE directive, 
please contact your dealer or local Beckman Coulter office 
for the proper decontamination information and take back 
program which will facilitate the proper collection, 
treatment, recovery, recycling, and safe disposal of device.

A28219-AA

This label indicates that this electronic information product 
contains certain toxic or hazardous substances. The center 
number is the Environmentally friendly Use Period (EFUP) 
date, and indicates the number of calendar years the product 
can be in operation. Upon the expiration of the EFUP, the 
product must be recycled. The circling arrows indicate the 
product is recyclable. The date code on the label or product 
indicates the date of manufacture.
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Disposal Precaution  
RoHS Environmental Label

Disposal Precaution

WARNING

Risk of biohazardous contamination if you have skin contact with the waste 

container, its contents, and its associated tubing. The waste container and its 

associated tubing could contain residual biological material and must be handled 

with care. Clean up spills immediately. Dispose of the contents of the waste 

container in accordance with your local regulations and acceptable laboratory 

procedures.

Use universal precautions when working with pathogenic materials. Means must be available to 
decontaminate the instrument and to dispose of biohazardous waste.

This label indicates that the electronic information product 
does not contain any toxic or hazardous substances. The center 
"e" indicates the product is environmentally safe and does not 
have an Environmentally Friendly Use Period (EFUP) date. 
Therefore, it can safely be used indefinitely. The circling arrows 
indicate the product is recyclable. The date code on the label or 
product indicates the date of manufacture.
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Troubleshooting Table  9
Troubleshooting Table

Table 9.1 lists problems that you could encounter while running the CytoFLEX flow cytometer, the 
probable causes of each problem, and the corrective actions. These problems are listed 
alphabetically in the Index, under the primary entry “troubleshooting.”

Table 9.1  Troubleshooting

Problem Probable Cause Corrective Action

The Cytometer cannot be 

turned on.

 • The instrument is turned off 

in the Cytometer menu. 

[CytoFLEX LX]

 • The power switch is in the off 

position and the Turn On 

selection will not function in 

the Cytometer menu. 

[CytoFLEX LX]

 • The power cable is not 

securely connected.

 • The fuse is blown.

1. Ensure the power switch is in the on 

position on the back of the Cytometer. 

[CytoFLEX LX]

2. Select Turn On in the Cytometer menu. 

[CytoFLEX LX]

3. Ensure that the power cable is securely 

connected to the back of the Cytometer.

4. Replace the fuse. Refer to CHAPTER 11, 

Replacing the Fuse in CHAPTER 11, 

Replacement/Adjustment Procedures. 

5. If the problem persists, contact us.

The Workstation cannot 

be turned on.

 • The power cable is not 

securely connected.

 • The Workstation was 

restarted too fast. 

1. Ensure that the power cable is securely 

connected to the back of the Cytometer.

2. Unplug the power cable. Wait 10 

seconds, then plug the power cable back 

in. Then, restart the computer.

3. If the problem persists, contact us.

The connection indicator 

light in the lower left 

corner of the software 

screen is red and 

displays Disconnected 

and Error.

 • Data connection error

 • The Cytometer is not turned 

on.

 • The Cytometer’s power cable 

is disconnected.

1. Ensure that the USB data cable is 

securely connected to the back of the 

Cytometer and the back of the 

Workstation. Refer to Figure 1.21.

2. Restart the software. Restart the 

Workstation.Refer to Initializing the 

Instrument in CHAPTER 3, Daily Startup.

3. Turn on the Cytometer using the power 

switch on the back of the instrument.

4. Verify that the power cable is securely 

connected to the back of the Cytometer.

5. If the problem persists, contact us.
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Troubleshooting Table  
The alarm does not 

sound when the waste 

container is full or the 

sheath fluid container is 

low and the software 

status display is red. 

 • The alarm is not working. 

 • Instrument data connection 

error. 

 • The sheath fluid/waste 

harness float is restricted.

 • The sheath fluid/waste 

harnesses have been 

secured on the wrong 

container.

1. Ensure the sheath fluid/waste harnesses 

are secured to the correct container.

2. Ensure that the USB data cable is 

securely connected to the back of the 

Cytometer and the back of the 

Workstation. Refer to Figure 1.21.

3. Restart the Workstation. Refer to 

Initializing the Instrument in CHAPTER 3, 

Daily Startup.

4. Restart the software.

WARNING

Risk of biohazardous contamination if 

you have skin contact with the waste 

container, its contents, and its 

associated tubing. The waste container 

and its associated tubing could contain 

residual biological material and must be 

handled with care. Clean up spills 

immediately. Dispose of the contents of 

the waste container in accordance with 

your local regulations and acceptable 

laboratory procedures.

5. Verify that the float of the sensor in the 

sheath fluid/waste container moves 

freely. 

6. Replace the sheath fluid/waste harness. 

Refer to Replacing the Sheath Fluid 

Harness and/or Waste Harness in 

CHAPTER 11, Replacement/Adjustment 

Procedures.

7. If the problem persists, contact us.

Table 9.1  Troubleshooting (Continued)

Problem Probable Cause Corrective Action
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Troubleshooting Table  9
The fluid status 

information displays red 

for Sheath and/or Waste 

even though the sheath 

fluid container is full and 

the waste container is 

empty.

 • Instrument data connection 

error.

 • The sensor connection is not 

working properly.

 • The sensor does not work 

properly.

 • The sheath fluid/waste 

harnesses have been 

secured on the wrong 

container.

1. Ensure the sheath fluid/waste harnesses 

are secured to the correct container.

2. Ensure that the USB data cable is 

securely connected to the back of the 

Cytometer and the back of the 

Workstation. Refer to Figure 1.21.

3. Restart the software.

4. Ensure the sheath fluid harness and/or 

the waste harness are properly 

connected.

5. Verify that the float of the sensor in the 

sheath fluid container and/or waste 

container moves freely. 

6. Replace the sheath fluid harness and/or 

the waste harness. Refer to Replacing 

the Sheath Fluid Harness and/or Waste 

Harness in CHAPTER 11, Replacement/

Adjustment Procedures.

7. If the problem persists, contact us.

The sample tube holder 

cannot move up and 

down automatically. 

The setting is incorrect. 1. Ensure that the sample injection mode in 

the software is in Semi-Automatic 

Injection mode. Refer to Selecting the 

Proper Sample Injection Mode in 

CHAPTER 3, Daily Startup.

2. If the problem persists, contact us.

The sample flow rate is 

unstable. 

 • The sample probe is clogged. 

 • The sample contains 

aggregates or clumps.

 • There are air bubbles in the 

flow cell. 

 • The sample peristaltic pump 

tubing is aged. 

 • The sample peristaltic pump 

tubing is not properly 

connected.

1. Run Prime. Refer to Priming the Flow Cell 

in CHAPTER 11, Replacement/

Adjustment Procedures.

2. Run Daily Clean. Refer to Daily Clean in 

CHAPTER 10, Cleaning Procedures.

3. Clean the sample probe. Refer to 

Cleaning the Sample Probe in 

CHAPTER 10, Cleaning Procedures.

4. Filter the sample using an appropriately 

sized mesh aperture filter. 

5. Ensure that the sample tubing is properly 

connected. Refer to Replacing the 

Sample Probe and/or the Sample 

Peristaltic Pump Tubing in CHAPTER 11, 

Replacement/Adjustment Procedures.

6. Replace the sample probe and sample 

peristaltic pump tubing. Refer to 

Replacing the Sample Probe and/or the 

Sample Peristaltic Pump Tubing in 

CHAPTER 11, Replacement/Adjustment 

Procedures.

7. If the problem persists, contact us.

Table 9.1  Troubleshooting (Continued)

Problem Probable Cause Corrective Action
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The sampling flow rate is 

too fast. 

 • The threshold setting is too 

low. 

 • The sample concentration is 

too high. 

 • There are too many sample 

fragments. 

 • The sheath fluid filter is 

clogged.

 • The sample flow rate 

requires calibration.

1. Use the manual threshold setting to 

increase the threshold. Refer to 

Adjusting the Threshold in CHAPTER 5, 

Data Acquisition and Sample Analysis.

2. Calibrate the sample flow rate. Refer to 

Calibrating the Sample Flow Rate or 

Calibrating the Sample Flow Rate [With 

Plate Loader] in CHAPTER 11, 

Replacement/Adjustment Procedures.

3. Dilute the sample and adjust the 

concentration to approximately 106/mL. 

4. Filter the sample using an appropriately 

sized mesh aperture filter. 

5. Restain the sample.

6. Replace the Sheath Fluid Filter. Refer to 

Replacing the Sheath Fluid Filter in 

CHAPTER 11, Replacement/Adjustment 

Procedures.

7. If the problem persists, contact us.

Laser power is low. Communication error 1. Reinitialize. Refer to Initializing the 

Instrument in CHAPTER 3, Daily Startup.

2. Restart the Cytometer.

3. If the problem persists, contact us.

Populations are drifting.  • Air bubbles are in the flow 

cell. 

 • Air bubbles are in the 

system. 

 • The sheath fluid harness float 

is restricted.

1. Run Prime. Refer to Priming the Flow Cell 

in CHAPTER 11, Replacement/

Adjustment Procedures.

2. Ensure that the sheath fluid harness and/

or waste harness is not kinked.

3. Ensure that the sheath fluid harness and/

or waste harness is securely connected.

4. Run Prime. Refer to Priming the Flow Cell 

in CHAPTER 11, Replacement/

Adjustment Procedures.

5. Verify that the float of the sensor in the 

sheath fluid container moves freely. 

6. Replace the sheath fluid harness. Refer 

to Replacing the Sheath Fluid Harness 

and/or Waste Harness in CHAPTER 11, 

Replacement/Adjustment Procedures.

7. If the problem persists, contact us.

Table 9.1  Troubleshooting (Continued)

Problem Probable Cause Corrective Action
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Troubleshooting

Troubleshooting Table  9
Population amplitude is 

decreasing and CV 

values are increasing.

 • Air bubbles are in the flow 

cell. 

 • The flow cell is dirty. 

 • The sheath fluid harness float 

is restricted.

1. Run Prime. Refer to Priming the Flow Cell 

in CHAPTER 11, Replacement/

Adjustment Procedures.

2. Run the Deep Clean procedure. Refer to 

Deep Clean Procedure in CHAPTER 10, 

Cleaning Procedures.

3. Verify that the float of the sensor in the 

sheath fluid container moves freely. 

4. Replace the sheath fluid harness. Refer 

to Replacing the Sheath Fluid Harness 

and/or Waste Harness in CHAPTER 11, 

Replacement/Adjustment Procedures.

5. If the problem persists, contact us.

The laser delay values 

are out of range. 

 • Air bubbles are in the flow 

cell.

 • Air bubbles are in the 

system.

 • The sheath fluid harness float 

is restricted.

1. Run Prime. Refer to Priming the Flow Cell 

in CHAPTER 11, Replacement/

Adjustment Procedures.

2. Ensure that the sheath fluid harness and/

or waste harness is not kinked.

3. Ensure that the sheath fluid harness and/

or waste harness is securely connected.

4. Verify that the float of the sensor in the 

sheath fluid container moves freely. 

5. Replace the sheath fluid harness. Refer 

to Replacing the Sheath Fluid Harness 

and/or Waste Harness in CHAPTER 11, 

Replacement/Adjustment Procedures.

6. If the problem persists, contact us.

Table 9.1  Troubleshooting (Continued)

Problem Probable Cause Corrective Action
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Troubleshooting Table  
No data acquisition.  • The threshold setting is too 

high.

 • The gain setting is too low.

 • Sheath fluid flow is 

insufficient.

 • Laser power is insufficient.

 • The sample probe is clogged.

1. Decrease the threshold setting. Refer to 

Adjusting the Threshold in CHAPTER 5, 

Data Acquisition and Sample Analysis. 

2. Increase the gain setting. Refer to 

Adjusting the Gain in CHAPTER 5, Data 

Acquisition and Sample Analysis.

3. Ensure that the sheath fluid harness and/

or waste harness is not kinked.

4. Ensure that the sheath fluid harness and/

or waste harness is securely connected.

5. Run Prime. Refer to Priming the Flow Cell 

in CHAPTER 11, Replacement/

Adjustment Procedures.

6. Reinitialize. Refer to Initializing the 

Instrument in CHAPTER 3, Daily Startup.

7. Restart the Cytometer.

8. Verify that your sample does not have 

excessive debris. If it does:

a. Filter the sample using an 

appropriately sized mesh aperture 

filter. 

b. Restain the sample.

9. Clean the sample probe. Refer to 

Cleaning the Sample Probe in 

CHAPTER 10, Cleaning Procedures.

10. Replace the sample probe and the 

sample peristaltic pump tubing. Refer to 

Replacing the Sample Probe and/or the 

Sample Peristaltic Pump Tubing in 

CHAPTER 11, Replacement/Adjustment 

Procedures.

11. If the problem persists, contact us.

Data populations are 

normal on one laser, but 

too low on another laser. 

The laser delay setting is 

incorrect.

1. Ensure that the laser delay is set 

correctly. Refer to Setting Laser Delay in 

CHAPTER 11, Replacement/Adjustment 

Procedures.

2. If the problem persists, contact us

Table 9.1  Troubleshooting (Continued)

Problem Probable Cause Corrective Action
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Troubleshooting

Troubleshooting Table  9
Data populations are not 

where they are 

expected.

 • The detector configuration 

setting is incorrect.

 • The optical filter is not placed 

correctly.

 • QC was not completed.

 • Gain and threshold is not set 

correctly.

1. Ensure that the detector configuration is 

set correctly. Refer to Verifying, 

Selecting, Editing, and Creating Detector 

Configuration in CHAPTER 5, Data 

Acquisition and Sample Analysis.

2. Ensure that the position of the optical 

filter in the WDM matches the detector 

configuration setting. Refer to Verifying, 

Selecting, Editing, and Creating Detector 

Configuration in CHAPTER 5, Data 

Acquisition and Sample Analysis. 

3. Ensure that the optical filter is installed 

correctly. Refer to Replacing the Optical 

Filter in CHAPTER 11, Replacement/

Adjustment Procedures.

4. Follow the QC procedure. Refer to 

CHAPTER 4, Instrument Quality Control 

and Standardization.

5. Review the gain and threshold settings. 

Refer to Adjusting the Gain and Adjusting 

the Threshold in CHAPTER 5, Data 

Acquisition and Sample Analysis.

6. Review the display ranges. Refer to 

Creating Plots and Gates in CHAPTER 5, 

Data Acquisition and Sample Analysis.

7. If the problem persists, contact us.

No changes occurred 

after manually adjusting 

compensation settings.

Compensation was applied to 

the wrong channel.

Ensure that the adjustment is applied to the 

correct primary and secondary channels in 

the compensation matrix.

Or

Select  to modify compensation in the 

desired plot.

Table 9.1  Troubleshooting (Continued)

Problem Probable Cause Corrective Action
B49006AM   9-17



Troubleshooting

Troubleshooting Table  
The calculation of the 

automatic compensation 

experiment is incorrect.

 • Erroneous data acquisition.

 • The gate is not set on the 

appropriate population. 

 • The events of the acquired 

cells are too low.

 • The mean fluorescence of 

the positive cells is too weak.

1. Ensure that the corresponding negative 

control tube and the individual positive 

tube acquired are from the same sample 

type.

2. Ensure that the single colors collected 

correspond to the correct tube name.

3. Ensure that the gate in the FSC/SSC plot 

encloses the correct sample population. 

4. Ensure that the positive gate in each 

tube is correctly placed.

5. Modify the events to record to ensure 

that enough events are collected for the 

data population.

6. Select samples with a stronger positive 

signal as the positive control.

Or

Use dedicated compensation beads such 

as VersaComp Antibody Capture Beads

The sample is flowing, 

but no signal appears in 

the plot.

 • The signal is outside of the 

display range.

 • The parent gate is not 

positioned properly and does 

not contain events.

 • The population color setting 

is too light.

 • The threshold is too high.

1. Use either  or  to modify the 

display range.

Or

Right-click the plot and select Property. 

The Plot Property window appears. 

Select Fit with sample.

2. Ensure that the parent gate is gated 

correctly.

3. Change the display color.

4. Move the sample above the threshold 

using one of the following methods:

 • Decrease the threshold setting. Refer 

to Adjusting the Threshold in 

CHAPTER 5, Data Acquisition and 

Sample Analysis.

 • Increase the gain setting. Refer to 

Adjusting the Gain in CHAPTER 5, 

Data Acquisition and Sample 

Analysis

Table 9.1  Troubleshooting (Continued)

Problem Probable Cause Corrective Action
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Troubleshooting Table  9
The concentration 

calculation is incorrect.

 • The sample concentration is 

not within the specified 

range.

 • The sample settled.

 • The sample flow rate is too 

fast.

 • The sample volume analyzed 

is too low.

 • The cell population is not 

detected.

1. Ensure that the pipette used in sample 

processing is calibrated.

2. Verify that the concentration of the 

sample is between 2x104
-107 events/mL.

3. Vortex the sample before loading and 

verify that the sample is evenly mixed 

before loading the sample. 

NOTE An excessively long sample 

loading time leads to sample 

settlement.

4. Ensure that the sample flow rate does 

not exceed 10,000 events/second. 

5. Adjust the threshold to remove sample 

debris. 

6. Ensure that the sample volume analyzed 

exceeds 10 μL.

7. Ensure that the following are correct:

 • Gain. Refer to Adjusting the Gain in 

CHAPTER 5, Data Acquisition and 

Sample Analysis.

 • Threshold. Refer to Adjusting the 

Threshold in CHAPTER 5, Data 

Acquisition and Sample Analysis.

 • Compensation settings. Refer to 

CHAPTER 6, Compensation) 

8. Ensure that the gating and population 

hierarchy are correct.

The sample probe is too 

low.

The sample probe is not securely 

connected.

1. Ensure that the sample probe is securely 

connected to the sample peristaltic 

pump tubing. Refer to Replacing the 

Sample Probe and/or the Sample 

Peristaltic Pump Tubing in CHAPTER 11, 

Replacement/Adjustment Procedures.

2. Ensure the sample pump cover is 

securely fastened.

3. If the problem persists, contact us.

The wash station drips 

during backflush.

 • The sample probe is not 

securely connected.

 • The wash station height 

adjustment is not correct.

1. Ensure that the sample probe is securely 

connected to the sample peristaltic 

pump tubing. Refer to Replacing the 

Sample Probe and/or the Sample 

Peristaltic Pump Tubing in CHAPTER 11, 

Replacement/Adjustment Procedures.

2. Ensure the sample pump cover is 

securely fastened.

3. If the problem persists,contact us.

Table 9.1  Troubleshooting (Continued)

Problem Probable Cause Corrective Action
B49006AM   9-19



Troubleshooting

Troubleshooting Table  
The mixer is not 

functioning.

 • Sample mixing is disabled in 

the software.

 • The mixer motor is defective.

1. Ensure sample mixing is enabled in the 

software. Refer to Changing Sample 

Mixing and Backflush Settings in 

CHAPTER 11, Replacement/Adjustment 

Procedures.

2. If the problem persists, contact us.

Instrument operations 

cannot be performed in 

the Acquisition screen.

 • The instrument is in standby 

mode.

 • The software is frozen.

 • Data connection error.

1. Select Initialize. 

2. Ensure that the power switch to the 

Cytometer is turned on.

3. Restart the software.

4. Restart the Workstation.

5. Ensure that the USB data cable is 

securely connected to the back of the 

Cytometer and the back of the 

Workstation. Refer to Figure 1.21.

6. If the problem persists, contact us.

Software installation 

fails.

Multiple issues. Contact us.

Table 9.1  Troubleshooting (Continued)

Problem Probable Cause Corrective Action
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Troubleshooting Table  9
QC aborted due to low 

event rate.

 • The diluted CytoFLEX Daily 

QC Fluorospheres or 

CytoFLEX Daily IR QC 

Fluorospheres concentration 

is too low.

 • The sample probe is clogged.

 • The sample line is clogged.

1. Add 1 drop of CytoFLEX Daily QC 

Fluorospheres to the QC solution. Then, 

rerun QC.

2. Reload the target value file. Refer to 

Importing Lot-Specific Target Values in 

CHAPTER 4, Instrument Quality Control 

and Standardization. Then, rerun QC.

3. Prepare a new sample of the CytoFLEX 

Daily QC Fluorospheres. Then, rerun QC.

4. Clean the sample probe. Refer to 

Cleaning the Sample Probe in 

CHAPTER 10, Cleaning Procedures. Then, 

rerun QC.

5. Run Prime. Refer to Priming the Flow Cell 

in CHAPTER 11, Replacement/

Adjustment Procedures. Then, rerun QC.

6. Run Daily Clean. Refer to Daily Clean in 

CHAPTER 10, Cleaning Procedures. Then, 

rerun QC.

7. Replace the sample probe and sample 

peristaltic pump tubing. Refer to 

Replacing the Sample Probe and/or the 

Sample Peristaltic Pump Tubing in 

CHAPTER 11, Replacement/Adjustment 

Procedures. Then, rerun QC.

8. If problem persists, contact us.

Table 9.1  Troubleshooting (Continued)

Problem Probable Cause Corrective Action
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Troubleshooting Table  
QC failed.  • The sheath fluid container 

and the waste container are 

not on the same level as the 

Cytometer.

 • The median fluorescence 

fails to meet the target 

specification.

 • The QC gain value does not 

meet the target gain 

specifications.

 • The laser delay settings are 

too high.

 • rCV fails specifications.

1. Ensure the sheath fluid container and the 

waster container are on the same level 

as the Cytometer.

2. Rerun QC. Refer to CHAPTER 4, 

Instrument Quality Control and 

Standardization.

3. Run Prime. Refer to Priming the Flow Cell 

in CHAPTER 11, Replacement/

Adjustment Procedures. Then, rerun QC.

4. Prime the sheath fluid filter with sheath 

fluid as follows, then rerun QC.

a. Remove the vent cap from the 

sheath fluid filter.

b. Ensure that the instrument is in 

Standby.

c. At the Workstation, select 

Cytometer > Prime.

IMPORTANT If the vent cap is not 

reinstalled as soon as the sheath 

fluid approaches the vent port, the 

sheath fluid will overflow.

d. Wait until the sheath fluid 

approaches the vent port in the 

sheath fluid filter, then immediately 

reinstall the vent cap to avoid 

overflow.

5. Run Daily Clean. Refer to Daily Clean in 

CHAPTER 10, Cleaning Procedures. Then, 

rerun QC.

6. Run Deep Clean. Refer to Deep Clean 

Procedure in CHAPTER 10, Cleaning 

Procedures. Then, rerun QC.

7. If the problem persists, contact us.

Table 9.1  Troubleshooting (Continued)

Problem Probable Cause Corrective Action
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Troubleshooting

Troubleshooting Table  9
Table 9.2  Troubleshooting [With Plate Loader]

Problem Probable Cause Corrective Action

The sample probe comes 

in contact with the 

bottom of the well plate.

 • Incorrect plate type 

selected.

 • The plate or plate holder is 

installed incorrectly.

 • The sample probe sampling 

position is not calibrated.

1. Verify that the correct plate type is 

selected in the Plate window.

2. Ensure the plate and the plate holder are 

installed correctly. Refer to Replacing 

the Plate Holder [With Plate Loader] in 

CHAPTER 11, Replacement/Adjustment 

Procedures.

3. Calibrate the sample probe sampling 

position. Refer to Calibrating the Plate 

Position [With Plate Loader] in 

CHAPTER 11, Replacement/Adjustment 

Procedures.

The dead volume of the 

plate wells are high.

 • Incorrect plate type 

selected.

 • The sample probe sampling 

position is not calibrated.

1. Verify that the correct plate type is 

selected in the Plate window.

2. Calibrate the sample probe sampling 

position. Refer to Calibrating the Plate 

Position [With Plate Loader] in 

CHAPTER 11, Replacement/Adjustment 

Procedures.

Mixing does not 

sufficiently suspend the 

sample particles.

 • Incorrect plate type 

selected.

 • Incorrect sample mixing 

setting.

 • The sample probe sampling 

position is not calibrated.

1. Verify that the correct plate type is 

selected in the Plate window.

2. Verify the sample mixing duration in the 

Plate window.

3. Calibrate the sample probe sampling 

position. Refer to Calibrating the Plate 

Position [With Plate Loader] in 

CHAPTER 11, Replacement/Adjustment 

Procedures.

Gain is over 3,000 and 

default gain settings are 

needed.

Corrupt/incorrect configuration 

file.

Reload the configuration file. Refer to 

Installing the Instrument Configuration File 

in CHAPTER A, Instrument Installation.

The configuration file 

does not match the 

instrument.

Corrupt/incorrect configuration 

file.

1. Verify the correct configuration file is 

installed.

2. Reload the configuration file. Refer to 

Installing the Instrument Configuration 

File in CHAPTER A, Instrument 

Installation.

The Administrative  

account is locked.

The Admin password was 

forgotten and the attempts 

exceed the limit.

1. Select Forgot password.

2. Contact us

Plots are cut off when 

printing a PDF.

Plots need to be rearranged. Rearrange the plots until the print preview 

screen shows all plots correctly. 
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Backup and Restore  
Backup and Restore

IMPORTANT If you have the Electronic Record Management software option installed, ensure the following 

prior to attempting to restore data:

 • The target system includes all of the disk volumes that each experiment directory is saved to.

 • The user performing the restore has Set Experiment Directory permission in CytExpert.

NOTE These procedures are only available if you have either the User Management or Electronic Record 

Management software option installed.

 • Electronic Record Management: Both the database and experiment files can be backed up or 

restored.

 • User Management: Only the database can be backed up or restored.

Backup

1 Launch CytExpert.

2 Select Backup/Restore > Backup. The Backup window appears.

CAUTION

Risk of data loss. Beckman Coulter recommends storing data on a drive other than 

the operating system.

3 Select  and browse to the desired backup directory to store the backup data. 
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Backup and Restore  9
Selecting the same drive as the operation system prompts the following system warning:

4 Select Next. The Prechecking window appears.
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Backup and Restore  
The backup starts automatically after the prechecking. 

5 Select Finish. 
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Backup and Restore  9
Restore

1 Select Backup/Restore > Restore. The Restore window appears.

NOTE Ensure the data is backed up before the restoration.

2 Select Next. 

3 Select  and browse to the desired directory to restore. 
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Backup and Restore  
4 Select Next. The Warning window appears.
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Backup and Restore  9
IMPORTANT Do not turn off your computer during the restoration.

5 Select Yes. The Preparing window appears.

The restoration starts automatically after finishing the preparation.
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Backup and Restore  
6 Select Finish. The following system prompt appears.

7 Select OK. 

Log Cleanup

Use Log Cleanup to delete Experiment Operation Logs and System Operation Logs before a selected 
date.

NOTE These procedures are only available if you have either the User Management or Electronic Record 

Management software option installed.

1 Ensure all experiment files are closed.
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Troubleshooting

Backup and Restore  9
2 Select Backup/Restore > Log Cleanup. The Log Clean-up window appears.

Close the experiment and try again if the operation system prompts the following message:

3 Select the desired date and time. 
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Backup and Restore  
4 Select Next. The Confirm window appears.

5 Select Yes. The Clean-up succeeded window appears.

6 Select Finish. 
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CHAPTER 10

Cleaning Procedures

Overview

This chapter describes how to carry out certain routine and nonscheduled cleaning procedures. 
Proper cleaning can help extend the service life of the instrument and ensure experimental 
accuracy. When conducting any cleaning, take all necessary biosafety precautions and use proper 
personal protective equipment. 

This chapter contains information on:

 • Routine Cleaning

— Daily Clean

— Daily Clean [With Plate Loader]

— Cleaning the Sample Station

— Deep Clean Procedure

— Cleaning the 4 L Sheath Fluid Container

— Cleaning the 4 L Waste Container

 • Nonscheduled Cleaning

— Surface Cleaning and Disinfection

— Preparing the Instrument for Transport or Storage

Routine Cleaning

Daily Clean

Daily Clean should be performed during instrument startup and instrument shutdown to clean the 
sample line. 

After sampling an excessively large sample or a sample that can easily clog the sample probe, it is 
recommended to perform the Daily Clean procedure. Daily Clean can also be used to remove 
residual sample from previous tubes.

1 Open the CytExpert software and confirm that the instrument is connected and that it has 

already been initialized. Refer to Logging Into the Software in CHAPTER 3, Daily Startup.
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Routine Cleaning  
2 Select Daily Clean in the Cytometer menu.

3 Add 2 mL of FlowClean solution to an unused sample tube.

4 Add 3 mL of DI water to an unused sample tube. 
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Cleaning Procedures

Routine Cleaning  10
5 Insert the sample tube with 2 mL of FlowClean solution into the sample holder and select Run. 

NOTE The default cleaning time is 3 minutes.

6 Remove the Flow Clean tube.
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Routine Cleaning  
7 Insert the sample tube with 3 mL of DI water into the sample holder and select Run to perform 

the second step of the cleaning process.

NOTE The default cleaning time is 5 minutes.

8 After the process has been completed, remove the sample tube and close the Daily Clean 

window.
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Routine Cleaning  10
Daily Clean [With Plate Loader]

Daily Clean should be performed during instrument startup and instrument shutdown to clean the 
sample line. 

After sampling an excessively large sample or a sample that can easily clog the sample probe, it is 
recommended to perform the Daily Clean procedure. Daily Clean can also be used to remove 
residual sample from previous tubes.

1 Open the CytExpert software and confirm that the instrument is connected and that it has 

already been initialized. Refer to Logging Into the Software in CHAPTER 3, Daily Startup.

2 Select Daily Clean in the Cytometer menu. The Daily Clean window appears. The plate loader 

automatically ejects the plate holder stage. 
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Cleaning Procedures

Routine Cleaning  
3  Follow the on screen software prompts and select the desired wells for cleaning agent and 

deionized water.

[CytoFLEX LX Shown]

IMPORTANT You must select at least one cleaning solution well and one water well.

a. Select the desired wells for the cleaning agent and select Set As Cleaning Agent Well.

b. Select the desired wells for the deionized water and select Set As Deionized Water Well.

NOTE To deselect water wells, select the desired well and select Set As Empty Well.

c. Select the Turn off cytometer after daily clean checkbox to automatically shutdown the 
cytometer after Daily Clean is finished. [CytoFLEX LX Only]

4 Select Start to start the cleaning procedure. The message Please confirm that the correct plate is 

placed properly and press OK appears. Select OK.

5 Select Close.
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Routine Cleaning  10
Cleaning the Sample Station

Carry out semi-automatic cleaning for the sample injection device once a week.

1 Ensure that the system has been shut down properly. Refer to Shutting Down the Instrument 

in CHAPTER 8, Daily Shutdown. 

WARNING

Risk of chemical injury from bleach. To avoid contact with the bleach, use barrier 

protection, including protective eyewear, gloves, and suitable laboratory attire. 

Refer to the Safety Data Sheet for details about chemical exposure before using 

the chemical.

2 Use a piece of absorbent material with a 10% bleach solution (1 part bleach [5 to 6% sodium 

hypochlorite - available chlorine] with 9 parts DI water) to wipe off all surfaces in the sample 
station, while taking all necessary biological safety precautions.

3 Wipe off the bottom of the semi-automatic sample injection device.
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Routine Cleaning  
 Cleaning the Sample Probe

When problems such as blockage of the sample probe occur, it is required to replace or clean the 
sample probe. 

1 Confirm that the instrument is in the standby state or that the power supply is turned off. 

WARNING

Risk of biohazardous contamination if you have skin contact with the sample 

probe or the sample peristaltic pump tubing. The sample probe and the sample 

peristaltic pump tubing might contain residual biological material and must be 

handled with care. Clean up spills immediately. Dispose of the sample probe and 

the sample peristaltic pump tubing in accordance with your local regulations and 

acceptable laboratory procedures.

2 Remove the sample probe. Refer to Replacing the Sample Probe and/or the Sample Peristaltic 

Pump Tubing in CHAPTER 11, Replacement/Adjustment Procedures.

3 Put the sample probe into a clean container and soak it in clean water. Use an ultrasonic 

cleaning device to clean for 2 minutes. 

4 Reattach the sample probe to the sample peristaltic pump tubing and confirm that the bead on 

the sample probe touches the sleeve on the end of the sample peristaltic pump tubing. 

IMPORTANT To ensure that the proper placement of the sample probe, push the sample pump cover up 

while installing the thumbscrew.

5 Install the sample pump cover. 

6 If ineffective, replace with a new sample probe. Refer to Replacing the Sample Probe and/or the 

Sample Peristaltic Pump Tubing in CHAPTER 11, Replacement/Adjustment Procedures.

Deep Clean Procedure

Carry out a deep clean once a month to clean the instrument flow cell. If the unit will be shutdown 
and not used for more than 10 days, it is recommended to complete one deep clean before resuming 
use. 
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Routine Cleaning  10
1 Place the instrument in standby state. 

2 Remove the right-side cover. Refer to Right-Side Cover Removal and Reinstallation in 

CHAPTER 11, Replacement/Adjustment Procedures.

3 Confirm that the Deep Clean solution volume in the bottle located inside the Fluidics module is 

sufficient.

To prepare and add more Deep Clean solution, refer to Adding the Deep Clean Solution in 
CHAPTER 11, Replacement/Adjustment Procedures.

4 Select Deep Clean in the Cytometer menu. The software message Are you sure to start deep clean? 

appears. Select Yes to start the Deep Clean process in the instrument flow cell.

5 The status bar prompts that a deep clean is under way. Wait for the Deep Clean process to finish. 

The following software message appears:

Select OK.
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Routine Cleaning  
6 Allow the cleaning solution to remain in the flow cell for approximately 30 minutes. If you are 

required to postpone the cleaning time, do not exceed 24 hours. During the Deep Clean cycle, 
the power supply of the unit can be turned off, but the instrument cannot be initialized. 

7 Select Prime in the Cytometer menu. The software message Are you sure to start Prime? appears. 

Select Yes.

8 Run Daily Clean. Refer to Daily Clean.

9 Perform initialization as required (see Initializing the Instrument in CHAPTER 3, Daily Startup) 

to carry out the next experiment or to turn off the instrument. 

10 Reinstall the right-side cover. Refer to Right-Side Cover Removal and Reinstallation in 

CHAPTER 11, Replacement/Adjustment Procedures.

Cleaning the 4 L Sheath Fluid Container

Clean the sheath fluid container once a month. 

1 Confirm that the instrument is turned off or is in the standby state. 

2 Remove the sheath fluid container from the Fluid Container holder.
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Routine Cleaning  10
3 Remove the sheath fluid harness from the sheath fluid container.

4 Empty the residual sheath fluid from the sheath fluid container.

5 Add about 50 to 100 mL of CytoFLEX Sheath Fluid to the sheath fluid container. 

6 Insert the sheath fluid harness back into the sheath fluid container and tightly close the sheath 

fluid container cap. 

7 Swirl the sheath fluid in the sheath fluid container, rinsing all surfaces.

8 Empty the sheath fluid container.

9 Refill the sheath fluid container. Refer to Filling the 4 L Sheath Fluid Container [CytoFLEX] in 

CHAPTER 11, Replacement/Adjustment Procedures.

Cleaning the 4 L Waste Container

Clean the waste container once a month. 

1 Confirm that the instrument is turned off or is in the standby state. 

2 Remove the waste container from the Fluid Container holder.

WARNING

Risk of biohazardous contamination if you have skin contact with the waste 

container, its contents, and its associated tubing. The waste container and its 

associated tubing could contain residual biological material and must be handled 

with care. Clean up spills immediately.

3 Remove the harness from the waste container.
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Routine Cleaning  
WARNING

Risk of biohazardous contamination if you have skin contact with the waste 

container, its contents, and its associated tubing. The waste container and its 

associated tubing could contain residual biological material and must be handled 

with care. Clean up spills immediately. Dispose of the contents of the waste 

container in accordance with your local regulations and acceptable laboratory 

procedures.

4 Empty the waste container.

WARNING

Risk of chemical injury from bleach. To avoid contact with the bleach, use barrier 

protection, including protective eyewear, gloves, and suitable laboratory attire. 

Refer to the Safety Data Sheet for details about chemical exposure before using 

the chemical.

5 Add one liter of sodium hypochlorite solution with 0.5% active chlorine to the waste container. 

6 Insert the waste harness back into the waste container and tightly close the waste container 

cap.

CAUTION

Risk of damage to the sheath fluid harness and/or waste harness. Do not leave the 

sodium hypochlorite solution in the fluid containers longer than 10 minutes.

7 Let stand for 5 to 10 minutes.

WARNING

Risk of chemical injury from bleach. To avoid contact with the bleach, use barrier 

protection, including protective eyewear, gloves, and suitable laboratory attire. 

Refer to the Safety Data Sheet for details about chemical exposure before using 

the chemical.

8 Dispose of the sodium hypochlorite solution in accordance with your local regulations and 

acceptable laboratory procedures.

9 Use deionized water to rinse the waste container and the waste harness. Ensure that there is no 

sodium hypochlorite residue.
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10 Place the waste container back into the Fluid Container holder.

Nonscheduled Cleaning

Surface Cleaning and Disinfection

1 Wipe the CytoFLEX Series label of the instrument clean with water and wipe dry immediately.

2 If you have a plate loader installed on your instrument, remove the front cover. Refer to Front 

Cover Removal and Reinstallation in CHAPTER 11, Replacement/Adjustment Procedures.

3 Wipe the wash collar modules in the single tube station and the plate loader station with 100% 

isopropanol and wipe dry immediately.

4 If you have a plate loader installed on your instrument, reinstall the front cover. Refer to Front 

Cover Removal and Reinstallation in CHAPTER 11, Replacement/Adjustment Procedures.
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Nonscheduled Cleaning  
WARNING

Risk of chemical injury from bleach. To avoid contact with the bleach, use barrier 

protection, including protective eyewear, gloves, and suitable laboratory attire. 

Refer to the Safety Data sheet for details about chemical exposure before using 

the chemical.

5 Prepare a cleaning solution of 1 part high-quality, fragrance-free bleach (5% or 6% solution of 

sodium hyphochlorite - available chlorine) and 9 parts distilled water.

CAUTION

Risk of instrument damage. The instrument label can peel or fade, and the wash 

collar can become brittle and crack over time if these surfaces are wiped clean 

using the bleach solution followed by the 70% ethanol. Do not clean the label or 

the wash collar with the bleach solution followed by the 70% ethanol. Only use the 

specified cleaning methods in Steps 1 and 3 to clean these surfaces.

CAUTION

Risk of personal injury if electronic equipment is used near fumes or flammable 

gases. Ethanol is a flammability hazard. Avoid this risk by never using it in or near 

operating instruments.

6 Wipe down all exposed surfaces with the bleach solution and then 70% ethanol. Pay special 

attention to the Sampling area. 

Be sure to avoid wiping the instrument label and wash collar module with the bleach solution 
and 70% ethanol.

Preparing the Instrument for Transport or Storage

When the instrument is to be transported or is not to be used for 30 days or more, complete the 
emptying processes to prevent instrument damage and to reduce the possibility of biological 
contamination. Contact us if you have any questions.

1 Run the Deep Clean procedure. Refer to Deep Clean Procedure.

2 Run the Daily Clean procedure. Refer to Daily Clean.
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Cleaning Procedures

Nonscheduled Cleaning  10
3 Clean the Sample Station. Refer to Cleaning the Sample Station.

4 Empty the sheath fluid container and the waste container (see Emptying the 4 L Waste 

Container [CytoFLEX] in CHAPTER 11, Replacement/Adjustment Procedures).

5 Clean and disinfect all surfaces. Refer to Surface Cleaning and Disinfection.

WARNING

Risk of biohazardous contamination if you have skin contact with the waste 

container, its contents, and its associated tubing. The waste container and its 

associated tubing could contain residual biological material and must be handled 

with care. Clean up spills immediately. Dispose of the contents of the waste 

container in accordance with your local regulations and acceptable laboratory 

procedures.

6 Clean the sheath fluid container and the waste container. Refer to Cleaning the 4 L Sheath Fluid 

Container. 

7 Remove the right-side cover (see Right-Side Cover Removal and Reinstallation in CHAPTER 11, 

Replacement/Adjustment Procedures).

8 Remove the Deep Clean solution bottle from the bracket, empty the Deep Clean solution bottle, 

and rinse with DI water. Then, attach the Deep Clean solution bottle to the bracket.

9 Remove the Plate Loader module if applicable (see Plate Loader Module Removal and 

Reinstallation [With Plate Loader] in CHAPTER 11, Replacement/Adjustment Procedures).

10 Power down and disconnect all the cables and sheath fluid and waste harnesses.
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Nonscheduled Cleaning  
CAUTION

Risk of instrument damage. The Cytometer can suffer irreparable damage if it is 

exposed to subfreezing temperatures while it still contains liquid. Always drain 

the flow cell after cleaning the Cytometer if the Cytometer will be stored or 

transported in subfreezing temperatures.

WARNING

Risk of contamination from biohazardous material. Always wear PPE when 

performing this procedure as you can contact components with blood residue 

when handling the Fluidics module. Dispose of any absorbent materials used to 

collect or clean up leaks in accordance with the local regulations and acceptable 

laboratory procedures. 

11 Disconnect the blue-labeled tubing from the pneumatic valve PV1 and hold the absorbent 

material under the disconnected tubing to collect any dripping liquid. 

1. PV1

PV2PV3PV1PV5

b
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Cleaning Procedures

Nonscheduled Cleaning  10
12 Disconnect the yellow-labeled tubing connected to the choke to vent the flow cell, allowing it 

to drain. 

13 Verify that liquid has stopped dripping from the blue-labeled tubing. 

NOTE The flow cell is empty when liquid stops dripping from the blue-labeled tubing. 

14 Dispose of the absorbent material used to collect the liquid in accordance with the local 

regulations and acceptable laboratory procedures and cleanup any spills. 

15 Reconnect the blue-labeled tubing to PV1. 

16 Reconnect the yellow-labeled tubing to the choke. 

17 Reinstall the right-side cover (see Right-Side Cover Removal and Reinstallation in CHAPTER 11, 

Replacement/Adjustment Procedures).

18 Ensure that the optical filters are seated properly. 

19 Ensure that the top cover is tightly closed.

1. Choke

PV2PV3PV1PV5

b
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20 If the instrument is to be transported or stored, put the instrument and the Plate Loader 

module (if applicable) into the Beckman Coulter supplied packing and comply with the 
requirements in Instrument Transportation and Storage in CHAPTER A, Instrument 
Installation, regarding correct placement during transportation and storage.

Lifting and Carrying Instructions

1 Position a person on the left and right sides of the Cytometer. 

2 Reach under the base of the Cytometer in the areas indicated by the arrows in the figure below.

3 Gently lift the Cytometer as shown in the figure below.

WARNING

Risk of personal injury. Use caution when lowering the Cytometer to avoid 

pinching fingers.

4 Lower the Cytometer to its designated location. 
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CHAPTER 11

Replacement/Adjustment Procedures

Overview

This chapter describes how to carry out certain routine and nonscheduled maintenance 
procedures. Proper maintenance can help extend the service life of the instrument and ensure 
experimental accuracy. When conducting any maintenance work, take all necessary biosafety 
precautions. 

IMPORTANT In addition to parts specifically discussed, for all replacement parts, use only parts provided by 

Beckman Coulter to ensure proper functioning of the instrument. Never disassemble any part of the 

instrument without prior authorization. Beckman Coulter assumes no responsibility for any instrument 

problems resulting from the use of any part not authorized by Beckman Coulter for use with the 

instrument. 

This chapter contains information on:

 • Routine Replacement/Adjustment

— Front Cover Removal and Reinstallation

— Right-Side Cover Removal and Reinstallation

— Filling the 4 L Sheath Fluid Container [CytoFLEX]

— Replacing the 10 L Sheath Fluid Cubitainer

— Emptying the 4 L Waste Container [CytoFLEX]

— Emptying the 10 L Waste Cubitainer

— Managing the Maintenance Reminder

— Adding the Deep Clean Solution

— Replacing the Sheath Fluid Filter

— Replacing the Sample Probe and/or the Sample Peristaltic Pump Tubing

— Replacing the Sample Probe Assembly [With Plate Loader]

— Changing the Sample Probe from the Single Tube Sample Station to the Plate Loader 
[CytoFLEX With Plate Loader]

— Changing the Sample Probe from the Plate Loader to the Single Tube Sample Station 
[CytoFLEX With Plate Loader]

— Inspecting the Liquid Flow Path for Leaks

— Priming the Flow Cell

— Replacing the Plate Holder [With Plate Loader]

— Plate Loader Module Removal and Reinstallation [With Plate Loader]

— Changing the Event Rate Setting
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Routine Replacement/Adjustment  
 • Nonscheduled Replacement/Adjustment

— Calibrating the Sample Flow Rate

— Calibrating the Sample Flow Rate [With Plate Loader]

— Setting Laser Delay

— Replacing the Optical Filter

— Replacing the Fuse

— Replacing the Sheath Fluid Harness and/or Waste Harness

— Changing Sample Mixing and Backflush Settings

— Calibrating the Plate Position [With Plate Loader]

Routine Replacement/Adjustment

Front Cover Removal and Reinstallation

Removal

WARNING

Risk of personal injury from electric shock caused by contacting exposed 

electronic components. Power down the instrument before removing the front 

cover of the Cytometer.

1 Exit the system software.

2 Turn off the main power switch on the back of the Cytometer.

3 Open the top cover.
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Routine Replacement/Adjustment  11
4 Remove the two screws securing the front cover and pull the front cover forward.

5 Lift the front cover up and out of the slots in the frame.

Reinstallation

1 Slide the tabs on the bottom of the front cover into the slots in the bottom of the frame.

2 Push in the latches on the front cover to retract the pins, push the front cover into place, and 

release the latches to secure the cover.

3 Close the top cover.

1. Securing screws

2. Front cover

CAUTION

CLASS 3B LASER RADIATION WHEN

OPEN AND INTERLOCKS DEFEATED

AVOID EXPOSURE TO BEAM

b

c
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Routine Replacement/Adjustment  
Right-Side Cover Removal and Reinstallation

IMPORTANT The CytoFLEX LX flow cytometer only requires you to unfasten the thumbscrews the first time. 

There is a retaining clip that is used to secure the right-side cover without the need for the thumbscrews, 

if desired. Once the thumbscrews are unfastened, the right-side cover can simply be pulled off of the 

retaining clip for removal and pushed onto the retaining clip for reinstallation. Ensure the top cover is 

open before removing the right-side cover from the retaining clip.

Removal

1 Open the top cover.

1. Thumbscrews

2. Right-side cover

3. Retaining clip

4. Tabs

CAUTION

CLASS  3B LASER   RADIATION WHEN OPEN AND 

INTERLOCKS DEFEATED. AVOID EXPOSURE TO BEAM

PRÉCAUTION

LASER  CLASSE  3B  RADIATION  LASER QUAND

 L ' INSTRUMENT EXT OUVERT ET NON  VERROUILLE

       
ÉVITER   TOUTE  EXPOSITION  AU  FAISCEAU

cb

d

e
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2 Unfasten the two captive thumbscrews for the right-side cover.

3 Lift the right-side cover up and out of the slots in the frame.

Reinstallation

1 Slide the tabs on the bottom of the right-side cover into the slots in the bottom of the frame and 

push the cover into place.

2 Fasten the two captive thumbscrews to secure the right-side cover.

3 Close the top cover.

1. Captive thumbscrews

2. Right-side cover

3. Tabs

CAUTION
CLASS 3B LASER RADIATION WHEN

OPEN AND INTERLOCKS DEFEATED

AVOID EXPOSURE TO BEAM

CAUTIONCLASS 3B LASER RADIATION WHEN
OPEN AND INTERLOCKS DEFEATED

AVOID EXPOSURE TO BEAM

CAUTION
CLASS 3B LASER RADIATION WHEN

OPEN AND INTERLOCKS DEFEATED

AVOID EXPOSURE TO BEAM

d

b

c
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Replacement/Adjustment Procedures

Routine Replacement/Adjustment  
Filling the 4 L Sheath Fluid Container [CytoFLEX]

1 Confirm that the instrument is turned off or is in the standby state.

2 If necessary, remove any cardboard cutouts from the new CytoFLEX Sheath Fluid cubitainer. If 

you do not need a new cubitainer, skip to Step 7.

3 Locate the spigot inside the cardboard cutout.

4 Remove the cap and seal from the new sheath cubitainer. Be sure to completely remove the foil 

seal.

5 Screw on the spigot.

6 Unscrew the sheath fluid harness from the sheath fluid container and place in the fluid sensor 

holder cutout (refer to Figure 1.7.) to prevent contamination of the sheath fluid harness. 

CAUTION

Risk of instrument damage. Remove the sheath fluid container from the Fluid 

Container holder and fill away from the instrument to prevent spills that could 

damage the instrument circuitry.

7 Remove the sheath fluid container from the Fluid Container holder.

8 Hold the Sheath fluid container under the CytoFLEX Sheath Fluid cubitainer ensuring the 

cubitainer is resting on a stable surface.

9 Fill the sheath fluid container.

10 Reinstall the sheath fluid harness onto the sheath fluid container.

11 Place the sheath fluid container back into the Fluid Container holder.
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Routine Replacement/Adjustment  11
Replacing the 10 L Sheath Fluid Cubitainer

1 Confirm that the instrument is turned off or is in the standby state. 

2 If necessary, remove any cardboard cutouts from the new CytoFLEX Sheath Fluid cubitainer.

Remove the cap and seal from the new sheath fluid cubitainer. Be sure to completely remove 
the foil seal.

Cyto FLEX

h Fluid
10 L

Cyto FLEX Sheath Fluid

�������
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Replacement/Adjustment Procedures

Routine Replacement/Adjustment  
CAUTION

Misleading results could occur if you contaminate the sheath fluid. Be careful not 

to contaminate the sheath fluid. Do not let your fingers, paper towels, or other 

objects touch the pickup tube assembly.

3 Unscrew the plastic cap that secures the pickup tube assembly into the old sheath fluid 

cubitainer and lay it on a leakproof disposable container, such as a glove or beaker.

Lift the pickup tube assembly straight up and out.

4 Inspect the pickup tube assembly and replace it if necessary.

REACTIVE INGREDIENTS: Anti-microbial compound

A nonionic, non-flourescent, and azide free sheath fluid 

for use on Beckman Coulter CytoFLEX flow cytometers.

10 L

Cyto FLEX

Sheath Fluid

Cyto FLEX

Sheath Fluid

�������
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Replacement/Adjustment Procedures

Routine Replacement/Adjustment  11
5 Carefully insert the pickup tube assembly straight into the new sheath fluid cubitainer. 

Tighten the cap.

6 Place the 10 L sheath fluid cubitainer to the left of the instrument.

7 Put the cap from the new container onto the old container and dispose of the container 

properly.

REACTIVE INGREDIENTS: Anti-microbial compound

A nonionic, non-flourescent, and azide free sheath fluid 

for use on Beckman Coulter CytoFLEX flow cytometers.

10 L

Cyto FLEX

Sheath Fluid

Cyto FLEX

Sheath Fluid

�������

Cyto
 FL

EX

Sh
eat

h Flu
id10 L

Cyto FLEX Sheath Fluid

�������
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Replacement/Adjustment Procedures

Routine Replacement/Adjustment  
Emptying the 4 L Waste Container [CytoFLEX]

1 Confirm that the instrument is turned off or is in the standby state. 

2 Remove the waste harness (see Figure 1.7). The waste harness from the Cytometer is connected 

to a 4-L waste container. 

3 Remove the waste container from the Fluid Container holder.

WARNING

Risk of biohazardous contamination if you have skin contact with the waste 

container, its contents, and its associated tubing. The waste container and its 

associated tubing might contain residual biological material and must be handled 

with care. Clean up spills immediately. Dispose of the contents of the waste 

container in accordance with your local regulations and acceptable laboratory 

procedures. Use proper personal protective equipment.

4 Empty the waste container. Dispose of the waste in accordance with your local regulations and 

acceptable laboratory procedures.

WARNING

Risk of chemical injury from bleach. To avoid contact with the bleach, use barrier 

protection, including protective eyewear, gloves, and suitable laboratory attire. 

Refer to the Safety Data Sheet for details about chemical exposure before using 

the chemical.

5 Add 400 mL of 5 to 6% bleach to the waste container.

6 Reinstall the waste harness in the waste container.

7 Put the waste container in the Fluid Container holder.
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Emptying the 10 L Waste Cubitainer

1 Confirm that the instrument is turned off or is in the standby state. 

2 Lift the waste cubitainer and swirl it before removing the cap.
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Replacement/Adjustment Procedures

Routine Replacement/Adjustment  
WARNING

Risk of biohazardous contamination if you have skin contact with the waste 

cubitainer, its contents, and its associated tubing. The waste cubitainer and it 

associated tubing might container residual biological material and must be 

handled with care. Clean up spills immediately. Dispose of the contents of the 

waste cubitainer in accordance with your local regulations and acceptable 

laboratory procedures.

3 Unscrew the cap and lay it on a leakproof disposable container, such as a glove or beaker.

4 Empty the waste cubitainer according to your laboratory’s procedures.

NOTE Take proper precautions to avoid spills if you are emptying the waste cubitainer into a sink, drain, 

or larger container. When moving the waste cubitainer to dispose of its contents, be sure the cap is 

secure to avoid spills.
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Replacement/Adjustment Procedures

Routine Replacement/Adjustment  11
WARNING

Risk of chemical injury from bleach. To avoid contact with the bleach, use barrier 

protection, including protective eyewear, gloves, and suitable laboratory attire. 

Refer to the Safety Data Sheet for details about chemical exposure before using 

the chemical.

5 Put about 1 L of high-quality, fragrance-free, gel-free bleach (5 to 6% solution of sodium 

hypochlorite -available chlorine) in the 10-L waste cubitainer to cover the bottom of the 
cubitainer.

6 Replace the cap on the new waste cubitainer and securely tighten.

NOTE Properly dispose of the leakproof disposable container used in Step 3 after you screw the cap 

back on the waste container.

NaClO
(5-6%)
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Managing the Maintenance Reminder

The maintenance reminder tracks the last maintenance date and initiates a reminder to complete 
maintenance for the following three items:

 • Refill Deep Clean solution bottle (cleaning solution)

 • Replace sheath fluid filter

 • Replace sample peristaltic pump tubing

When reagents or parts have reached the designated use time limit in either days or number of uses, 

the Maintenance Message icon  appears 
in the right side of the status bar.

1 Select the Maintenance Message icon  from the status bar to access the 

Maintenance window. The expired item appears with a warning triangle  to the left of the 
item listed. 

Or

Select Maintenance in the Advanced menu. The Maintenance window appears. The expired 

item is displayed with a warning triangle  to the left of the item listed. 

2 Select the desired item to manage, then choose one of the following:

 • To manage refilling the Deep Clean solution bottle, go to Step 3.

 • To manage replacing the sheath filter, skip to Step 4.

 • To manage replacing the sample peristaltic pump tubing, skip to Step 5.
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3 Select Detail. The Refill Deep Clean Solution Bottle window appears.

Select Refill. A pop-up window appears to reset the maintenance date as the current date that 
the maintenance was performed.

4 Select Detail. The Replace Sheath Fluid Filter window appears.
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Select Replace. A pop-up window appears to reset the maintenance date as the current date that 
the maintenance was performed.

5 Select Detail. The Replace Peristaltic Pump Tubing window appears.

Select Replace. A pop-up window appears to reset the maintenance date as the current date that 
the maintenance was performed.
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Adding the Deep Clean Solution

Check occasionally whether the Deep Clean solution in the Deep Clean solution bottle is sufficient. 
Replace the Deep Clean solution when the maintenance reminder prompts you to do so. 

WARNING

Risk of chemical injury from Contrad® 70 reagent. To avoid contact with the 

Contrad® 70 reagent, use barrier protection, including protective eyewear, 

gloves, and suitable laboratory attire. Refer to the Safety Data Sheet for details 

about chemical exposure before using the chemical.

1 Make 60 mL of Deep Clean solution by mixing 30 mL of Contrad® 70 and 30 mL DI water in the 

Deep Clean solution bottle and swirl the solution gently to create the Deep Clean solution.

2 Verify that the Cytometer is in standby state or is turned off. 

3 Remove the right-side cover of the instrument. Refer to Right-Side Cover Removal and 

Reinstallation.

4 Remove the Deep Clean solution bottle and open the cap.

5 Add 60 mL Deep Clean solution to the bottle.
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6 Tighten the cap, and attach the Deep Clean solution bottle to the bracket.

7 Reinstall the right-side cover (see Right-Side Cover Removal and Reinstallation), and fasten the 

thumbscrews.

8 Reset the maintenance reminder tracker. Refer to Managing the Maintenance Reminder.

Replacing the Sheath Fluid Filter

It is recommended to replace the sheath fluid filter every six months when the maintenance 
reminder prompts you to do so. The life of the filter is related to the quality of the sheath fluid used. 
If it is found that there are impurities in the light scatter pattern, replace the sheath fluid filter. 

1 Select Standby on the left of the screen to place the instrument in standby state, or shut off the 

Cytometer's power. 

2 Remove the right-side cover. Refer to Right-Side Cover Removal and Reinstallation.
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3 Press the spring piece on the quick connector and the Cytometer on the upper side of the filter, 

and disconnect the quick connector.

4 Repeat Step 3 for the quick connector behind the quick connector removed in the previous 

step.

NOTE The spring is on the opposite side.

5 Remove the sheath fluid filter from the bracket.

6 Connect the new, unused filter using the quick connector springs.

c

B
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7 Attach the filter to the filter bracket.

8 Remove the vent cap and set it aside.

9 Turn on the Cytometer and open the software.

10 Select Prime in the Cytometer menu.
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CAUTION

Risk of instrument damage. If the vent cap is not sealed tightly, unstable flow rate 

and leakage of the sheath fluid can occur.

11 Observe the liquid level in the filter during the prime cycle. When the liquid level reaches the 

upper section of the filter, reinstall the vent cap to prevent air leakage.

12 Reinstall the right-side cover (see Right-Side Cover Removal and Reinstallation) and lock the 

screw.

13 If the problem persists, contact us.

14 Run the system startup program. Refer to Running the System Startup Program [with the Single 

Tube Loader] in CHAPTER 3, Daily Startup.

15 Reset the maintenance reminder tracker. Refer to Managing the Maintenance Reminder.
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Replacing the Sample Probe and/or the Sample Peristaltic Pump Tubing

WARNING

Risk of biohazardous contamination if you have skin contact with the sample 

probe or the sample peristaltic pump tubing. The sample probe and the sample 

peristaltic pump tubing could contain residual biological material and must be 

handled with care. Clean up spills immediately. Dispose of the sample probe and 

the sample peristaltic pump tubing in accordance with your local regulations and 

acceptable laboratory procedures.

IMPORTANT If you need to replace the single tube sample probe assembly and you have the CytoFLEX 

Sample Injection Mode Control Kit installed on your CytoFLEX Series instrument, pull the probe out of the 

CytoFLEX Sample Injection Mode Control Kit and push the new probe into place.

IMPORTANT If you need to replace the single tube sample probe assembly and you have the Sample 

Injection Mode Control Kit installed on your CytoFLEX Series instrument, pull the probe out of the 

CytoFLEX Sample Injection Mode Control Kit and push the new probe into place.

It is recommended to replace the tubing of the sample peristaltic pump every six months, or sooner, 
if your lab has a high sample volume, as tubing used for an excessively long time can cause 
degradation of the stability of the sample flow and increase of the CV detected.

NOTE Ensure you replace the sample probe with a sample probe that has the same color jewel.

1 Place the instrument in standby state.

2 Remove the right-side cover. Refer to Right-Side Cover Removal and Reinstallation.

3 Remove the front cover. Refer to Front Cover Removal and Reinstallation.
B49006AM   11-22



Replacement/Adjustment Procedures

Routine Replacement/Adjustment  11
4 Remove the sample pump cover thumbscrew and the sample pump cover.

[Without Sample Injection Mode Control Kit]

[With Sample Injection Mode Control Kit]
B49006AM   11-23



Replacement/Adjustment Procedures

Routine Replacement/Adjustment  
5 Take out the sample peristaltic pump tubing.

[Without Sample Injection Mode Control Kit]

[With Sample Injection Mode Control Kit]
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Routine Replacement/Adjustment  11
CAUTION

Risk of optical misalignment. Removing the PEEK tubing from the bottom of the 

flow cell could cause misalignment of the optical components. Do not remove the 

PEEK tubing from the bottom of the flow cell.

6 Remove the sample PEEK tubing from the sample peristaltic pump tubing.

[Without Sample Injection Mode Control Kit]

[Without Sample Injection Mode Control Kit]: Proceed to Step 7.

[With Sample Injection Mode Control Kit]

[With Sample Injection Mode Control Kit]: Skip to Step 9.
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7 [Without Sample Injection Mode Control Kit]: Lift the sample probe out of the wash station.

8 [Without Sample Injection Mode Control Kit]: Remove the sample peristaltic pump tubing from 

the sample probe.

Skip to Step 10.
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9 [With Sample Injection Mode Control Kit]: Remove the sample probe from the metal block if you 

need replace the sample probe.

Proceed to Step 10.

10 Dispose of the old sample probe and/or sample peristaltic pump tubing in accordance with 

your local regulations and acceptable laboratory procedures.

[Without Sample Injection Mode Control Kit]: Proceed to Step 11.

[With Sample Injection Mode Control Kit]: Skip to Step 13.

11  [Without Sample Injection Mode Control Kit]: Connect the sample peristaltic pump tubing to the 

sample probe.
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12  [Without Sample Injection Mode Control Kit]: Connect the sample PEEK tubing to the sample 

peristaltic pump tubing.

13 [With and Without Sample Injection Mode Control Kit]: Slide the sample probe into the wash 

station.

[Without Sample Injection Mode Control Kit]: Skip to Step 15.

[With Sample Injection Mode Control Kit]: Proceed to Step 14.
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14 [With Sample Injection Mode Control Kit]: Connect the sample probe to the metal block.

Proceed to Step 15.

15 Install the sample peristaltic pump tubing, taking care not to use any sharp tools, ensuring that 

the tube is fully inserted into the groove.

NOTE You can use the sample pump cover thumbscrew to install the sample peristaltic pump tubing.

[Without Sample Injection Mode Control Kit]

[Without Sample Injection Mode Control Kit]: Skip to Step 17.
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[With Sample Injection Mode Control Kit]

[With Sample Injection Mode Control Kit]: Proceed to Step 16.

16 [With Sample Injection Mode Control Kit]: Connect the PEEK tubing to the sample peristaltic 

pump tubing.

Proceed to Step 17.
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17 Install the sample pump cover.

[Without Sample Injection Mode Control Kit]

[With Sample Injection Mode Control Kit]

NOTE To ensure the proper placement of the sample probe, push the sample pump cover up while 

installing the thumbscrew.

[With and Without Sample Injection Mode Control Kit]: Proceed to Step 18.

18 Reinstall the right-side cover (see Right-Side Cover Removal and Reinstallation), and lock with 

the screw.
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Replacing the Sample Probe Assembly [With Plate Loader]

IMPORTANT If you have the sample injection mode control kit installed on your CytoFLEX Series instrument, 

contact us to replace the sample probe assembly.

IMPORTANT If you have the Sample Injection Mode Control Kit installed on your CytoFLEX Series 

instrument, contact us to replace the sample probe assembly.

WARNING

Risk of biohazardous contamination if you have skin contact with the sample 

probe or the sample peristaltic pump tubing. The sample probe and the sample 

peristaltic pump tubing could contain residual biological material and must be 

handled with care. Clean up spills immediately. Dispose of the sample probe and 

the sample peristaltic pump tubing in accordance with your local regulations and 

acceptable laboratory procedures.

1 Turn the Cytometer's main power switch off.

2 Remove the right-side cover. Refer to Right-Side Cover Removal and Reinstallation in 

CHAPTER 11, Replacement/Adjustment Procedures.

3 Remove the front cover. Refer to Front Cover Removal and Reinstallation in CHAPTER 11, 

Replacement/Adjustment Procedures.
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4 Remove the sample pump cover thumbscrew and the sample pump cover.

CAUTION

Risk of optical misalignment. Removing the PEEK tubing from the bottom of the 

flow cell could cause misalignment of the optical components. Do not remove the 

PEEK tubing from the bottom of the flow cell.

5 Remove the plate loader PEEK tubing from the sample peristaltic pump tubing.
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CAUTION

The plate loader PEEK tubing can be deformed, which could affect sample flow. 

When routing the plate loader PEEK tubing to and from the Sample Station, be 

careful not to pinch, crimp, stretch, or break the tubing.

6 Pull the plate loader PEEK tubing through the slot so the tubing sits inside the instrument.

7 Loosen the white plastic thumbscrew behind the plate loader sample probe.
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8 Lift the plate loader sample probe assembly straight up to remove it from the probe holder.

9 Align the tongue on the plate loader sample probe assembly with the groove in the probe 

holder and slide the probe down until it is flush with the probe holder.
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10 Tighten the white plastic thumbscrew.

CAUTION

The plate loader PEEK tubing can be deformed which could affect sample flow. 

When routing the plate loader PEEK tubing to and from the Sample Station, be 

careful not to pinch, crimp, stretch, or break the tubing.

11 Slide the new plate loader PEEK tubing through the slot into the single tube sample station area.

Screw
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12 Connect the sample peristaltic pump tubing to the plate loader PEEK tubing.

13 Install the sample pump cover.

NOTE To ensure the proper placement of the sample probe, push the sample pump cover up while 

installing the thumbscrew.

14 Reinstall the right-side cover (refer to Right-Side Cover Removal and Reinstallation in 

CHAPTER 11, Replacement/Adjustment Procedures), and lock with the screw.

15 Close the top cover.
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16 Turn the Cytometer's main power switch on.

Changing the Sample Probe from the Single Tube Sample Station to the Plate 

Loader [CytoFLEX With Plate Loader]

WARNING

Risk of biohazardous contamination if you have skin contact with the sample 

probe or the sample peristaltic pump tubing. The sample probe and the sample 

peristaltic pump tubing could contain residual biological material and must be 

handled with care. Clean up spills immediately.

NOTE If you have the Sample Injection Mode Control Kit installed on your CytoFLEX or CytoFLEX LX, refer to 

Switching the Sample Probe from the Single Tube Sample Station to the Plate Loader [With Sample 

Injection Mode Control Knob] in APPENDIX C, Sample Injection Mode Control Kit for instructions on 

switching between single tube mode and plate loader mode.

NOTE If you have the Sample Injection Mode Control Kit installed on your CytoFLEX Series instrument, refer 

to Switching the Sample Probe from the Single Tube Sample Station to the Plate Loader [With Sample 

Injection Mode Control Knob] in APPENDIX C, Sample Injection Mode Control Kit for instructions on 

switching between the single tube mode and the plate loader mode.

1 Switch to the Plate Loader sample injection mode. Refer to Selecting the Plate Loader Sample 

Injection Mode [With Plate Loader] in CHAPTER 3, Daily Startup.

2 Lift the top cover.

3 Remove the right-side cover. Refer to Right-Side Cover Removal and Reinstallation in 

CHAPTER 11, Replacement/Adjustment Procedures.

4 Remove the front cover. Refer to Front Cover Removal and Reinstallation in CHAPTER 11, 

Replacement/Adjustment Procedures.
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5 Remove the sample pump cover thumbscrew and the sample pump cover.

6 Remove the sample probe from the single tube sample station.
B49006AM   11-39



Replacement/Adjustment Procedures

Routine Replacement/Adjustment  
7 Place the sample probe in the white clip located on the right side of the sample station.
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CAUTION

The plate loader PEEK tubing can be deformed which could affect sample flow. 

When removing the plate loader PEEK tubing from the white clips, be careful not 

to pinch, crimp, stretch, or break the tubing.

8 Remove the plate loader PEEK tubing from the two white clips located at the top of the sample 

station.
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9 Connect the plate loader PEEK tubing to the sample peristaltic pump tubing.

10 Reinstall the sample pump cover.

NOTE To ensure the proper placement of the sample probe, push the sample pump cover up while 

installing the thumbscrew.

11 Reinstall the right-side cover (refer to Right-Side Cover Removal and Reinstallation in 

CHAPTER 11, Replacement/Adjustment Procedures), and lock with the screw.

12 Close the top cover.
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13 Turn the Cytometer's main power switch on.

Changing the Sample Probe from the Plate Loader to the Single Tube Sample 

Station [CytoFLEX With Plate Loader]

WARNING

Risk of biohazardous contamination if you have skin contact with the sample 

probe or the sample peristaltic pump tubing. The sample probe and the sample 

peristaltic pump tubing could contain residual biological material and must be 

handled with care. Clean up spills immediately.

NOTE If you have the Sample Injection Mode Control Kit installed on your CytoFLEX or CytoFLEX LX, refer to 

Switching the Sample Probe from the Plate Loader to the Single Tube Sample Station [With Sample 

Injection Mode Control Knob] in APPENDIX C, Sample Injection Mode Control Kit for instructions on 

switching between single tube mode and plate loader mode.

NOTE If you have the Sample Injection Mode Control Kit installed on your CytoFLEX Series instrument, refer 

to Switching the Sample Probe from the Plate Loader to the Single Tube Sample Station [With Sample 

Injection Mode Control Knob] in APPENDIX C, Sample Injection Mode Control Kit for instructions on 

switching between the single tube mode and the plate loader mode.

1 Switch to either the Semi-Automatic or manual sample injection mode. Refer to Selecting the 

Proper Sample Injection Mode in CHAPTER 3, Daily Startup.

2 Lift the top cover.

3 Remove the right-side cover. Refer to Right-Side Cover Removal and Reinstallation in 

CHAPTER 11, Replacement/Adjustment Procedures.

4 Remove the front cover. Refer to Front Cover Removal and Reinstallation in CHAPTER 11, 

Replacement/Adjustment Procedures.
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5 Remove the sample pump cover thumbscrew and the sample pump cover.

6 Remove the plate loader PEEK tubing from the sample peristaltic pump tubing.
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CAUTION

The plate loader PEEK tubing can be deformed, which could affect sample flow. 

When placing the plate loader PEEK tubing in the white clips, be careful not to 

pinch, crimp, stretch, or break the tubing.

7 Place the plate loader PEEK tubing in the two white clips located at the top of the sample 

station.
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8 Remove the sample probe from the white clip located on the right side of the sample station.

9 Connect the sample probe to the sample peristaltic pump tubing.
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10 Run Daily Clean in CHAPTER 10, Cleaning Procedures.

Inspecting the Liquid Flow Path for Leaks

WARNING

The liquid flow tubing can aged and cracked or the connector can be loosened. 

Liquid leakage can lead to biological harm. To reduce occurrence of such 

problems, carry out liquid flow tubing inspection every six months and ensure that 

the Fluidics module functions without any leaks. If any leaks are found when using 

the Cytometer, stop the experiment immediately and look for the source of the 

leak. 

1 Remove the right-side cover of the instrument. Refer to Right-Side Cover Removal and 

Reinstallation.

2 Perform instrument initialization to enable the sheath fluid to flow. Refer to Initializing the 

Instrument in CHAPTER 3, Daily Startup.

3 Check the connectors and tubes in the Fluidics module, and check whether any liquid leaks out. 

4 Check the sheath fluid, backflush, and waste liquid connector on the back of the Cytometer, and 

check whether any liquid leaks out. 

5 Place the instrument in standby state, complete the priming procedure, and check whether the 

Fluidics module has any liquid leakage. 

6 If any liquid leaks out and the point of liquid leakage is from the filter, try to tighten the filter 

connector and check again. If the problem persists, replace the sheath fluid filter. 

7 If any liquid leaks out from any other connector or tube, stop running the instrument and 

contact us. 
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Priming the Flow Cell

Priming of the flow cell is required when:

 • The instrument is not used for a long period of time.

 • The sheath fluid is refilled.

 • The instrument is being used for the first time.

 • The signal of the instrument is poor or the signal drifts.

 • The sheath filter is replaced.

1 Ensure that the instrument is in standby state.

NOTE If the instrument is not already in the standby state, select Standby from the Cytometer Menu or 

select Standby in the Data Acquisition Control screen.

2 Select Prime from the Cytometer Menu to prime the flow cell. Wait for the beep and for the 

Instructions window to close. 

Otherwise, look for the status bar to display that priming has completed.

3 Run Daily Clean to clean the sample line. Refer to Daily Clean in CHAPTER 10, Cleaning 

Procedures
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Replacing the Plate Holder [With Plate Loader]

Figure 11.1  Plate Holder Stage (Standard Plate Loader)

1. Pins

2. Position A1

c

b
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Figure 11.2  Plate Holder Stage (Plate Loader DW)

CAUTION

The plate holder must be secured tightly to the plate holder stage with position 

A1 located in the top, left corner of the plate holder stage (refer to Figure 11.1 and 

Figure 11.2) to prevent instrument damage.

Slide the notches on the bottom of the plate holder (refer to Figure 1.17) over the pins (refer to 
Figure 11.1, and Figure 11.2).

1. Position A1

2. Spring lock

c

b
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Plate Loader Module Removal and Reinstallation [With Plate Loader]

WARNING

Risk of contamination from biohazardous material. Always wear PPE when 

performing this procedure as you can contact components with blood residue.

Removal

1 Power down the instrument and disconnect the power cable from the wall.

2 Lift the top cover and remove the front cover. Refer to Front Cover Removal and Reinstallation.

3 Place absorbent material on the stage in the Plate Loader module.
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4 In the Sample Station, disconnect that end of the plate loader PEEK tubing.

 • If the plate loader PEEK tubing is attached to the sample peristaltic pump tubing, remove 
the sample pump cover and disconnect the plate loader PEEK tubing.
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 • If the plate loader PEEK tubing is in the plate loader PEEK tubing clips, remove the tubing 
from the clips. 

CAUTION

The PEEK tubing can be deformed which could affect sample flow. When routing 

the Plate Loader PEEK tubing to and from the Sampling Station, be careful not to 

pinch, crimp, stretch, or break the tubing.

5 Pull the plate loader PEEK tubing through the slot so the tubing sits inside the instrument.
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6 Remove the red and black marked tubes that are attached to the left and right connectors in 

the Plate Loader module, respectively, as shown in Figure 11.3.

Figure 11.3  Removing the Tubings from the Fluidics Module to the Plate Loader

1. Red

2. Black

Screw
c

b
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7 Remove the two countersunk M4 x 10 Phillips-head screws in the Plate Loader module. Refer to 

Figure 11.4.

Figure 11.4  Plate Loader Module Securing Screws

8 Slide the Plate Loader module out of the Cytometer. Refer to Figure 11.5.

Figure 11.5  Removing the Plate Loader from the Cytometer

Installation

1 Remove the front cover. Refer to Front Cover Removal and Reinstallation.

1. Securing screws

b
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2 Remove the right-side cover. Refer to Right-Side Cover Removal and Reinstallation.

3 Slide the Plate Loader module in to the Cytometer. Refer to Figure 11.6.

Figure 11.6  Installing the Plate Loader in to the Cytometer

4 Install the two countersunk M4 x 10 Phillips-head screws in the Plate Loader module. Refer to 

Figure 11.7.

Figure 11.7  Plate Loader Module Securing Screws

1. Securing screws

b
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5 Install the red and black marked tubings that are attached to the left and right connectors in 

the Plate Loader module, respectively, as shown in Figure 11.8.

Figure 11.8  Connecting the Tubings from the Fluidics Module to the Plate Loader

1. Red

2. Black

Screw
c

b
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CAUTION

The PEEK tubing can be deformed, which could affect sample flow. When routing 

the Plate Loader PEEK tubing to and from the Sampling Station, be careful not to 

pinch, crimp, stretch, or break the tubing.

6 Slide the new plate loader PEEK tubing through the slot into the single tube sample station area.

7 Remove the sample pump cover thumbscrew and the sample pump cover.

Screw
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8 Connect the plate loader PEEK tubing to the sample peristaltic pump tubing.

9 Reinstall the sample pump cover.

NOTE To ensure the proper placement of the sample probe, push the sample pump cover up while 

installing the thumbscrew.

10 Replace the right-side cover (refer to Right-Side Cover Removal and Reinstallation in 

CHAPTER 11, Replacement/Adjustment Procedures), and lock with the screw.

11 Replace the front cover. Refer to Front Cover Removal and Reinstallation.
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12 Close the top cover.

13 Turn the Cytometer's main power switch on.

14 Verify that the system is operating correctly by running QC in the Plate Loader mode. Refer to 

Preparing the QC Sample [With Plate Loader] and Collecting QC Data [With Plate Loader] in 
CHAPTER 4, Instrument Quality Control and Standardization.

Changing the Event Rate Setting

The Event Rate Setting adjusts the collection setting around signal measurement so that the system 
is able to optimize the acquisition of events ensuring optimal sensitivity and abort rates when 
acquiring at higher event rates.

1 Select Event Rate Setting in the Advanced menu. The Event Rate Setting window appears.

2 Select High if the event rate is >10,000 events/second.

Or

Select Default if the event rate is <10,000 events/second.

3 Select OK.
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Nonscheduled Replacement/Adjustment

Calibrating the Sample Flow Rate

Calibrate the sample flow rate: 

 • After replacing the sample peristaltic pump tubing.

 • If a precise volumetric measurement is required. 

The accuracy of concentration calculations can be affected by the sample flow rate.

1 Verify that the instrument is in the initialized state.

2 Select Calibrate Sample Flow Rate in the Cytometer menu.
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3 Select the flow rate to be calibrated. 

If you want to calibrate all flow rates at once, fast calibration is recommended. The rate selected 
in the Calibrate Sample Flow Rate window overrides the rate selected in the Acquisition 
window.

4 Prepare one sample tube with 1 mL of clean deionized water then use a calibrated analytical 

balance to measure the weight of the prepared sample tube. Record the weight and enter it into 
the software. 

NOTE The weight section accepts up to four decimal places.

5 Select Next and put the sample tube in the sample loading position (see Figure 1.12).
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6 Select Initialize to start the sample run. 

7 Select Run to begin acquiring the sample.
B49006AM   11-63



Replacement/Adjustment Procedures

Nonscheduled Replacement/Adjustment  
8 Wait for the sample run to finish, remove the sample tube, and use the analytical balance to 

measure the weight and record the value. 

9 Select Next to determine if the results fall within the acceptable range. 

If the results fall within the acceptable range, the current setting is kept. 

If deviation occurs, the setting is automatically corrected. 
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Calibrating the Sample Flow Rate [With Plate Loader]

Calibrate the sample flow rate: 

 • After replacing the sample peristaltic pump tubing.

 • If a precise volumetric measurement is required. 

The accuracy of concentration calculations can be affected by the sample flow rate.

1 Verify that the instrument is in the initialized state.

2 Select Calibrate Sample Flow Rate in the Cytometer menu. The plate loader automatically ejects 

the plate holder stage. 
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3 Select the sampling speed that needs to be calibrated and select Calibrate. The Calibrate Sample 

Flow Rate window appears.

4 Follow the on-screen software prompts, then weigh the sample plate.

5 Enter the weight of the sample plate and set the acquisition time.

NOTE Do not exceed three minutes when using the fast sampling rate.
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6 Select Plate Settings to set the sample well and plate type.

7 Select OK to save the settings.

8 Select Next to proceed to the next step. The plate loader automatically ejects the plate holder 

stage. 

9 Place the sample plate onto the plate loader.

10 Verify the settings and select Load to load the plate.
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11 Select Run. The message Please confirm that the correct plate is placed properly and press OK 

appears. Select OK. The system begins acquiring the sample.

12 The plate loader automatically ejects the plate holder stage after the sample is acquired. Weigh 

the plate.

13 Enter the remaining weight value and select Next to confirm the calibration.
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14 Select OK.

Setting Laser Delay

Laser delay is preset for QC. Only change the laser delay if the software prompts you that there is a 
difference in the actual delay and the default delay.

1 Select Delay Setting from the Advanced menu. The Delay Setting window appears.

2 Set the current to the actual delay for the specified detector stated in the error message 

received.

3 Select Set as Default. 
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4 Select Close.

Replacing the Optical Filter

When the optical filter is damaged or it is required to use an optical filter with a non-standard 
wavelength, you must replace the optical filter yourself. For the specific part number of the optical 
filter, consult your Beckman Coulter Representative or your local dealer. 

1 Confirm that the instrument is in the standby state or that the instrument is turned off. 

2 Confirm the laser corresponds to the channel in which the optical filter is to be replaced.

3 Open the top cover of the instrument.

4 Press the spring piece of the WDM cap corresponding to the laser, and open the WDM cap. 
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CAUTION

Risk of damage to the optical filter. Do not touch the optical filter glass piece. 

Touching the optical filter glass piece can obscure and/or scratch the optical filter 

glass piece.

CAUTION

Risk of damage to the optical filter. Pull the filter straight up when removing it 

from the WDM. Removing the filter at an angle could chip the edge of the filter 

glass.

5 Use vertical force to remove the optical filter to be replaced, and note the color identification 

and wavelength identification on the optical filter bracket.

CAUTION

Risk of damage to the optical filter. Push the filter straight down when inserting it 

into the WDM. Inserting the filter at an angle could chip the edge of the filter glass.

6 Insert the optical filter to be installed vertically into the corresponding position, taking care to 

align the wavelength identification with the left, and that the bracket is inserted into the 
bottom. 
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7 Close the WDM cap and the instrument top cover. 

8 Turn on the Cytometer and open the software. 

9  Select Detector Configuration in the Cytometer menu and create a new instrument 

configuration based on the settings of the new optical filter. Refer to Verifying, Selecting, 
Editing, and Creating Detector Configuration in CHAPTER 5, Data Acquisition and Sample 
Analysis.

Set this new configuration as the current configuration.

Replacing the Fuse

Use a 5 A, time delay, T 5 AL, 250 VAC fuse.

WARNING

Risk of personal injury. A shock hazard exists if the power cable is connected. Turn 

off the Cytometer and disconnect the primary power cable before performing 

these procedures.

1 Turn off the Cytometer, and disconnect the power cable.
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2 Press both sides of the fuse holder of the instrument inwards using a flat head screwdriver, and 

pull out the fuse holder. 

IMPORTANT Select well-performing products that comply with the specifications required, to ensure that 

the instrument can function normally and safely. 

3 Check whether the fuse installed is blown, and replace the blown fuse with a new one.

The specifications of the fuse required are: T 5 AL 250 VAC, delay blow fuse, 5A, 250 VAC, 
5 x 20 mm. Beckman Coulter recommends using SCHURTER 0034.3124. 

4 Insert the fuse holder.
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5 Reconnect the power cable.

Replacing the Sheath Fluid Harness and/or Waste Harness

Replace the sheath fluid harness and/or the waste harness if you have a faulty sheath fluid sensor 
and/or waste sensor.

1 Confirm that the instrument is turned off or is in the standby state. 

2 Remove sheath and/or waste pickup tubing from the appropriate container.

3 Disconnect the blue harness (1) from the sheath fluid container (2) and/or the yellow harness 

(3) from the waste container (4) from the fluid connector panel (5) on the back right corner of 
the instrument according to the color code.

CLASS 1 LASER PRODUCT
COMPLIES WITH 21 CFR 1040.10 AND 1040.11
EXCEPT FOR DEVIATIONS PURSUANT TO
LASER NOTICE NO. 50 DATED JUNE 24, 2007
MANUFACTURED 

SNSN

Sheath SheathWaste

b

c

d

e

f
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Disconnect the waste (1) and/or sheath (2) level sensors.

4 Dispose of the sheath fluid harness and/or the waste harness according to your laboratory 

procedures.

5 Insert the new sheath and/or waste pickup tubing into the appropriate container.

6 Connect the blue harness (1) from the sheath fluid container (2) and/or the yellow harness (3) 

from the waste container (4) to the fluid connector panel (5) on the back right corner of the 
instrument according to the color code.

b c

CLASS 1 LASER PRODUCT
COMPLIES WITH 21 CFR 1040.10 AND 1040.11
EXCEPT FOR DEVIATIONS PURSUANT TO
LASER NOTICE NO. 50 DATED JUNE 24, 2007
MANUFACTURED 

SNSN

Sheath SheathWaste

b

c

d

e

f
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Connect the waste (1) and/or sheath (2) level sensors.

Changing Sample Mixing and Backflush Settings

WARNING

Risk of biohazardous contamination. Enabling sample mixing for 1.5-mL and 2-mL 

sample tubes in the semi-automatic sample injection mode can result in sample 

splashing. Exceeding 300-μL sample volume when using 1.5-mL and/or 2-mL 

sample tubes can also result in sample splashing. Disable sample mixing in the 

semi-automatic sample injection mode when using 1.5-mL and 2-mL sample tubes 

and do not exceed 300-μL sample volume.

The sample mixer can be enabled or disabled if necessary. The sample mixing duration can also be 
increased or decreased if necessary.

Whenever a sample is likely to leave residue or cause contamination, the backflush time can be 
increased to reduce cross contamination.

1 Open the CytExpert software and confirm that the instrument is connected. Refer to Logging 

Into the Software in CHAPTER 3, Daily Startup. 

b c
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2 Select Cytometer Configuration in the Cytometer menu. The Cytometer Configuration window 

appears.

3 Select the Sample Mixing checkbox to enable sample mixing. 

Or

Deselect the Sample Mixing checkbox to disable sample mixing.

4 Change the sample mixing duration to the desired time. 

NOTE The default setting is 1 second. Select Default to set the Cytometer configuration settings back 

to the factory default settings.

5 Change the backflush duration to the desired time for either the Manual/Semi-Automatic 

sample injection mode or the Plate Loader sample injection mode depending on the current 
sample injection mode selected.

NOTE The default setting is 3 seconds without the Sample Injection Control Kit installed or 4 seconds 

with the Sample Injection Control Kit installed. Select Default to set the Cytometer configuration 

settings back to the factory default settings.

NOTE The default setting is 3 seconds without the Sample Injection Mode Control Kit installed or 4 

seconds [CytoFLEX and CytoFLEX S] or 6 seconds [CytoFLEX LX] with the Sample Injection Mode 

Control Kit installed. Select Default to set the Cytometer configuration settings back to the factory 

default settings.
B49006AM   11-77



Replacement/Adjustment Procedures

Nonscheduled Replacement/Adjustment  
6 Select OK.

Calibrating the Plate Position [With Plate Loader]

Use the following procedure to calibrate the plate position and the sample probe position:

 • Upon installation

 • After a new plate type is defined for first use

 • After changing plate manufacturers of the same previously calibrated plate type

 • When optimizing plate performance

1 Remove the front cover. Refer to Front Cover Removal and Reinstallation in CHAPTER 11, 

Replacement/Adjustment Procedures.

2 Select .
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3 Select Plate Type Library in the Advanced menu. The plate loader automatically ejects the plate 

holder stage and the Plate Type Library window appears.

NOTE The 96-well deep well plate is only available for use if the Plate Loader DW is installed.

[Standard 96-Well Plate]: Proceed to Step 4.

[96-Well Deep Well Plate]: Skip to Step 5.

4 [Standard 96-Well Plate]: Select the plate type and place the plate on the plate holder. Skip to 

Step 11.

[Standard 96-Well Plate in the Plate Holder (Standard Plate Loader -Without groove)]

A1
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[Standard 96-Well Plate in the Plate Holder (Plate Loader DW -With groove)]

NOTE Ensure plate well A1 aligns with position A1.

5 [96-Well Deep Well Plate]: Select the 96-Well Deep Well plate type. 

6 [96-Well Deep Well Plate]: Place a 96-well deep well plate into the calibration frame.

NOTE Ensure plate well A1 aligns with position A1.

NOTE The calibration frame and the transparent plate are used to assist the calibration in X-axis and 

Y-axis. They are delivered together with the Plate Loader DW.

A1

A1
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7 [96-Well Deep Well Plate]: Turn the calibration frame together with the deep well plate upside 

down. Push the right corner of the frame into place against the lower right corner of the plate.

NOTE Ensure the deep well plate is correctly placed into the calibration frame.

8 [96-Well Deep Well Plate]: Place the transparent plate on the frame.

NOTE Ensure the A1 of the transparent plate aligns with position well A1.

A1
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9 [96-Well Deep Well Plate Shown]: Mark the center position of well A1, A12, H1, H12 on the 

transparent plate. 

10 [96-Well Deep Well Plate]: Place the transparent plate on the plate holder stage. 

NOTE Ensure plate well A1 aligns with position A1.

11 Select Edit to access the calibrate icon. The Edit Plate Type window appears. 

X

X

X

X

A1

X

X X

X
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[Standard 96-Well Plate]

[96-Well Deep Well Plate]

NOTE You can access the calibrate icon by either adding a plate or duplicating a plate. Refer to Plate 

Type Library in CHAPTER 2, Using the CytExpert Software.

12 Set the Mix settings. 
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13 Select Calibrate. The message Please confirm that the plate is placed properly and Press Ok. appears. 

Select OK. The plate loader loads the plate holder stage and the sample probe moves to the 
sample aspiration position of well A1. 

[Standard 96-Well Plate]: Proceed to Step 14.

[96-Well Deep Well Plate]: Skip to Step 15.

CAUTION

Risk of instrument damage. Do not crash the probe into the bottom of the plate as 

this will cause irreparable damage to the probe. Move the probe one step at a time 

when lowering the probe on the Z-axis toward the bottom of the plate. You will 

hear a click when the probe makes contact with the bottom of the well, this is the 

extreme position for the Z-axis of the probe. Do not move the probe any lower 

after you hear the click.

14  [Standard 96-Well Plate]: Select  and  or  and  to adjust the 

sample probe positions in the X-, Y-, and Z-axes.

Ensure the sample probe is centered and touches the bottom of the well.

NOTE The sample probe should just make contact with the bottom of the well.

NOTE The X-axis arrows moves the sample probe well position left and right. The Y-axis arrows moves 

the sample probe well position forward and back. The Z-axis arrows moves the sample probe up and 

down.

Skip to Step 16.
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15  [96-Well Deep Well Plate]: Select  and  or  and  to adjust the 

sample probe positions in the X-, and Y-axes.

Ensure the sample probe is centered on the mark of transparent plate.

NOTE The X-axis arrows moves the sample probe well position left and right. The Y-axis arrows moves 

the sample probe well position forward and back. The Z-axis arrows moves the sample probe up and 

down.

16 Select Test to verify the sample probe position.

Listen for the click to ensure the probe has made contact with the bottom of the well. Readjust 
the sample probe position by moving the probe 3 steps up. This is the correct position for the 
Z-axis of the probe.

NOTE [Transparent Plate]: The sample probe cannot come in contact with the surface of the 

transparent plate in the Z-axis. This is normal. Do not adjust the sample probe positions in the X-axis. 

The probe position in the Z-axis will be calibrated using a deep well plate.
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17 Select Next to move to the next well.

18 Repeat Steps 14-17 for wells A12, H1, and H12.
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19 Select Next. The calibration completion window appears. 

20 [Standard 96-Well Plate]: Select Finish to save the settings and exit. Skip to Step 30. 

[96-Well Deep Well Plate]: Select Finish to save the settings and exit. Continue to calibrate the 
probe position of Z-axis for the deep well plate. Proceed to Step 21.
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21 [96-Well Deep Well Plate]: Remove the transparent plate from the plate holder stage. 

22 [96-Well Deep Well Plate]: Select the plate type which has already been calibrated on the X-axis 

and Y-axis above on the Plate Type Library window, and place the deep well plate on the plate 
holder stage. 

[96-Well Deep Well Plate]

NOTE Ensure plate well A1 aligns with position A1.

23  [96-Well Deep Well Plate]: Select Edit to access the calibrate icon again. The Edit plate window 

appears. 

A1
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24 Select Calibrate. The message Please confirm that the plate is placed properly and Press Ok. appears. 

Select OK. The plate loader loads the plate holder stage and the sample probe moves to the 
sample aspiration position of well A1. 

CAUTION

Risk of instrument damage. Do not crash the probe into the bottom of the plate as 

this will cause irreparable damage to the probe. Move the probe one step at a time 

when lowering the probe on the Z-axis toward the bottom of the plate. You will 

hear a click when the probe makes contact with the bottom of the well, this is the 

extreme position for the Z-axis of the probe. Do not move the probe any lower 

after you hear the click.

25  [96-well Deep Well Plate]: Select  and  to adjust the sample probe positions in 

the Z-axis.

Ensure the sample probe is centered and touches the bottom of the well.

NOTE The sample probe should just make contact with the bottom of the well.

NOTE The probe positions of X-axis and Y-axis have already been calibrated on the transparent plate. 

Do not continue to adjust the sample probe positions in X-axis and Y-axis. 

26 [Deep-96 Well Plate]: Select Test to verify the sample probe position.

Listen for the click to ensure the probe has made contact with the bottom of the well. Readjust 
the sample probe position by moving the probe 3 steps upper. This is the correct position for 
the Z-axis of the probe.
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27 [96-Well Deep Well Plate]: Select Next to move to the next well.

28 [96-Well Deep Well Plate]: Repeat Steps 25-27 for wells A12, H1, and H12.

29 [96-Well Deep Well Plate]: Select Finish to save the settings and exit.

30 Reinstall the front cover. Refer to Front Cover Removal and Reinstallation in CHAPTER 11, 

Replacement/Adjustment Procedures.
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CHAPTER A

Instrument Installation

Overview

[CytoFLEX]: Your instrument may have been shipped directly to your laboratory, in which case you 
will need to set up and connect the Cytometer and the Workstation. Refer to this chapter for the 
instrument installation procedure.

[CytoFLEX LX]: The CytoFLEX LX is installed by your Beckman Coulter Service Representative. Do 
not open the box or crate. Wait for a qualified Beckman Coulter Service Representative.

This chapter contains information on:

 • Instrument Transportation and Storage

 • Installation Environment Validation

 • Unpacking the Instrument and Inspecting the Materials for Defects or Omissions [CytoFLEX]

 • CytExpert Software Installation Options

 • Installing the Software [CytoFLEX]

 • Upgrading the CytExpert Software

 • Reinstalling the CytExpert Software

Instrument Transportation and Storage

Refer to Preparing the Instrument for Transport or Storage in CHAPTER 10, Cleaning Procedures, 
prior to transportation or storage.

Attention to the following items is required when transporting or storing the instrument:

 • Take caution to protect the instrument from exposure to rain or sunlight.

 • Always place the instrument on a flat, stable surface, and take note of the symbol for this side up.

 • Temperature range: see Temperature and Humidity.

 • To prevent extrusion, the load on top cannot exceed 100 kg.

 • CytoFLEX Cytometer net weight 23 kg, gross weight 27 kg; transport the instrument using only 
appropriate equipment so as to guard against personal injury.

 • CytoFLEX LX Cytometer net weight 23 kg, gross weight 27 kg; transport the instrument using 
only appropriate equipment so as to guard against personal injury.

Validate the 

environment
Ô Open the package Ô

Install the 

instrument
Ô Prepare to boot
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Installation Environment Validation

IMPORTANT This instrument is intended for indoor use only.

Verify whether the installation environment satisfies the following requirements:

Worktable

CAUTION

Risk of instrument damage. Place the instrument on a level surface. Failing to do 

so places the system is in danger of toppling and can result in damage. Take all 

necessary precautions throughout the process of storing or transporting the 

instrument.

 • The tabletop must be smooth and level.

 • Minimum tabletop load bearing capacity [CytoFLEX]: 50 kg

 • Minimum tabletop load bearing capacity [CytoFLEX LX]: 100 kg.

 • The tabletop must not vibrate or shake.

 • Minimum tabletop dimensions [CytoFLEX]: 120 cm x 80 cm; minimum vertical space above 
tabletop: 80 cm

 • Minimum tabletop dimensions [CytoFLEX LX]: 200 cm x 80 cm; minimum vertical space above 
tabletop: 100 cm

 • Position the instrument in such a manner that it will facilitate disconnection of the power cable 
at the instrument end.

Ventilation and Cleaning

IMPORTANT If necessary, use ventilation equipment, but airflow must not be allowed to blow directly on 

the system, as it can affect the reliability of the data.

 • Ensure that the working environment is well ventilated for proper heat dissipation. 

 • Maintain a clearance of at least 20 cm from the back of the instrument for heat dissipation.

 • Keep the environment as dust free as possible.

 • Avoid direct exposure to sunlight.

 • Avoid placing near heat sources or exposing to drafts.

 • Avoid corrosives or flammable gases.
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Installation Environment Validation  A
Power Source

DANGER

Risk of electric shock and/or instrument damage. Ensure that the power source is 

properly grounded. Improper grounding can cause electric shock and damage the 

system. Verify that the output voltage of the power outlet conforms to the system 

requirements and that a 5 A, time delay, T 5 AL 250 VAC fuse is installed. To 

prevent personal injury, Beckman Coulter recommends using a power source 

designed to protect against electrical shock.

CAUTION

Possible instrument damage could occur if you use an extension cord or a power 

strip to connect the Cytometer. Always plug the Cytometer into a dedicated outlet 

with an isolated ground.

The power source requirements are as follows:

 • This instrument has been tested to and meets all applicable requirements for CE Marking.

 • This instrument complies with the emission and immunity requirements described in IEC 
61326-1.

 • This equipment has been designated and tested to CISPR 11 Class A. In a domestic environment 
it may cause radio interference, in which case, you may need to take measures to mitigate the 
interference.

 • It is advised that the electromagnetic environment should be evaluated prior to operation of 
the device.

 • Do not use this device in close proximity to sources of strong electromagnetic radiation 
(unshielded intentional RF sources), as these may interfere with the proper operation.

 • 100-240 volts, 50/60 Hz, 3-wire power cable, well grounded.

 • Amperage not less than 10 A.

 • The system requires a well-grounded power outlet (150 VA normal, 250 VA max) to provide the 
necessary power.

 • Distance from system to socket less than 1.5 m.

Power consumption of the Plate Loader is <30 W.
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Temperature and Humidity

CAUTION

Risk of instrument damage and/or erroneous results. To ensure reliability, the 

system must be operated in the specified environment, within the required 

temperature and humidity ranges. If the ambient temperature or humidity level 

falls outside the ranges mentioned above, use appropriate air conditioning.

 • CytoFLEX: Ambient temperature: 15-27°C with fluctuations of no more than <±2°C per hour. 

 • CytoFLEX LX: Ambient temperature: 15-30°C with fluctuations of no more than <±2°C per hour. 

 • Relative humidity: 15% RH-80% RH, non-condensing.

Waste Disposal

WARNING

Risk of biohazardous contamination if you have skin contact with the waste 

container, its contents, and its associated tubing. The waste container and its 

associated tubing might contain residual biological material and must be handled 

with care. Clean up spills immediately. Dispose of the contents of the waste 

container in accordance with your local regulations and acceptable laboratory 

procedures.

The waste line from the Cytometer is connected to a waste container/cubitainer. Dispose of the 
system’s waste in accordance with your local regulations and acceptable laboratory procedures.

The waste line supplied with the instrument can be connected to an open drain. If you use an open 
drain, mechanically secure the waste tube into the drain so the tube cannot accidentally come out 
of the drain. This prevents spillage.

Unpacking the Instrument and Inspecting the Materials for Defects or 

Omissions [CytoFLEX]

Take care to store the instrument in a suitable environment where it can remain in the proper 
position.

Check that the following components on the packing list are present:

 • Cytometer

 • Cables

 • Computer
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 • Mouse

 • Keyboard

 • Monitor

 • Fluid Container holder [CytoFLEX]

 • Sheath fluid container

 • Waste container

 • Sheath fluid tubing

 • Waste tubing

 • USB configuration key

 • Software USB

Installing the Instrument and Connecting the Equipment [CytoFLEX]

IMPORTANT Use the appropriate power cable plug for your geographic region.

CAUTION

Risk of erroneous results. Place the Fluid Containers and the instrument on the 

same, level surface. An excessive difference in height can alter the flow velocity.

CAUTION

Possible instrument damage could occur if you use an extension cord or a power 

strip to connect the Cytometer. Always plug the Cytometer into a dedicated outlet 

with an isolated ground.

1 Remove the Cytometer, the Fluid Containers, the accompanying holder, the computer, the 

monitor, and the keyboard and mouse from the each respective box placing them flat on the 
instrument worktable.

NOTE The Fluid Container holder must be on the same plane as the Cytometer. 

Reach under the base of the instrument to lift the Cytometer out of the package. Beckman 
Coulter recommends that two people lift the Cytometer out together.

2 Ensure a minimum clearance of 20 cm on both sides and to the back of the Cytometer to 

maintain enough room to access the on/off controls for the Cytometer devices.
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3 After removing the monitor and attaching the base, place them on the worktable with the 

computer.

[CytoFLEX Without Plate Loader Shown]

4 Open the top cover of the Cytometer. Check inside to verify that the optical bench cover (1) is 

tightly closed and that the optical fibers (3) and WDMs (2) are securely connected.

1. Fluid Containers. Place on the left side of the Cytometer.

2. Cytometer. Place between the Fluid Containers and the Workstation.

3. Workstation. Place on the right side of the Cytometer.

b c d

CAUTION
CLASS 3B LASER RADIATION WHEN
OPEN AND INTERLOCKS DEFEATED

AVOID EXPOSURE TO BEAM

e

w

q
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5 Remove any shipping tape and open the cap of each WDM. Verify that the light filters inside are 

in place.

6 Insert sheath and waste pickup tubing into the appropriate container.

7 Connect the blue harness (1) from the sheath fluid container (2) and the yellow harness (3) 

from the waste container (4) to the fluid connector panel (5) on the back right corner of the 
Cytometer according to the color code.

CLASS 1 LASER PRODUCT
COMPLIES WITH 21 CFR 1040.10 AND 1040.11
EXCEPT FOR DEVIATIONS PURSUANT TO
LASER NOTICE NO. 50 DATED JUNE 24, 2007
MANUFACTURED 

SNSN

Sheath SheathWaste

b

c

d

e

f
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8 Connect the waste (1) and sheath (2) level sensors.

9 Place the sheath fluid container (1) and the waste container (2) in the Fluid Container 

holder (3).

b c

Sheath SheathWaste

c

d

b
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10 Set up the supplied computer (1) and connect the USB cable (2) from the back of the Cytometer 

(3) to a USB port on the back of the computer.

11 Plug the Cytometer power cable in to the back of the Cytometer.

12 Connect the computer keyboard, mouse, and monitor.

CLASS 1 LASER PRODUCT
COMPLIES WITH 21 CFR 1040.10 AND 1040.11
EXCEPT FOR DEVIATIONS PURSUANT TO
LASER NOTICE NO. 50 DATED JUNE 24, 2007
MANUFACTURED 

SNSN

b

c

d

CLASS 1 LASER PRODUCT
COMPLIES WITH 21 CFR 1040.10 AND 1040.11
EXCEPT FOR DEVIATIONS PURSUANT TO
LASER NOTICE NO. 50 DATED JUNE 24, 2007
MANUFACTURED 

SN
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13 Remove the foam support holding the sample loader in the front-right corner of the 

instrument.

[CytoFLEX Without Plate Loader Shown]

14 Add Deep Clean solution to the Deep Clean solution bottle. Refer to Step 1 and Steps 3 - 7 of the 

Adding the Deep Clean Solution in CHAPTER 11, Replacement/Adjustment Procedures.

15 Clean the sheath fluid container. Refer to Cleaning the 4 L Sheath Fluid Container in 

CHAPTER 10, Cleaning Procedures. 

16 Fill the Sheath fluid container. Refer to Filling the 4 L Sheath Fluid Container [CytoFLEX] in 

CHAPTER 11, Replacement/Adjustment Procedures.

WARNING

Risk of chemical injury from bleach. To avoid contact with the bleach, use barrier 

protection, including protective eyewear, gloves, and suitable laboratory attire. 

Refer to the Safety Data Sheet for details about chemical exposure before using 

the chemical.

17 Add 400 mL of 5 to 6% bleach to the waste container.

18 Install the CytExpert software. Refer to Installing the Software [CytoFLEX].

19 Turn on the instrument. Refer to Turning On the Instrument in CHAPTER 3, Daily Startup.

20 Open the CytExpert software. Refer to Logging Into the Software in CHAPTER 3, Daily Startup.

21 Run the System Startup Program. Refer to Running the System Startup Program [with the 

Single Tube Loader] in CHAPTER 3, Daily Startup.
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22 Prime the instrument three times. Refer to Priming the Flow Cell in CHAPTER 11, Replacement/

Adjustment Procedures.

23 Prepare a QC sample. Refer to Preparing the QC Sample in CHAPTER 4, Instrument Quality 

Control and Standardization.

24 Import the lot-specific target values files. Refer to Importing Lot-Specific Target Values in 

CHAPTER 4, Instrument Quality Control and Standardization.

25 Perform a QC to establish the target gain values for your instrument. Refer to Collecting QC Data 

in CHAPTER 4, Instrument Quality Control and Standardization. 

26 If QC fails, the following software message appears. Select Yes. 

NOTE Target gain values must be established upon installation. QC could fail up to three times upon 

installation until target gain values are established.

27 Repeat Steps 23-26 until the target gain values are established and QC has passed.

NOTE  If QC fails more than three times, contact us.

28 Within five business days, activate your Warranty by contacting us and providing them with 

your latest QC run results.

Installing the Instrument and Connecting the Equipment [CytoFLEX LX]

The CytoFLEX LX is installed by Beckman Coulter service.
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CytExpert Software Installation Options

CytExpert software version 2.0 and higher has three installation options upon install.

 • CytExpert Default software option. User Login is not required to run the system.

 • CytExpert User Management software option. User Login is required to run the system. 
Contains features and functionality that facilitates user and role management.

 • CytExpert Electronic Record Management software option. User Login is required to run the 
system. Contains features and functionality that facilitates compliance with 21 CFR Part 11 

guidelines for Electronic Records and Signatures.

Installing the Software [CytoFLEX]

The installation process workflow is as follows:

The CytExpert software can be installed on any computer that meets the minimum specifications 
(see Instrument Specifications in CHAPTER 1, System Overview) for analysis-only use.

Install the CytExpert 

software
Ô

Install instrument 

configuration files
Ô Start the software
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Required Materials

The following materials are required to install the CytExpert software:

 • CytoFLEX Series flow cytometer.

 • CytoFLEX Series Workstation.

 • CytExpert software installation USB.

 • Authorized Beckman Coulter USB configuration key.

Installing the CytExpert Software

IMPORTANT Follow this procedure when installing the CytExpert software for the first time.

1 Ensure the workstation and the monitor are powered on.

2 Insert the software USB into the computer.

NOTE If the Autoplay window appears, select Open folder to view files. 
B49006AM   A-13



Instrument Installation

Installing the Software [CytoFLEX]  
3 Select CytExpert_X.X_Setup.exe. The User Account Control window appears. 

4 Select Yes. The CytExpert Setup Welcome window appears.

5 Select Next.
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6 Select both support program checkboxes in the CytExpert Setup Prerequisites window.

7 Select Next. The Microsoft .NET Framework window appears.

8 Select the I have read and accept the license terms checkbox.
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9 Select Install. The Installation is Complete window appears when installation has finished.

10 Select Finish. The Microsoft Visual C++ 2013 Redistributable Setup window appears.

11 Select the I have read and accept the license terms checkbox.
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12 Select Install. The Setup Successful window appears when installation has finished.

13 Select Close. The Welcome to the CytExpert Setup Wizard window appears.
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14 Select Next. The Beckman Coulter License Terms window appears.

15 Read the Beckman Coulter Customer End User License Agreement.

16 Select the I accept the terms of this agreement checkbox.

NOTE The checkbox is not selectable until you scroll all the way to the end of the agreement.
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17 Select Next. The Choose a file location window appears.

18 Select Next. The Installation Options window appears. 

19 Select the desired installation option. Refer to CytExpert Software Installation Options.
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20 Select Next. The Begin installation of CytExpert window appears.

21 Select Install to begin installing the software. The Installation Progress window appears.

NOTE The software will install into the default file path provided unless otherwise specified.
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22 If a Windows Security window appears. Select Install this driver software anyway to install the 

USB drive.

23 The following software prompt appears. Select OK.

NOTE The term “device” in this message refers to the cytometer.

24 Wait for the software to finish installing. The install complete window appears. 
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25 Select Close to finish the CytExpert software installation.

26 Install the instrument configuration file. Refer to Installing the Instrument Configuration File.

Installing the Instrument Configuration File

CAUTION

Risk of erroneous results or instrument damage. Only install the configuration file 

that matches your instrument. Installing an incorrect configuration file could 

cause erroneous results or instrument damage.

Use this procedure to install the configuration settings for the instrument. If the CytExpert 
software will not be connected to a Cytometer, this step can be skipped.

IMPORTANT You must install the CytExpert software before installing the instrument configuration file. 

Refer to Installing the Software [CytoFLEX].

1 Select and run CytExpert_X.X_Config_Setup_XXXX.exe. The User Account Control window 

appears. 

NOTE XXXX refers to the serial number of the instrument.
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2 Select Yes. The CytExpert Config Welcome window appears.

3 Select Next. The CytExpert Config Ready to Install window appears.

4 Verify that the serial name displayed at the top of the window is correct.
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5 Select Install. When the installation has finished, the Completing the CytExpert Config Setup 

Wizard window appears.

6 Select Finish.

7 If you get the following message, select OK. When you launch CytExpert, the system will 

automatically upgrade your configuration file. Proceed to Step 9.
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Starting the Software

IMPORTANT The default username is admin. The default password is password.

1 Insert the USB configuration key into the USB port of the computer.

2 Start the software. Refer to Logging Into the Software in CHAPTER 3, Daily Startup, for detailed 

instructions on opening the software and confirming the connection status.

NOTE If the software shows Connected, data collection and analysis can be completed. 

Upgrading the CytExpert Software

Use this procedure to upgrade to software version 2.0 or higher from any previous version. 

If you only need to upgrade to the CytExpert Default software option, you should follow the 
procedure below. 

If you need to install either the CytExpert User Management software option or the CytExpert 
Electronic Record Management software option, you should first follow the procedure below then 
follow the reinstallation procedure. Refer to Reinstalling the CytExpert Software.

Refer to CytExpert Software Installation Options for the differences between each software option 
available.
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CAUTION

Risk of data loss. Reinstalling the CytExpert Software could overwrite your 

database. Ensure you backup your database prior to software reinstallation.

1 Insert the software USB into the computer.

NOTE If the Autoplay window appears, select Open folder to view files.

2 Select CytExpert_X.X_Setup.exe. The User Account Control window appears. 
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3 Select Yes. The Welcome to CytExpert Setup Wizard window appears.

4 Select Next. The Beckman Coulter License Terms window appears.

5 Read the Beckman Coulter Customer End User License Agreement.
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6 Select the I accept the terms of this agreement checkbox.

NOTE The checkbox is not selectable until you scroll all the way to the end of the agreement.

7 Select Next. The Installation Options window appears.
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8 Select Next. If you are upgrading your software from a previous version and the previous 

version is not uninstalled first, the following window appears.

9 Select Install to begin installing the software. The Installation Progress window appears.
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10 If the following software prompt appears, select OK.

NOTE The term “device” in this message refers to the cytometer.

11 Wait for the software to finish installing. The install complete window appears. 

12 Select Close to finish the CytExpert software installation.

Reinstalling the CytExpert Software

Use this procedure to:

 • Change the software option installed in all software versions 2.0 and higher. Refer to CytExpert 
Software Installation Options for the differences between each software option available.

NOTE If you are upgrading to software version 2.0 or higher from any software version prior to software 

version 2.0, refer to Upgrading the CytExpert Software.
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 • Reinstall the same version of software.

 • Upgrade your software to a version newer than software version 2.0.

CAUTION

Risk of data loss. Reinstalling the CytExpert Software could overwrite your 

database. Ensure you backup your database prior to software reinstallation.

1 Backup your CytExpert data if you previously had a software option other than the Default 

software option installed. Refer to Backup and Restore in CHAPTER 9, Troubleshooting.

2 Insert the software USB into the computer.

NOTE If the Autoplay window appears, select Open folder to view files.

3 Select CytExpert_X.X_Setup.exe. The User Account Control window appears. 
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4 Select Yes. The Welcome to CytExpert Setup Wizard window appears.

5 Select Next. The Change your installation of CytExpert screen appears.
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6 Select Remove. The Begin Remove of CytExpert screen appears.

IMPORTANT If the Remove CytExpert settings, CytExpert database, cytometer configuration, and 

temporary files checkbox is checked, your settings, database, configuration files, and temporary files will 

be overwritten and you will need to reinstall your cytometer configuration and restore any databases you 

might have.

7 Ensure the Remove CytExpert settings, CytExpert database, cytometer configuration, and temporary 

files checkbox is unchecked.
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8 Select Remove. When software removal is complete, the software displays the message 

CytExpert has been successfully configured.

9 Select Close.

10 Navigate back to the software USB folder.

11 Select CytExpert_X.X_Setup.exe. The User Account Control window appears. 
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12 Select Yes. The Welcome to CytExpert Setup Wizard window appears.

13 Select Next. The Beckman Coulter License Terms window appears.

14 Read the Beckman Coulter Customer End User License Agreement.
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15 Select the I accept the terms of this agreement checkbox.

NOTE The checkbox is not selectable until you scroll all the way to the end of the agreement.

16 Select Next. The Choose a file location window appears.

17 Select Next. The Installation Options window appears.
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Reinstalling the CytExpert Software  A
18 Select the desired installation option. Refer to CytExpert Software Installation Options.

19 Select Next. The Begin installation of CytExpert window appears.

20 Select Install to begin installing the software. The Installation Progress window appears.
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Reinstalling the CytExpert Software  
21 If the following software prompt appears, select OK.

NOTE The term “device” in this message refers to the cytometer.

22 Wait for the software to finish installing. The install complete window appears. 

23 Select Close to finish the CytExpert software installation.
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APPENDIX B

CytExpert Electronic Record Management

Overview

IMPORTANT You must have the CytExpert Electronic Record Management software option installed to use 

the features listed below. Refer to CytExpert Software Installation Options in CHAPTER A, Instrument 

Installation.

Beckman Coulter's CytoFLEX with CytExpert software version 2.0 and higher contains features and 
functionality that facilitates compliance with 21 CFR Part 11 guidelines for Electronic Records and 
Signatures. This electronic record management includes controls for user identification, 
permissions, electronic signatures, data integrity, operation and experiment logs and audit trails. 
CytExpert software version 2.0 and higher contains a database that uses checksum matching to 
prevent tampering of the records and files that are indexed in the Closed File System.

This chapter contains information on:

 • Software Menu

 • Experiment Management

 • Log

 • Electronic Signature

 • User Management

Software Menu

The CytExpert Electronic Record Management software option includes additional software menu 
items that are not available in the CytExpert Default software option or the CytExpert User 
Management software option. Refer to Figure 2.3 and Figure 2.4 for comprehensive software menu 
trees and details on which menu item applies to each software option. 
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Experiment Management  
Experiment Management

CAUTION

Risk of file corruption. Do not add, delete, or modify data from the Windows 

Explorer directory. Manage all data changes using Experiment Explorer to ensure 

file indexing remains intact.

Closed File System

The closed file system provides audit trail capability for CytExpert experiment files. The closed file 
system provides a secure layer between the actual Windows Explorer files and the CytExpert users 
to retain file integrity.

Three file types are managed by the closed file system:

 • Experiment files

 • Compensation experiment files

 • Experiment template files

The Experiment Explorer dialog can be accessed by selecting File > Experiment Explorer. The 
Experiment Explorer dialog functions similarly to Windows Explorer.

Experiments, compensation experiments, and experiment templates created in other modes can be 
imported into the closed file system. These closed file system experiments can also be exported. 
Refer to Importing an Experiment/Template and Exporting an Experiment/Template.
B49006AM   B-2



CytExpert Electronic Record Management

Experiment Management  B
Experiment Directory Management

When launching CytExpert for the first time after installing the software, the Administrator must 
set up at least one experiment directory for experiment files.

NOTE Only one experiment directory can be created per drive.

Setting Up the Experiment Directory

1 Select Settings > Set Experiment Directory. The Set Experiment Directory window appears.

2 Select Add. The Add New Experiment Directory window appears.

3 Enter a name for the experiment directory.

4 Select and browse to the desired Windows file system folder.
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CytExpert Electronic Record Management

Experiment Management  
5 Select OK. The specified folder appears in the Set Experiment Directory window.

NOTE Select Rename to rename the experiment directory. Select Delete to delete an experiment 

directory.

Folder Hierarchy Management

Select File > Experiment Explorer to view Experiment Explorer. Select New Folder from the 
right-click drop down menu or from the Experiment Explorer toolbar to create a new subfolder. 

Select Rename from the right-click drop down menu or from the Experiment Explorer toolbar to 
rename a subfolder. 

Select Delete from the right-click drop down menu or from the Experiment Explorer toolbar to 
delete a subfolder. 
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CytExpert Electronic Record Management

Experiment Management  B
Experiment Related Operations

The Experiment Explorer dialog appears in place of the Windows File Explorer in the following 
operations: New/Open Experiment, New/Open Compensation Experiment, Save As, Save 
Experiment As Template, Recent Template, and New Experiment from Template.
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Experiment Management  
Importing an Experiment/Template

Use the following procedure to import experiment (.xit), compensation (.xitc), or experiment from 
template (.xitm) files into the system.

1 Select File > Experiment Explorer. The Experiment Explorer window appears.
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Experiment Management  B
2 Select Import Experiment from the right-click drop down menu or from the Experiment 

Explorer toolbar.

3 Browse to the desired file path to import and select Open.
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CytExpert Electronic Record Management

Experiment Management  
A progress bar appears when importing files.

Once the import is complete, the imported files display in the Experiment Explorer.

NOTE Users can import .xit, .xitc, and .xitm files individually or multiple files at a time.
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Experiment Management  B
Exporting an Experiment/Template

1 Select File > Experiment Explorer. The Experiment Explorer window appears.

2 To export a single experiment:

a. Select Export Experiment from the right-click drop down menu or from the Experiment 
Explorer toolbar.
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Experiment Management  
b. Browse to the desired file path for export and select Save.

A progress bar appears when exporting files.

Once the export is complete, the exported file displays in the target folder.

OR
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Experiment Management  B
To export multiple experiments: 

a. Select all of the experiments to be exported then select Export Experiment from the 
right-click drop down menu or from the Experiment Explorer toolbar.

b. Browse to the desired file path for export and select OK.
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Log  
A progress bar appears when exporting files.

Once the export is complete, the exported file displays in the target folder.

Log

The CytExpert Electronic Record Management software option includes three logs:

Experiment Operation Log — The experiment operation log lists the audit trail records related to 
the experiment operations based on query criteria.

System Operation Log — The system operation log lists the log records associated with the system 
configuration changes based on query criteria.

User Management Operation Log — The user management operation log lists all of the log 
records related to the user management operations based on query criteria.

NOTE All three logs support print and export to PDF or CSV file functions.

Experiment Operation Log

The Experiment Operation Log generates an experiment audit trail record when performing 
experiment operations.

Select Log > Experiment Operation Log to open the Experiment Operation Log window. Refer to 
Figure B.1.
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CytExpert Electronic Record Management

Log  B
Figure B.1  Experiment Operation Log Window

1. Experiment: Used to specify the experiment file 

criteria.

NOTE If an experiment is open, the current 

experiment displays in the Experiment 

section.

2. Experiment ID: Used to specify the experiment 

ID query criteria.

3. User: Used to specify the user query criteria.

NOTE The default selection all users.

4. Time Range: Used to specify the operation time 

range query criteria.

5. : Runs the query on the specified 

query criteria.

6. Query display: Displays the queried results.

7. : Displays the print and export 

preview dialog. Refer to Figure B.3.

8. : Selects an experiment from the 

Select Experiment Profile window. Refer to 

Figure B.2.

9. : Selects the experiment 

that is currently open.

NOTE An experiment must be open for the 

button to be selectable.
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CytExpert Electronic Record Management

Log  
Figure B.2  Select Experiment Profile Window

1. Keyword search: Used to search for keywords in the experiment display list.

2. Clear: Clears the keyword search.

3. Experiment display list: Displays the experiments in a list.

4. Select: Selects an experiment.

5. Close: Closes the Select Experiment Profile window.
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CytExpert Electronic Record Management

Log  B
Figure B.3  Print and Export Preview Window

System Operation Log

The System Operation Log generates system log records for settings, configuration, maintenance, 
and QC.

Select Log > System Operation Log to open the System Operation Log window. Refer to Figure B.4.

1. Print: Prints the report.

2. Export to PDF or CSV: Exports the report as a PDF or CSV file.

3. Report View: Displays the detailed report view.
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CytExpert Electronic Record Management

Log  
Figure B.4  System Operation Log Window

NOTE The System Operation Log uses the same query criteria and functions as the Experiment Operation 

Log. Refer to Figure B.1.

User Management Operation Log

The User Management Operation Log generates audit log records for user management, role 
management, account policies, password changes, and login/logout records.

Select Log > User Management Operation Log to open the User Management Operation Log window. 
Refer to Figure B.5.
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Electronic Signature  B
Figure B.5  User Management Operation Log Window

NOTE The User Management Operation Log uses the same query criteria and functions as the Experiment 

Operation Log. Refer to Figure B.1.

Electronic Signature

Signing Experiments

1 Select File > Save to save the experiment. 
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Electronic Signature  
2 Select Signature > Sign. The Sign window appears.

3 Enter your username and password.
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Electronic Signature  B
4 Select the appropriate signature.

NOTE Only the highest signature level can skip to the final approval by selecting Enforce as the final 

signature. 

5 If necessary, enter comments related to the experiment.

6 Select OK.

The signature status displays in the top-left corner of the software screen.

If the experiment has been signed by all required signatures or the Enforce as final signature is 
selected, the status displays: The experiment has been validated.
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Electronic Signature  
7 Select Signature > Signature Records to view the electronic signature details.

Rejecting Experiment

1 Select Signature > Reject.

NOTE You cannot reject an experiment if it has been validated.
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Electronic Signature  B
2 If necessary, enter comments related to the experiment.

3 Select OK. The following message appears: Are you sure you want to reject the signature?

4 Select Yes to confirm the rejection of your signature or No to cancel.

Setting the Signature Retention Period

The signature retention period becomes effective immediately once an experiment has been 
signed. The experiment cannot be deleted or edited within the retention period.

Select Settings > Set Retention Period to set the signature retention period for an experiment. 

NOTE  The default signature retention period is 300 days. The allowable range is 1-9999 days.

Select Settings > Set Retention Period to navigate to the Experiment Explorer window to set the 
signature retention period for multiple experiments. 
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Electronic Signature  
Select Settings > Retention Period Options to default signature retention period for experiments.

NOTE Select Allow retention period modification for a validated experiment to allow modifying the 

signature retention period for a validated experiment.

Signature Setting

The Signature Setting allows you to set the signature hierarchy, the signature name, and the 
maximum signature count for each signature level.

1 Select Signature > Signature Setting. The Signature Setting window appears.

NOTE You can add a maximum of 3 signature levels. 
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Electronic Signature  B
2 Select the signature name to be edited from the Signatures section of the Signature Setting 

window. Then, select Edit. The Edit Signature window appears.

3 Enter the signature name.

4  Select the desired Maximum Signature Count.

NOTE The signature count means the allowable number of signatures for the signature name. You can 

choose between 1 and 10. The default value is 1.
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Electronic Signature  
5 Select a role for the signature from the Allow signature for roles section of the Edit Signature 

window.

NOTE Each role can sign or reject only if the sign/reject permission is assigned and the role signature is 

selected. The available roles displayed in the window depend on the permission setting assigned in 

Role Manager. To assign sign/reject permissions to a role, refer to Modifying User Roles in the Role 

Window in CHAPTER 2, Using the CytExpert Software.

6 Select OK.

7 Select Close.
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Electronic Signature  B
Printing an Experiment Signature

IMPORTANT Ensure an experiment is signed prior to attempting to print the experiment signature.

To print an experiment with a signature, refer to Printing Graphics in CHAPTER 5, Data Acquisition 
and Sample Analysis.
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User Management  
User Management

User Administration

Logging In and Out of the Software

Refer to Logging Into the Software and Logging Out of the Software in CHAPTER 3, Daily Startup.

Locking the Account

Refer to Locking the Account in CHAPTER 3, Daily Startup.

Role Management

Refer to Role Management in CHAPTER 2, Using the CytExpert Software.

User Management

Refer to User Management in CHAPTER 2, Using the CytExpert Software.

Account Policies

Refer to Account Policies in CHAPTER 2, Using the CytExpert Software.
B49006AM   B-26



APPENDIX C

Sample Injection Mode Control Kit

Overview

The Sample Injection Mode Control Kit is a mechanical knob installed by your service engineer that 
enables users to switch between the Plate Loader sample injection mode and the Semi-Automatic 
or manual sample injection mode. The switch eliminates the need to manually re-route the tubing.

This chapter contains information on:

 • Performance Characteristics [With the Sample Injection Mode Control Knob]

 • Sample Injection Mode Control Kit Components

 • Switching the Sample Probe from the Single Tube Sample Station to the Plate Loader [With 
Sample Injection Mode Control Knob]

 • Switching the Sample Probe from the Plate Loader to the Single Tube Sample Station [With 
Sample Injection Mode Control Knob]

Performance Characteristics [With the Sample Injection Mode Control 

Knob]

Performance [CytoFLEX With Standard Plate Loader]

Throughput [With 

Standard Plate 

Loader]a

a. This performance characteristic is different if you do not have the Sample Injection Mode Control Kit installed on your 

CytoFLEX flow cytometer. Refer to Performance Characteristics in CHAPTER 1, System Overview.

10 second acquisition without mixing or backflush: <35 min.

10 second acquisition with 3 second mixing and 4 second backflush: < 50 min.

Performance [CytoFLEX With Plate Loader DW]

Carryover Plate Loader format <0.5%

Throughput [With 

Plate Loader DW]a

a. The Plate Loader DW is equipped with the Sample Injection Mode Control Kit. Refer to APPENDIX C, Sample Injection Mode 

Control Kit.

Standard 96-well plate, 10 second acquisition without mixing or backflush: <36 

min.

96-well deep well plate, 10 second acquisition without mixing or backflush: <37 

min

Standard 96-well plate, 10 second acquisition with 5 second mixing and 4 second 

backflush: <54 min.

96-well deep well plate, 10 second acquisition with 10 second mixing and 4 

second backflush: <64 min.
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Sample Injection Mode Control Kit Components  
Sample Injection Mode Control Kit Components

Figure C.1  Sample Injection Mode Control Knob

Performance [CytoFLEX LX With Standard Plate Loader]

Throughput [With 

Standard Plate 

Loader]a

a. This performance characteristic is different if you do not have the Sample Injection Mode Control Kit installed on your 

CytoFLEX LX flow cytometer. Refer to Performance Characteristics in CHAPTER 1, System Overview.

10 second acquisition without mixing or backflush: <38 min.

10 second acquisition with 3 second mixing and 6 second backflush: < 56 min.

Performance [CytoFLEX LX With Plate Loader DW]

Carryover Plate Loader format <0.5%

Throughput [With 

Plate Loader DW]a

a. The Plate Loader DW is equipped with the Sample Injection Mode Control Kit. Refer to APPENDIX C, Sample Injection Mode 

Control Kit.

Standard 96-well plate, 10 second acquisition without mixing or backflush: <39 

min.

96-well deep-well plate, 10 second acquisition without mixing or backflush: <40 

min

Standard 96-well plate, 5 second acquisition with 6 second mixing and 4 second 

backflush: <60 min.

96-well deep well plate, 10 second acquisition with 6 second mixing and 4 second 

backflush: <69 min.

1. Switch module knob

NOTE The P indicates the instrument is set to Plate Loader sample injection mode. The T indicates 

the instrument is set to the Semi-Automatic or manual sample injection mode.

b
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Sample Injection Mode Control Kit

Switching the Sample Probe from the Single Tube Sample Station to the Plate Loader [With Sample Injection Mode Control Knob]  C
Switching the Sample Probe from the Single Tube Sample Station to the 

Plate Loader [With Sample Injection Mode Control Knob]

WARNING

Risk of biohazardous contamination if you have skin contact with the sample 

probe or the sample peristaltic pump tubing. The sample probe and the sample 

peristaltic pump tubing could contain residual biological material and must be 

handled with care. Clean up spills immediately.

Use universal precautions when working with pathogenic materials. Means must 

be available to decontaminate the instrument and to dispose of biohazardous 

waste.

WARNING

Risk of biohazardous contamination and/or sample dilution when performing a 

manual backflush. If the CytExpert Sample Injection Mode does not match the 

Sample Injection Control Knob position, a manual backflush can cause backflush 

fluid to flow through the path set by the Sample Injection Mode Control knob 

potentially contaminating the sample tube/plate and/or the sample station. 

Ensure the Sample Injection Mode Control Knob is positioned to match the correct 

CytExpert Sample Injection Mode. Clean up spills immediately.

Use universal precautions when working with pathogenic materials. Means must 

be available to decontaminate the instrument and to dispose of biohazardous 

waste.

CAUTION

Risk of instrument damage. The sample probe can easily become damaged or 

deformed. To avoid damage to the sample probe, turn the switch module knob 

carefully and avoid contacting the sample probe.

NOTE If you do not have the Sample Injection Mode Control Kit installed, refer to Changing the Sample Probe 

from the Single Tube Sample Station to the Plate Loader [CytoFLEX With Plate Loader] in CHAPTER 11, 

Replacement/Adjustment Procedures.

1 Switch to the Plate Loader sample injection mode. Refer to Selecting the Plate Loader Sample 

Injection Mode [With Plate Loader] in CHAPTER 3, Daily Startup.
B49006AM   C-3



Sample Injection Mode Control Kit

Switching the Sample Probe from the Single Tube Sample Station to the Plate Loader [With Sample Injection Mode Control Knob]  
2 Turn the switch module knob to the left (counterclockwise) until the flat side of the knob is 

parallel to the front panel and the P is facing you. Ensure that the knob is turned as far as it will 
go.

The system is now ready for use in the Plate Loader sample injection mode.

NOTE If you do not see any events upon running an acquisition:

1. Select  to stop the acquisition.

2. Ensure that the switch module knob is turned as far as it will go.

3. Rerun the acquisition.

4. If the problem persists, contact us.
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Switching the Sample Probe from the Plate Loader to the Single Tube Sample Station [With Sample Injection Mode Control Knob]  C
Switching the Sample Probe from the Plate Loader to the Single Tube 

Sample Station [With Sample Injection Mode Control Knob]

WARNING

Risk of biohazardous contamination if you have skin contact with the sample 

probe or the sample peristaltic pump tubing. The sample probe and the sample 

peristaltic pump tubing could contain residual biological material and must be 

handled with care. Clean up spills immediately.

Use universal precautions when working with pathogenic materials. Means must 

be available to decontaminate the instrument and to dispose of biohazardous 

waste.

WARNING

Risk of biohazardous contamination and/or sample dilution when performing a 

manual backflush. If the CytExpert Sample Injection Mode does not match the 

Sample Injection Control Knob position, a manual backflush can cause backflush 

fluid to flow through the path set by the Sample Injection Mode Control knob 

potentially contaminating the sample tube/plate and/or the sample station. 

Ensure the Sample Injection Mode Control Knob is positioned to match the correct 

CytExpert Sample Injection Mode. Clean up spills immediately.

Use universal precautions when working with pathogenic materials. Means must 

be available to decontaminate the instrument and to dispose of biohazardous 

waste.

CAUTION

Risk of instrument damage. The sample probe can easily become damage or 

deformed. To avoid damage to the sample probe, turn the switch module knob 

carefully and avoid contacting the sample probe.

NOTE If you do not have the Sample Injection Mode Control Kit installed, refer to Changing the Sample Probe 

from the Plate Loader to the Single Tube Sample Station [CytoFLEX With Plate Loader] in CHAPTER 11, 

Replacement/Adjustment Procedures.

1 Switch to either the Semi-Automatic or manual sample injection mode. Refer to Selecting the 

Proper Sample Injection Mode in CHAPTER 3, Daily Startup.
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Switching the Sample Probe from the Plate Loader to the Single Tube Sample Station [With Sample Injection Mode Control Knob]  
2 Turn the switch module knob to the right (clockwise) until the flat side of knob is perpendicular 

to the front panel and the T is facing you. Ensure that the knob is turned as far as it will go.

The system is now ready for use in either the Semi-Automatic or manual sample injection 
mode.

NOTE If you do not see any events upon running an acquisition:

1. Select  to stop the acquisition.

2. Ensure that the switch module knob is turned as far as it will go.

3. Rerun the acquisition.

4. If the problem persists, contact us.
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APPENDIX D

Deep Well Plate

Specimen Collection Plate Specifications

Beckman Coulter does not recommend the use of one plate in preference to another nor guarantee 
the acceptability of the plates to produce quality results. If you need information on a plate not 
listed in Table D.1, ensure that the plate size and characteristics conform to the specifications listed 
below. Calibrate the plate position for any new plate types prior to acquisition. Refer to Calibrating 
the Plate Position [With Plate Loader] in CHAPTER 11, Replacement/Adjustment Procedures.

NOTE Ensure that the following specifications are met when you select the 96-well deep well plates:

 • The inner well diameter is ≥ 5.8 mm.

 • The plate height is ≤ 45.5 mm.

Table D.1  Deep Well Plate [with Plate Loader DW]

Name Volume Material Manufacturer PN

96-well deep well plate 1 mL Polystyrene Beckman Coulter 267001

96-well deep well plate 1 mL Polypropylene Beckman Coulter 267006

96-well deep well plate 2 mL Polypropylene Beckman Coulter 140504
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APPENDIX E

Custom Optical Filters

Overview

IMPORTANT A custom optical filter could influence the performance of other channels due to the band pass 

and the reflection efficiency. Beckman Coulter recommends the operator to validate the performance of 

the custom optical filter within their configuration prior to accepting experimental results.

The optical filter is critical for optimal experiment results. When selecting an optical filter glass 
piece, the filter should comply with the following specifications.

NOTE When installing a custom filter, you need to create a new detector configuration. Refer to Verifying, 

Selecting, Editing, and Creating Detector Configuration in CHAPTER 5, Data Acquisition and Sample 

Analysis. For QC, refer to CHAPTER 4, Instrument Quality Control and Standardization.

Installing a Custom Optical Filter

IMPORTANT Keep the optical filter support holder for future use.

The optical filter support holder is used to align the optical filter glass piece with the optical filter 
mount. 

Table E.1  CytoFLEX Series Optical Filter Specifications

Length 14.5 mm ± 0.1 mm

Width 6.1 mm ± 0.1 mm

Thickness 2.0 mm ± 0.1 mm

Incident angle 14 ° ± 2 °

Material Fused silica, N-BK7, or equivalent

Surface quality 60/40 on both surfaces

Parallelism � 20 arc seconds

Optical density Make sure the optical density of the optical filter glass is big enough to 

block the wavelengths of the installed lasers to decrease the 

background noise.
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Custom Optical Filters

Installing a Custom Optical Filter  
Figure E.1  Optical Filter and the Optical Filter Support Holder

Before you start to install the custom optical filter glass piece, ensure the following items are 
available:

 • Custom optical filter glass piece

 • Optical filter mount

 • Optical filter support holder

 • 3.0-mm flat-head screw driver

 • Lens papers

 • Absolute ethanol

CAUTION

Risk of damage to the optical filter. When cleaning or replacing a filter, handle 

with care to avoid scratching the glass surface and to prevent the filter from 

falling. Use optical lens paper and absolute ethanol to clean the optical filters.

1 Place the new custom optical filter glass piece on a piece of clean lens paper. 

2 Moisten a piece of lens paper with several drops of absolute ethanol. 

1. Optical filter mount

2. Optical filter glass piece

3. Optical filter support holder

b dc
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Custom Optical Filters

Installing a Custom Optical Filter  E
3 Using the moistened lens paper gently clean any spots on the surface of the optical filter glass 

piece and the optical filter mount socket.

4 Allow the custom optical filter glass piece to dry and check the optical filter glass piece for 

streaks.

NOTE If streaks remain, repeat Steps 2-3 until the custom optical filter glass piece is clean. If the optical 

filter glass piece is scratched, replace the optical filter glass piece as needed.

5 Using the 3.0-mm flat-head screwdriver, loosen the screw on the optical filter mount.
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Custom Optical Filters

Installing a Custom Optical Filter  
CAUTION

Risk of damage to the optical filter glass piece. Push the optical filter glass piece 

straight into the optical filter mount socket carefully. Inserting the optical filter 

glass piece at an angle could chip the edge of the optical filter glass piece.

CAUTION

Risk of damage to the optical filter glass piece. Do not touch the filter glass piece. 

Touching the optical filter glass can obscure and/or scratch the optical filter. 

Always handle the optical filter glass piece with lens paper.

6 Push the clean optical filter glass piece straight into the optical filter mount socket with the 

band pass coating surface facing down. 

NOTE If you are unsure about which surface is the band pass coating surface, consult the supplier of 

your custom filter glass piece.

7 Using the 3.0-mm flat-head screw driver, fasten the screw on the filter mount. Do not fully 

tighten the screw until adjustments are completed below.
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Installing a Custom Optical Filter  E
CAUTION

Risk of damage to the optical filter. Push the filter all the way into the supporting 

holder carefully. Inserting the filter at an angle could chip the edge of the filter 

glass piece.

8 Slide the optical filter into the optical filter support holder slot until it touches the back of the 

holder. 

9 Hold the optical filter and tighten the screw using the 3-mm flat-head screw driver.

10 If necessary, label the filter mount with the corresponding band pass information.

11 Install the optical filter into the WDM. Refer to Replacing the Optical Filter in CHAPTER 11, 

Replacement/Adjustment Procedures.
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Custom Optical Filters

Installing a Custom Optical Filter  
12 Edit the detector configuration to ensure the correct display of axis labels. Refer to Verifying, 

Selecting, Editing, and Creating Detector Configuration in CHAPTER 5, Data Acquisition and 
Sample Analysis.

13 Run QC to check whether the custom filter has impacted the performance of the default 

channels. Refer to CHAPTER 4, Instrument Quality Control and Standardization.

NOTE QC will not provide a result for laser-filter combinations that do not have a target value.

14 If necessary, you need to adjust the filter screw slightly and repeat QC until optimal 

performance is achieved. Refer to Step 9 and Steps 11-13. 
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APPENDIX F

Table of Hazardous Substances

Table of Hazardous Substances

The Hazardous Substances Names and Concentration are shown in Table F.1, Table F.2, and 
Table F.3.
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 多溴联苯 
(PBB)

多溴二苯醚
(PBDE)

O O

O O

O O

O O

O O

O O

O O

O O

O O

O O

O O

O O

low the limit requirements in GB/T 26572.

this part in above the limit requirement in 
Table F.1  Table of Hazardous Substances Name and Concentration [CytoFL

电子电气产品号码 
EEP Part Number: A00-1-1102                                

产品名称 Product Name: CytoFLEX
产品型号 Product Model Number: A00-1-1102

部件名称

Component Name

有毒有害物质或元素 Hazardous Sub

铅 
(Pb)

汞 
(Hg)

镉 
(Cd)

六价铬

(Cr6+)

印刷电路板组件 Circuit Boards X O O O

电源组件 Power Supplies O O O O

计算机 Computer O O O O

功率调节器 Power Conditioner O O O O

光量传感器 Optical Sensors O O O O

激光 Laser O O O O

发动机/泵/阀门/ Motors/Pumps/Valves O O O O

电线 Cables X O O O

管路及橡胶 Tubing & Rubber O O O O

塑料部件 Plastic O O O O

连接部件 Hardware O O O O

包装材料 Packing Material O O O O

This table is prepared in accordance with the provisions of SJ/T 11364

○：表示该有毒有害物质在该部件所有均质材料中的含量均在GB/T 26572标准规定的限量要求以下

x: 表示该有毒有害物质至少在该部件的某一均质材料中的含量超出GB/T 26572标准规定的限量要求

（企业可在此处，根据实际情况对上表中打“×”的技术原因进行进一步说明)

O: Indicates that the toxic or hazardous substances contained in all of the homogenous materials for this part is be

X: Indicates that the toxic or hazardous substance contained in at least one of the homogenous materials used for 
GB/T 26572.
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ces Name

多溴联苯 
(PBB)

多溴二苯醚
(PBDE)

O O

O O

O O

O O

O O

O O

O O

O O

O O

O O

O O

O O

 the limit requirements in GB/T 26572.

 part in above the limit requirement in 
Table F.2  Table of Hazardous Substances Name and Concentration [CytoFLEX

电子电气产品号码 

EEP Part Number: B90883                          

产品名称 Product Name: CytoFLEX LX
产品型号 Product Model Number: B90883

部件名称

Component Name

有毒有害物质或元素 Hazardous Substan

铅 

(Pb)

汞 
(Hg)

镉 
(Cd)

六价铬 

(Cr6+)

印刷电路板组件 Circuit Boards X O O O

电源组件 Power Supplies O O O O

计算机 Computer O O O O

功率调节器 Power Conditioner O O O O

光量传感器 Optical Sensors O O O O

激光 Laser X O O O

发动机/泵/阀门/ Motors/Pumps/Valves O O O O

电线 Cables X O O O

管路及橡胶 Tubing & Rubber O O O O

塑料部件 Plastic O O O O

连接部件 Hardware X O O O

包装材料 Packing Material O O O O

This table is prepared in accordance with the provisions of SJ/T 11364

○：表示该有毒有害物质在该部件所有均质材料中的含量均在GB/T 26572标准规定的限量要求以下

x: 表示该有毒有害物质至少在该部件的某一均质材料中的含量超出GB/T 26572标准规定的限量要求

（企业可在此处，根据实际情况对上表中打“×”的技术原因进行进一步说明)

O: Indicates that the toxic or hazardous substances contained in all of the homogenous materials for this part is below

X: Indicates that the toxic or hazardous substance contained in at least one of the homogenous materials used for this
GB/T 26572.
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EX LX 355]

stances Name

 多溴联苯 
(PBB)

多溴二苯醚
(PBDE)

O O

O O

O O

O O

O O

O O

O O

O O

O O

O O

O O

O O

low the limit requirements in GB/T 26572.

this part in above the limit requirement in 
Table F.3  Table of Hazardous Substances Name and Concentration [CytoFL

电子电气产品号码 
EEP Part Number: C06779                         

产品名称 Product Name: CytoFLEX LX 355
产品型号 Product Model Number: C06779

部件名称

Component Name

有毒有害物质或元素 Hazardous Sub

铅 
(Pb)

汞 
(Hg)

镉 
(Cd)

六价铬

(Cr6+)

印刷电路板组件 Circuit Boards X O O O

电源组件 Power Supplies O O O O

计算机 Computer O O O O

功率调节器 Power Conditioner O O O O

光量传感器 Optical Sensors O O O O

激光 Laser X O O O

发动机/泵/阀门/ Motors/Pumps/Valves O O O O

电线 Cables X O O O

管路及橡胶 Tubing & Rubber O O O O

塑料部件 Plastic O O O O

连接部件 Hardware X O O O

包装材料 Packing Material O O O O

This table is prepared in accordance with the provisions of SJ/T 11364

○：表示该有毒有害物质在该部件所有均质材料中的含量均在GB/T 26572标准规定的限量要求以下

x: 表示该有毒有害物质至少在该部件的某一均质材料中的含量超出GB/T 26572标准规定的限量要求

（企业可在此处，根据实际情况对上表中打“×”的技术原因进行进一步说明)

O: Indicates that the toxic or hazardous substances contained in all of the homogenous materials for this part is be

X: Indicates that the toxic or hazardous substance contained in at least one of the homogenous materials used for 
GB/T 26572.



Abbreviations

The following list is a composite of the symbols, abbreviations, acronyms, and reference 
designators either used in this manual or related to the information in it. When the same 
abbreviation (or reference designator) is used for more than one word (or type of component), all 
meanings relevant to this manual are included, separated by semicolons.

' — foot

“ — inch

% — percent

°C — degrees Celsius

°F — degrees Fahrenheit

± — plus or minus

< — less than

> — greater than

� — less than or equal to

μ — micron

μL — microliters

μm — micrometer

A — ampere

AC — alternating current

APC — Allophycocyanin

APC-A700 — Allophycocyanin-Alexa 
Fluor™ 700 tandem dye

APC-A7500 — Allophycocyanin-Alexa 
Fluor™ 750

APC-Cy7 — Allophycocyanin-Cyanin 7

API — Application Programming Interface

Acq. — Acquisition

BCI — Beckman Coulter Incorporated

BMP — bitmap

BP — band-pass filter

CDRH — Center for Devices and Radiological 
Health

CFSE — carboxyfluorescein succinmidyl ester

cm — centimeters

CSV — comma separated value

CV — coefficient of variation

DNA — deoxyribonucleic acid

DW — deep well

ECD — Energy Coupled Dye

EFUP — Environmentally friendly Use Period

EMF — enhanced metafile format

EMR — electromagnetic radiation

FAPD — Fiber Array Photo Detector

FCS — flow cytometry standard

FITC — Fluorescein isothiocyanate

FSC — forward scatter

GB — gigabyte

GHz — gigahertz

Gr Wt — gross weight

H — humidity

Hz — hertz

IEC — International Electrotechnical 
Commission

IR — infrared
B49006AM   Abbreviations-1



Abbreviations

  
kg — kilograms

KO — Krome Orange

LED — light emitting diode

L — liter

LJ — Levey-Jennings

LWH — length, width, height

m — meter

MB — megabyte

MFI — median fluorescence intensity

MHz — megahertz

min — minute

mL — milliliter

mm — millimeter

mW — milliwatt

NA — numerical aperture

NaClO — sodium hypochlorite solution

NaN3 — sodium azide

nm — nanometer

Nt Wt — net weight

PB — Pacific Blue™ dye

PC5 — Phycoerythrin-Cy™5 tandem dye

PC5.5 — Phycoerythrin-Cy™5.5 tandem dye

PC7 — Phycoerythrin-Cy™7 tandem dye

PE — Phycoerythrin

PEEK — polyether ether ketone

PerCP — Peridinin-Chlorophyll

PI — Propidium Iodide

PN — part number

QC — quality control

RAM — random access memory

rCV — robust coefficient of variation

RH — relative humidity

RoHS — Restriction of Hazardous Substances 
Directive

RPTM — real-time messaging protocol

S/N — serial number

SNR — signal to noise ratio

SSC — side scatter

USB — universal serial bus

UV — ultraviolet

V — volts

VA — volt-ampere

VAC — voltage alternating current

VSSC — violet side scatter

WDM — wavelength division multiplexer

W — watts
B49006AM   Abbreviations-2



Index

Symbols
’

define, Abbreviations-1
"

define, Abbreviations-1
°C

define, Abbreviations-1
°F

define, Abbreviations-1
μ

define, Abbreviations-1
μL

define, Abbreviations-1
μm

define, Abbreviations-1
±

define, Abbreviations-1
<

define, Abbreviations-1
>

define, Abbreviations-1

Numerics
10 L sheath fluid cubitainer

replacing, 11-7
10 L waste cubitainer (CytoFLEX LX)

emptying, 11-11
4 L sheath fluid container

to clean, 10-10
4 L sheath fluid container (cleaning)

routine maintenance, 10-10
4 L sheath fluid container (CytoFLEX)

filling, 11-6
4 L waste container

to clean, 10-11
4 L waste container (cleaning)

routine maintenance, 10-11
4 L waste container (CytoFLEX)

emptying, 11-10

A
A

define, Abbreviations-1
about this manual, xxxi
AC

define, Abbreviations-1
account

locking, 3-9
unlock, 2-27

account menu, 2-21
account policies, 2-31
acoustic noise level, 1-32
Acq.

define, Abbreviations-1
acquisition screen, 2-3

collection, 2-5
navigation, 2-4
plot area, 2-8
status bar, 2-9
test tubes, 2-7

acquisition settings
to configure, 5-40

add
vertex to auto polygon gate, 5-54

adding
Deep Clean solution, 11-17
standardization item, 4-28

adding channels
for compensation, 6-21

adjust compensation
manually, 6-16

adjusting
autogate movement, 5-55
compensation, 6-16
compensation settings, 7-8
gain, 5-60
threshold, 5-62

adjusting auto gates, 5-52
adjustment

nonscheduled, 11-61
routine, 11-2

advanced menu, 2-20
alarm
  Index-1
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Fluidics module, 1-13
mute, 1-13

alarm does not sound when the waste container 
is full or the sheath fluid container is low 
and the software status display is 
red, 9-12

alerts
caution define, xiii
important define, xiii
note define, xiii
warning define, xiii

analysis
screen, 7-1

analysis screen, 2-9
to open, 7-3

analyzing
data, 5-70

APC
define, Abbreviations-1

APC-A7500
define, Abbreviations-1

APC-Cy7
define, Abbreviations-1

API
define, Abbreviations-1

applying
standardization in QC, 4-30

auto gates
adjusting, 5-52
creating, 5-52

auto polygon gate
add vertex, 5-54

auto recalculate
turn off, 5-54
turn on, 5-54

auto shutdown, 5-8, 8-2, 10-6
auto startup, 8-2
autogate

adjusting movement, 5-55
extent, 5-56
movement, 5-55

autosampling system
Deep Clean solution peristaltic pump, 1-13

B
backflush settings

to change, 11-76
backup, 9-24

manual injection mode, 3-10

band-pass filter, 1-7, 1-8, Abbreviations-1
band-pass filters, 1-6
BCI

define, Abbreviations-1
Beckman Coulter Customer Support Center, 

contacting, ii
BMP

define, Abbreviations-1
bold face font

conventions, xxxiii
bottle

Deep Clean solution, 1-13
BP

define, Abbreviations-1

C
calculating

compensation values, 6-8, 6-13
concentration, 7-7
sample volume, 7-7

calculation of the automatic compensation 
experiment is incorrect, 9-18

calculations
compensation, 6-1

calibrating
plate position [with plate loader], 11-78
sample flow rate, 11-61
sample flow rate with plate loader, 11-65

call center, contact inforrmation, ii
caution

define, xiii
caution label

RoHS, 9-9
CDRH

define, Abbreviations-1
CFSE

define, Abbreviations-1
change

password, 2-27
changing

mixer and backflush settings, 11-76
tube name, 5-40

changing sample probe
from plate loader to single tube sample 

station, 11-43
from single tube sample station to plate 

loader, 11-38
channel

to set, 5-40
  Index-2
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channels
adding for compensation, 6-21
fluorescence, 5-30, 5-31
to set, 5-40

characteristics
performance, 1-35

check
waste and reagent levels (10 L fluid 

cubitainers), 3-4
waste and reagent levels (4 L fluid 

containers), 3-2
cleaning

4 L sheath fluid container, 10-10
4 L waste container, 10-11
nonscheduled, 10-13
routine, 10-1
sample probe, 10-8
sample station, 10-7
surfaces, 10-13

cleaning and ventilation
installation environment validation, A-2

cleaning solution
to prepare, 8-1

cleaning the 4 L sheath fluid container
routine maintenance, 10-10

cleaning the 4 L waste container
routine maintenance, 10-11

cleaning the sample station
routine maintenance, 10-7

closed file system
electronic record management, B-2

cm
define, Abbreviations-1

collecting
data, 5-36
QC data, 4-11
QC data with plate loader, 4-14

collection
acquisition screen, 2-5

collection conditions
to set, 5-63

compensation
adding channels, 6-21
calculations, 6-1
to adjust, 6-16
to manually adjust, 6-16

compensation controls
compensation experiment screen, 2-11

compensation experiment
to create, 6-2

compensation experiment screen, 2-10
compensation controls, 2-11

compensation experiment with plate loader
creating, 6-10

compensation library
to manage, 6-20

compensation matrix
to create from previously acquired 

data, 6-14
to generate, 6-4, 6-13

compensation sample
prepare, 6-4, 6-13

compensation settings
adjust, 7-8
exporting, 6-19
importing and exporting, 5-80

compensation settings from compensation 
library

to import, 6-17
compensation settings from compensation 

matrix files
to import, 6-16

compensation values
to calculate, 6-8, 6-13

components
Cytometer, 1-2
Fluid Containers/Cubitainers, 1-2
fluidics system, 1-11
instrument, 1-1
main, 1-2
optical, 1-4
plate holder, 1-21
plate loader, 1-17
sample injection mode control kit, C-2
Workstation, 1-2

concentration
calculation, 7-7
sample volume, 7-7

concentration calculation is incorrect, 9-19
concluding

experiment, 5-83
configuration

system, 1-25
configuring

acquisition settings, 5-40
confirming results, 4-18
connection indicator light in the lower left 

corner of the software screen is red and 
displays Disconnected and Error, 9-11

contact information, Beckman Couter Customer 
  Index-3
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Support Center, ii
conventions

bold face font, xxxiii
the term press, xxxiii
the term select, xxxiii

conventions used, 1-xxxiii
copying

experiments, 7-1
previously acquired experiment, 7-1

create a compensation experiment
start page operations, 2-2

create a new experiment from a template
start page operations, 2-2

create a new screen
start page operations, 2-2

creating
compensation experiment, 6-2
compensation experiment with plate 

loader, 6-10
compensation matrix from previously 

acquired data, 6-14
detector configuration, 5-29
dot plot overlays, 7-5
heat map (plate loader), 5-18
histogram overlays, 7-5
Levey-Jennings charts, 4-22
new experiment, 5-1
new experiment with plate loader, 5-3
plots and gates, 5-43
user roles, 2-29
users, 2-25

creating auto gates, 5-52
CSV

define, Abbreviations-1
custom filter, E-1
custom statistics

setting, 5-67
customer-replaceable parts

ordering, F-1
customized parameters

setting, 5-66
CV

define, Abbreviations-1
CytExpert

installation options, A-12
CytExpert API test client

setup, 2-48
CytExpert software

reinstall, A-30

upgrade, A-25

instrument, 1-30
dimensions, 1-30

instrument, 1-31
dimensions, 1-31
Cytometer, 1-2, 1-3, A-6
Cytometer cannot be turned on, 9-11
cytometer menu, 2-17

D
daily shutdown

routine maintenance, 10-1
daily shutdown with plate loader

routine maintenance, 10-5
daily start up

routine maintenance, 10-1
daily start up with plate loader

routine maintenance, 10-5
data

analyzing, 5-70
collecting, 5-36
exporting, 5-70
sampling, 5-36
to import, 7-1

data populations are normal on one laser, but 
too low on another laser, 9-16

data populations are not where they are 
expected, 9-17

data sheets, material safety
how to order, 1-29

Deep Clean
procedure, 10-8
routine maintenance, 10-8

Deep Clean solution
to add, 11-17
to prepare, 11-17

Deep Clean solution bottle
fluidics module, 1-13

Deep Clean solution peristaltic pump
autosampling system, 1-13

default
detector configuration, 5-30

default password, 2-24, A-25
default username

username
default, A-25

define
  Index-4
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%, Abbreviations-1
caution, xiii
important, xiii
note, xiii
quality control (QC), 4-1
symbols, -xv
warning, xiii

defining the negative population, 6-4
delete

experiment directory (electronic record 
management), B-4

heat map parameter, 5-20
deleting

heat map (plate loader), 5-27
standardization items, 4-30
user roles, 2-30
users, 2-26

detector (WDM)
optical components, 1-4

detector configuration
to create, 5-29
to edit, 5-29
to select, 5-29
to verify, 5-29

detector configuration default, 5-30
detector unit

wavelength division multiplexor (WDM), 1-5
disabling lasers, 5-59
disinfection

surfaces, 10-13
disposal

precaution, 9-10
waste, A-4

DNA
define, Abbreviations-1

document overview, xxxi
dot plot overlays

to create, 7-5
dual-parameter plots, 2-34
DW

define, Abbreviations-1

E
ECD

define, Abbreviations-1
editing

detector configuration, 5-29
standardization item parameters, 4-29

EFUP

define, Abbreviations-1
electronic devices

fuse, 1-26, 1-28
load button, 1-26, 1-28
power switch, 1-26, 1-28

electronic record management
closed file system, B-2
electronic signature, B-17
experiment directory management, B-3
experiment management, B-2
experiment operation log, B-12
experiment related operations, B-5
exporting an experiment/template, B-9
folder hierarchy management, B-4
importing an experiment/template, B-6
log, B-12
software menu, B-1
system operation log, B-15
user management, B-26
user management operation log, B-16

electronic signature
electronic record management, B-17
retract, B-20

EMF
define, Abbreviations-1

emptying
10 L waste cubitainer (CytoFLEX LX), 11-11
4 L waste container (CytoFLEX), 11-10

EMR
define, Abbreviations-1

enabling lasers, 5-59
environment validation

installation, A-2
environment validation (installation)

power source, A-3
temperature and humidity, A-4
ventilation and cleaning, A-2
worktable, A-2

environmental label
RoHS, 9-10

exit the software
start page operations, 2-2

experiment
concluding, 5-83
sign, B-17

experiment (new)
creating, 5-1

experiment directory (electronic record 
management)

delete, B-4
  Index-5
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rename, B-4
setup, B-3

experiment directory management
electronic record management, B-3

experiment management
electronic record management, B-2

experiment operation log
electronic record management, B-12

experiment related operations
electronic record management, B-5

experiment saving, 5-83
experiment selection

start page, 3-27
experiment settings, 2-45
experiment signature

print, B-25
experiments

to copy, 7-1
exporting

compensation settings, 5-80, 6-19
data, 5-70
FCS files, 5-75
heat map (plate loader), 5-27
instrument settings, 5-78, 5-79
plots of multiple tubes as picture files, 5-78
results, 7-9
statistics table of multiple tubes as a picture 

file, 5-78
user logs, 2-33

exporting and experiment/template
electronic record management, B-9

extent
autogate, 5-56

F
FAPD

define, Abbreviations-1
FCS

define, Abbreviations-1
FCS files

exporting, 5-75
files menu, 2-15
filling

4 L sheath fluid container (CytoFLEX), 11-6
filling sheath fluid container, 3-2
filter, E-1

optical, 1-5
sheath fluid, 1-13

FITC

define, Abbreviations-1
flow cell

to prime, 11-48
flow cell waste out

fluidic connection, 1-14, 3-3, 3-5
Fluid Container holder, 1-11
Fluid Containers, 1-2, 1-3, A-6
Fluid Containers/Cubitainers

component, 1-2
fluidics system, 1-12
fluidics system component, 1-11

fluid sensor holder cutout, 1-11
fluid status information displays red for Sheath 

and/or Waste even though the sheath 
fluid container is full and the waste 
container is empty, 9-13

fluidic connections
flow cell waste out, 1-14, 3-3, 3-5
sheath fluid in, 1-14, 3-3, 3-5
sheath fluid level sensor connector, 1-14, 

3-3, 3-5
sheath return, 1-14, 3-3, 3-5
waste level sensor connector, 1-14, 3-3, 3-5
waste out, 1-14, 3-3, 3-5

Fluidics module
alarm, 1-13

fluidics module
Deep Clean solution bottle, 1-13
fluidics system, 1-13
fluidics system component, 1-11
sheath fluid filters, 1-13

fluidics system
components, 1-11
Fluid Containers/Cubitainers, 1-12
fluidics module, 1-13

fluidics system components
Fluid Containers/Cubitainers, 1-11
fluidics module, 1-11

fluorescence channels, 5-30, 5-31
folder hierarchy management

electronic record management, B-4
four-quadrant gates

for dual-parameter plots, 2-35
front cover

removal, 11-2
FSC

define, Abbreviations-1
functions

software, 2-1
  Index-6
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fuse
electronic devices, 1-26, 1-28
to replace, 11-72

G
gain

to adjust, 5-60
gate settings, 2-47
gates

to create, 5-43
gates for dual-parameter plots

four-quadrant gates, 2-35
lasso gates, 2-35
polygon gates, 2-35
rectangle gates, 2-35

gates for single-parameter plots
line-segment gates, 2-35
vertical gates, 2-35

GB
define, Abbreviations-1

generating
compensation matrix, 6-4, 6-13

Ghz
define, Abbreviations-1

Gr. Wt.
define, Abbreviations-1

graphic and gating styles, 2-34
graphics

printing, 5-80

H
H

define, Abbreviations-1
hazard

laser, 9-1
hazards

laser beam, 9-2
radiation, 9-3

hazards/precautions, 9-1
heat map (plate loader)

creating, 5-18
deleting, 5-27
exporting, 5-27
modifying, 5-26
refreshing, 5-25

heat map parameter
deleting, 5-20

help menu, 2-22

help, Beckman Coulter Customer Support 
Center, ii

histogram overlays
to create, 7-5

how to
use your manual, xxxi

humidity and temperature
installation environment validation, A-4

Hz
define, Abbreviations-1

I
IEC

define, Abbreviations-1
important

define, xiii
importing

compensation settings, 5-80
compensation settings from compensation 

library, 6-17
compensation settings from compensation 

matrix files, 6-16
data, 7-1
instrument settings, 5-78, 5-79
lot-specific target values, 4-5
previously acquired data, 7-1
standardization item, 4-30

importing an experiment/template
electronic record management, B-6

information
ordering, 1-29

initializing the instrument, 3-28
inspecting materials

unpacking, A-4
inspection

liquid flow tubing, 11-47
pre-boot, 3-1

inspection when unpacking, A-4
installation

environment validation, A-2
instrument, A-1
software, A-12

installation category, 1-31
installation options

CytExpert, A-12
installing

custom filter, E-1
instrument configuration file, A-22
Plate Loader module, 11-51
  Index-7
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software, A-13
installing the instrument and connecting the 

equipment
unpacking inspection, A-5, A-11

instrument
components, 1-1
initializing, 3-28
inspecting materials, A-4
installation, A-1
maintenance, 11-1
parameters, 1-32
shut off, 8-1
transportation and storage, A-1
unpacking, A-4

instrument characteristics, 1-30
instrument components

Cytometer, 1-2
Fluid Containers/Cubitainers, 1-2
Workstation, 1-2

instrument configuration
unpacking inspection, A-4

instrument configuration file
to install, A-22

instrument dimensions, 1-30, 1-31
instrument operations cannot be performed in 

the Acquisition screen, 9-20
instrument settings

exporting, 5-79
importing, 5-79
importing and exporting, 5-78

instrument specifications, 1-30
instrument transport or storage

to prepare, 10-14
IR

define, Abbreviations-1
items

adding for standardization, 4-28
deleting for standardization, 4-30
editing for standardization, 4-29
importing for standardization, 4-30

K
kg

define, Abbreviations-2
KO

define, Abbreviations-2

L
L

define, Abbreviations-2
label

RoHS caution, 9-9
RoHS environmental, 9-10

labels
disposal of electrical instrumentation, 

warning, 9-9
RoHS caution, 9-9
RoHS environmental, 9-10
to set, 5-40

language settings, 2-48
laser

hazards, 9-1
settings, 5-57
standardizing target values, 4-27
target power settings (CytoFLEX LX 

only), 5-59
laser beam

hazards, 9-2
laser delay

to set, 11-69
laser delay values are out of range, 9-15
laser lines, 1-32
laser power is low, 9-14
laser target power settings (CytoFLEX LX 

only), 5-59
laser wavelength, 1-32
lasers

disable, 5-59
enable, 5-59

lasso gates
for dual-parameter plots, 2-35

launching the software, 2-1
LED

define, Abbreviations-2
Levey-Jennings charts

to create, 4-22
line segment gates

for single-parameter plots, 2-35
liquid flow tubing

inspection, 11-47
liquid flow tubing inspection

routine maintenance, 11-47
LJ

define, Abbreviations-2
load button

electronic devices, 1-26, 1-28
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locking
account, 3-9

log
electronic record management, B-12
user management operation, 2-33

log in
software, 3-6

log menu, 2-22
logs

exporting, 2-33
viewing, 2-33

lot-specific target values
to import, 4-5

LWH
define, Abbreviations-2

M
m

define, Abbreviations-2
main components, 1-2
maintenance

instrument, 11-1
See also routine maintenance; nonscheduled 

maintenance
maintenance reminder

to manage, 11-14
managing

compensation library, 6-20
maintenance reminder, 11-14

manual
about, xxxi
adjust compensation, 6-16

manual injection mode
running small sample volumes, 3-10

manuals
updating, iii

material safety data sheets (MSDS/SDS)
how to order, 1-29

MB
define, Abbreviations-2

menu
account, 2-21
acquisition and analysis screen, 2-15
advanced, 2-20
cytometer, 2-17
files, 2-15
help, 2-22
log, 2-22
QC/Standardization, 2-20

settings, 2-19
signature, 2-22
software, 2-14

menu tree
software, 2-14

MFI
define, Abbreviations-2

MHz
define, Abbreviations-2

min
define, Abbreviations-2

mixer is not functioning, 9-20
mixer settings

to change, 11-76
mL

define, Abbreviations-2
mm

define, Abbreviations-2
modifying

heat map (plate loader), 5-26
user roles, 2-30
users, 2-26
well settings with plate loader, 5-14

modifying well settings, 5-14
applying existing well settings to additional 

wells, 5-15
moving well location [with plate 

loader], 5-16
movement

adjusting for autogates, 5-55
autogate, 5-55

moving
well location [with plate loader], 5-16

MSDS (material safety data sheets)
how to order, 1-29

multiple tube plots
export as picture files, 5-78

multiple tube statistics table

export as picture files, 5-78
mute

alarm, 1-13
mute alerter icon, 1-13
mW

define, Abbreviations-2

N
NA

define, Abbreviations-2
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NaClO
define, Abbreviations-2

NaN3
define, Abbreviations-2

navigation
acquisition screen, 2-4
QC screen, 2-13

negative population
to define using unstained samples, 6-4

new experiment
creating, 5-1

new experiment with plate loader
creating, 5-3

nm
define, Abbreviations-2

no changes occurred after manually adjusting 
compensation settings, 9-17

no data acquisition, 9-16
nonscheduled cleaning, 10-13
nonscheduled maintenance

adding the Deep Clean solution, 11-17
calibrating the sample flow rate, 11-61
calibrating the sample flow rate with plate 

loader, 11-65
cleaning the sample probe, 10-8
preparing the instrument for storage or 

transport, 10-14
replacing the fuse, 11-72
replacing the optical filter, 11-70

nonscheduled replacement/adjustment, 11-61
note

define, xiii
Nt. Wt.

define, Abbreviations-2

O
open a compensation experiment

start page operations, 2-2
open an experiment

start page operations, 2-2
open software, 3-6
opening

analysis screen, 7-3
optical

components, 1-4
optical bench

optical component, 1-4
optical components

detector (WDM), 1-4

optical bench, 1-4
optical fiber, 1-4

optical fiber, 1-10
optical filter, 1-5

to replace, 11-70
ordering

customer-replaceable parts, F-1
ordering information, 1-29
overlay dot plots, 2-34
overlay histograms, 2-34
overview

document, xxxi

P
page setup settings, 2-47
parameter (heat map)

delete, 5-20
parameters

editing standardization items, 4-29
instrument, 1-32

password
change, 2-27
default, 2-24, A-25
reset, 2-27

PB
define, Abbreviations-2

PC5
define, Abbreviations-2

PC5.5
define, Abbreviations-2

PC7
define, Abbreviations-2

PE
define, Abbreviations-2

PEEK
define, Abbreviations-2

PerCP
define, Abbreviations-2

performance characteristics, 1-35
sample injection mode control knob, C-1

performing
daily quality control, 4-1

PI
define, Abbreviations-2

picture files
to export, 5-78

plate holder
components, 1-21

plate holder with plate loader
  Index-10
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replacing, 11-49
plate loader

components, 1-17
Plate Loader module

installing, 11-51
removing, 11-51

plate loader PEEK tubing
replacing, 11-32

plate loader PEEK tubing (replacing)
routine maintenance, 11-32

plate position [with plate loader]
calibrating, 11-78

plate type, 2-36
plate type library, 2-36
plot area

acquisition screen, 2-8
plot display conditions

to set, 5-65
plot settings, 2-46
plots

dual-parameter, 2-34
overlay dot plots, 2-34
overlay histograms, 2-34
single-parameter, 2-34
to create, 5-43
to set, 7-3

PN
define, Abbreviations-2

policies
account, 2-31

pollution degree, 1-32
polygon gates

for dual-parameter plots, 2-35
population amplitude is decreasing and CV 

values are increasing, 9-15
populations are drifting, 9-14
position

sample tube holder, 1-16
power source

installation environment validation, A-3
power source inspection

pre-boot, 3-5
power switch

electronic devices, 1-26, 1-28
pre-boot inspection, 3-1

check waste and reagent levels (10 L fluid 
cubitainers), 3-4

check waste and reagent levels (4 L fluid 
containers), 3-2

power source inspection, 3-5

workstation connections inspection, 3-5
precaution

disposal, 9-10
precautions

safety, -xiv
precautions/hazards, 9-1
preparation process

QC sample (CytoFLEX Daily IR QC 
Fluorospheres), 4-3

QC sample (CytoFLEX Daily IR QC 
Fluorospheres) with plate loader, 4-5

QC sample (CytoFLEX Daily QC 
Fluorospheres), 4-3

QC sample (CytoFLEX Daily QC 
Fluorospheres) with plate loader, 4-4

preparing
compensation sample, 6-4, 6-13
Deep Clean solution, 11-17
instrument for storage or transport, 10-14
QC sample, 4-3
QC sample with plate loader, 4-4
the cleaning solution, 8-1

preparing QC sample
required materials, 4-3

preparing QC sample with plate loader
required materials, 4-4

press
conventions, xxxiii

previously acquired data
to import, 7-1

previously acquired experiment
to copy, 7-1

priming
flow cell, 11-48

print
experiment signature, B-25

printing
graphics, 5-80

procedure
Deep Clean, 10-8

product description, 1-1

Q
QC

applying standardization, 4-30
define, Abbreviations-2
laser target values, 4-27
result manager, 4-25

QC aborted due to low event rate, 9-21
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QC data
collecting, 4-11

QC data with plate loader
collecting, 4-14

QC experiment screen, 2-12, 2-13
QC failed, 9-22
QC menu tree

software, 2-15
QC report screen, 2-12
QC sample

preparation, 4-3
QC sample (CytoFLEX Daily IR QC 

Fluorospheres)
preparation process, 4-3

QC sample (CytoFLEX Daily IR QC 
Fluorospheres) with plate loader

preparation process, 4-5
QC sample (CytoFLEX Daily QC Fluorospheres)

preparation process, 4-3
QC sample (CytoFLEX Daily QC Fluorospheres) 

with plate loader
preparation process, 4-4

QC sample with plate loader
preparation, 4-4

QC screen
navigation, 2-13

QC software menu tree, 2-15
QC/Standardization menu, 2-20
quality control

perform daily, 4-1
quality control (QC)

define, 4-1

R
radiation

hazards, 9-3
RAM

define, Abbreviations-2
rCV

define, Abbreviations-2
reagent levels (10 L fluid cubitainers)

check, 3-4
reagent levels (4 L fluid containers)

check, 3-2
rectangle gates

for dual-parameter plots, 2-35
refreshing

heat map (plate loader), 5-25
reinstall

CytExpert software, A-30
reinstallation procedures

right-side cover, 11-5
removal procedures

front cover, 11-2
right-side cover, 11-4

removing
Plate Loader module, 11-51

rename
experiment directory (electronic record 

management), B-4
replacement

nonscheduled, 11-61
routine, 11-2

replacing
10 L sheath fluid cubitainer, 11-7
fuse, 11-72
optical filter, 11-70
plate holder with plate loader, 11-49
plate loader PEEK tubing, 11-32
sample peristaltic pump tubing for sample 

loading, 11-22
sheath fluid filter, 11-18
sheath fluid harness and/or waste 

harness, 11-74
replacing sheath fluid cubitainer, 3-4
replacing the peristaltic pump for sample 

loading
routine maintenance, 11-22

replacing the sample probe for plate loader
routine maintenance, 11-32

replacing the sheath fluid filter
routine maintenance, 11-18

required materials
QC sample preparation, 4-3
QC sample preparation with plate loader, 4-4
software installation, A-13

reset
password, 2-27

restore, 9-24
result manager

QC, 4-25
results

confirming, 4-18
to export, 7-9

retention period
setting, B-21

retract
electronic signature, B-20
  Index-12
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RH
define, Abbreviations-2

right-side cover
reinstallation, 11-5
removal, 11-4

RoHS
caution label, 9-9
define, Abbreviations-2
environmental label, 9-10

role management, 2-27
roles

creating, 2-29
deleting, 2-30
modifying, 2-30

routine cleaning, 10-1
routine maintenance

cleaning the 4 L sheath fluid container, 10-10
cleaning the 4 L waste container, 10-11
cleaning the sample station, 10-7
daily startup and shutdown, 10-1
daily startup and shutdown with plate 

loader, 10-5
Deep Clean, 10-8
liquid flow tubing inspection, 11-47
replacing the plate loader PEEK 

tubing, 11-32
replacing the sample peristaltic pump 

tubing for sample loading, 11-22
replacing the sheath fluid filter, 11-18

routine replacement/adjustment, 11-2
RPTM

define, Abbreviations-2
running

single positive control samples, 6-6
system startup program, 3-16
system startup program with plate 

loader, 3-19
running small sample volumes

manual injection mode, 3-10

S
S/N

define, Abbreviations-2
safety

precautions, -xiv
sample

checks before running, 5-28
sample acquisition position

sample tube holder position, 1-16

sample flow rate
calibrating, 11-61

sample flow rate is unstable, 9-13
sample flow rate with plate loader

calibrating, 11-65
sample injection control knob

performance characteristics, C-1
sample injection mode

selecting, 3-9
sample injection mode control kit

components, C-2
sample is flowing, but no signal appears in the 

plot, 9-18
sample loading

backup, 3-10
sample loading position

sample tube holder position, 1-16
sample peristaltic pump tubing

to replace, 11-22
sample peristaltic pump tubing for sample 

loading
to replace, 11-22

sample peristaltic pump tubing for sample 
loading (replacing)

routine maintenance, 11-22
sample probe

to clean, 10-8
sample probe change

from plate loader to single tube sample 
station, 11-43

from single tube sample station to plate 
loader, 11-38

sample probe for plate loader
replacing, 11-32

sample probe is too low, 9-19
sample probe switch

from plate loader to single tube sample 
station, C-5

from single tube sample station to plate 
loader, C-3

sample station, 1-15
to clean, 10-7

sample station (cleaning)
routine maintenance, 10-7

sample tube holder cannot move up and down 
automatically, 9-13

sample tube holder position
sample acquisition position, 1-16
sample loading position, 1-16
standby position, 1-16
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sample wells with plate loader
setting, 5-9

sampling
data, 5-36

sampling flow rate is too fast, 9-14
saving

experiment, 5-83
screen

acquisition, 2-3
analysis, 2-9, 7-1, 7-3
compensation experiment, 2-10
QC experiment, 2-12, 2-13
QC report, 2-12
software, 2-1

SDS (safety data sheets)
how to order, 1-29

select
conventions, xxxiii

selecting
detector configuration, 5-29
proper sample injection mode, 3-9

service, contact information, ii
setting

channel, 5-40
channels, 5-40
collection conditions, 5-63
custom statistics, 5-67
customized parameters, 5-66
labels, 5-40
laser delay, 11-69
laser target power settings (CytoFLEX LX 

only), 5-59
plot display conditions, 5-65
retention period, B-21
sample wells with sample wells, 5-9
signature, B-22
the plots and statistics, 7-3

setting up
violet side scatter channel (VSSC), 5-33

settings
acquisition, 5-40
experiment, 2-45
gate, 2-47
language, 2-48
laser, 5-57
page setup, 2-47
plot, 2-46
software, 2-45
tube, 2-46

settings menu, 2-19
setup

CytExpert API test client, 2-48
experiment directory (electronic record 

management), B-3
sheath fluid container, 1-11

to fill, 3-2
sheath fluid container 4 L (CytoFLEX)

filling, 11-6
sheath fluid container/cubitainer, 1-12
sheath fluid cubitainer

to replace, 3-4
sheath fluid cubitainer 10 L

replacing, 11-7
sheath fluid filter

to replace, 11-18
sheath fluid filter (replacing)

routine maintenance, 11-18
sheath fluid filters

fluidics module, 1-13
sheath fluid harness and sensor, 1-11, 1-12
sheath fluid in

fluidic connection, 1-14, 3-3, 3-5
sheath fluid level sensor connector

fluidic connection, 1-14, 3-3, 3-5
sheath return

fluidic connection, 1-14, 3-3, 3-5
shut off

the instrument, 8-1
shutdown

automatic, 5-8, 8-2, 10-6
shutdown daily

routine maintenance, 10-1
shutdown daily with plate loader

routine maintenance, 10-5
sign

experiment, B-17
signature

setting, B-22
signature menu, 2-22
single positive control samples

to run, 6-6
single-parameter plots, 2-34
SNR

define, Abbreviations-2
software

functions, 2-1
launching, 2-1
log in, 3-6
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main screen, 2-1
open, 3-6
to install, A-13
to start, A-25

software installation, A-12
installing CytExpert software, A-13
installing instrument configuration 

file, A-22
required materials, A-13
starting the software, A-25

software installation fails, 9-20
software menu, 2-14

acquisition and analysis screen menu, 2-15
electronic record management, B-1

software menu tree, 2-14
software operations

create a new experiment, 2-2
software screen, 2-1

start page, 2-2
start page operations, 2-2

software settings, 2-45
specifications

characteristics, 1-30
instrument, 1-30

SSC
define, Abbreviations-2

standardization, 4-26
applying in QC, 4-30
laser target values, 4-27

standardization item
adding, 4-28
deleting, 4-30
importing, 4-30

standardization item parameters
editing, 4-29

standby position
sample tube holder position, 1-16

start page
main software screen, 2-2
selecting experiments, 3-27

start page operations
create a compensation experiment, 2-2
create a new experiment from a 

template, 2-2
exit the software, 2-2
main software screen, 2-2
open a compensation experiment, 2-2
open an experiment, 2-2

starting
the software, A-25

startup
automatic, 8-2

startup daily
routine maintenance, 10-1

startup daily with plate loader
routine maintenance, 10-5

station
sample, 1-15

statistics
to set, 7-3

status bar
acquisition screen, 2-9

storing the instrument, A-1
support, Beckman Coulter customer, ii
surface

cleaning and disinfection, 10-13
switching sample probe

from plate loader to single tube sample 
station, C-5

from single tube sample station to plate 
loader, C-3

symbols
define, -xv

system configuration, 1-25
system operation log

electronic record management, B-15
system startup program

to run, 3-16
system startup program with plate loader

running, 3-19

T
table

troubleshooting, 9-11
target power settings (CytoFLEX LX only)

laser, 5-59
target values

laser standardization, 4-27
temperature and humidity

installation environment validation, A-4
test tubes

acquisition screen, 2-7
the term press

conventions, xxxiii
the term select

conventions, xxxiii
threshold

to adjust, 5-62
transporting the instrument, A-1
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troubleshooting, 9-1
alarm does not sound when the waste 

container is full or the sheath fluid 
container is low and the software status 
display is red, 9-12

calculation of the automatic compensation 
experiment is incorrect, 9-18

concentration calculation is incorrect, 9-19
connection indicator light in the lower left 

corner of the software screen is red and 
displays Disconnected and Error, 9-11

Cytometer cannot be turned on, 9-11
data populations are normal on one laser, 

but too low on another laser, 9-16
data populations are not where they are 

expected, 9-17
fluid status information displays red for 

Sheath and/or Waste even though the 
sheath fluid container is full and the 
waste container is empty, 9-13

instrument operations cannot be performed 
in the Acquisition screen, 9-20

laser delay values are out of range, 9-15
laser power is low, 9-14
mixer is not functioning, 9-20
no changes occurred after manually 

adjusting compensation settings, 9-17
no data acquisition, 9-16
population amplitude is decreasing and CV 

values are increasing, 9-15
populations are drifting, 9-14
QC aborted due to low event rate, 9-21
QC failed, 9-22
sample flow rate is unstable, 9-13
sample is flowing, but no signal appears in 

the plot, 9-18
sample probe is too low, 9-19
sample tube holder cannot move up and 

down automatically, 9-13
sampling flow rate is too fast, 9-14
software installation fails, 9-20
table, 9-11
wash station drips during backflush, 9-19
Workstation cannot be turned on, 9-11

tube
settings, 2-46

tube name
to change, 5-40

turn off

auto recalculate, 5-54
turn on

auto recalculate, 5-54
turning the power on, 3-6

U
unlock

user account, 2-27
unpacking inspection, A-4

check instrument configuration, A-4
installing the instrument and connecting 

the equipment, A-5, A-11
unpacking the instrument, A-4
unstained samples

to define the negative population, 6-4
upgrade

CytExpert software, A-25
USB

define, Abbreviations-2
use your manual

how to, xxxi
user account

unlock, 2-27
user management, 2-23

electronic record management, B-26
user management operation

log, 2-33
user management operation log

electronic record management, B-16
user roles

creating, 2-29
deleting, 2-30
modifying, 2-30

users
creating, 2-25
deleting, 2-26
modifying, 2-26

using unstained samples, 6-4
UV

define, Abbreviations-2

V
V

define, Abbreviations-2
VA

define, Abbreviations-2
VAC

define, Abbreviations-2
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ventilation and cleaning
installation environment validation, A-2

verifying
detector configuration, 5-29

vertex
add to auto polygon gate, 5-54

vertical gates
for single-parameter plots, 2-35

viewing
user logs, 2-33

violet side scatter channel (VSSC)
to set up, 5-33

VSSC
define, Abbreviations-2

W
W

define, Abbreviations-2
warning

define, xiii
wash station drips during backflush, 9-19
waste container, 1-11
waste container 4 L (CytoFLEX)

emptying, 11-10
waste container/cubitainer, 1-12
waste cubitainer 10 L (CytoFLEX LX)

emptying, 11-11
waste disposal, A-4
waste fluid harness and sensor, 1-11, 1-12
waste harness

to replace, 11-74
waste level sensor connector

fluidic connection, 1-14, 3-3, 3-5
waste levels (10 L fluid cubitainers)

check, 3-4
waste levels (4 L fluid containers)

check, 3-2
waste out

fluidic connection, 1-14, 3-3, 3-5
wavelength

laser, 1-32
wavelength division multiplexer (WDM), 1-5
WDM

define, Abbreviations-2
well settings with plate loader

modifying, 5-14
copying

wells, 5-15
cutting

wells, 5-15
modifying well settings

copying wells, 5-15
cutting wells, 5-15
pasting wells, 5-15

pasting
wells, 5-15

running
samples, 5-16

sample, 5-16
sample injection mode

selecting, 3-12
selecting

proper sample injection mode, 3-12
Workstation, 1-2, 1-3, A-6

component, 1-2
Workstation cannot be turned on, 9-11
workstation connections inspection

pre-boot, 3-5
worktable

installation environment validation, A-2
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Beckman Coulter, Inc.
Customer End User License Agreement

This Product contains software that is owned by Beckman Coulter, Inc. or its suppliers and is protected by 
United States and international copyright laws and international trade provisions. You must treat the 
software contained in this Product like any other copyrighted material. This license and your right to use the 
Product terminate automatically if you violate any part of this agreement.

This is a license agreement and not an agreement for sale. Beckman Coulter hereby licenses this Software to 
you under the following terms and conditions:

You May:

1. Use this software in the computer supplied to you by Beckman Coulter;
2. Maintain one copy of this software for backup purposes (the backup copy shall be supplied by Beckman 

Coulter);
3. After written notification to Beckman Coulter, transfer the entire Product to another person or entity, 

provided you retain no copies of the Product software and the transferee agrees to the terms of this 
license agreement.

You May Not:

1. Use, copy or transfer copies of this Software except as provided in this license agreement;
2. Alter, merge, modify or adapt this Software in any way including disassembling or decompiling;
3. Loan, rent, lease, or sublicense this Software or any copy.

Limited Warranty

Beckman Coulter warrants that the software will substantially conform to the published specifications for the 
Product in which it is contained, provided that it is used on the computer hardware and in the operating 
system environment for which it was designed. Should the media on which your software arrives prove 
defective, Beckman Coulter will replace said media free of charge within 90 days of delivery of the Product. 
This is your sole remedy for any breach of warranty for this software.

Except as specifically noted above, Beckman Coulter makes no warranty or representation, either expressed 
or implied, with respect to this software or its documentation including quality, performance, 
merchantability, or fitness for a particular purpose.

No Liability for Consequential Damages

In no event shall Beckman Coulter or its suppliers be liable for any damages whatsoever (including, without 
limitation, damages for loss of profits, business interruption, loss of information, or other pecuniary loss) 
arising out of the use of or inability to use the Beckman Coulter Product software. Because some states do not 
allow the exclusion or limitation of liability for consequential damages, the above limitation might not apply 
to you.

General

This agreement constitutes the entire agreement between you and Beckman Coulter and supersedes any 
prior agreement concerning this Product software. It shall not be modified except by written agreement 
dated subsequent to the date of this agreement signed by an authorized Beckman Coulter representative. 
Beckman Coulter is not bound by any provision of any purchase order, receipt, acceptance, confirmation, 
correspondence, or otherwise, unless Beckman Coulter specifically agrees to the provision in writing. This 
agreement is governed by the laws of the State of California.
B49006AM   Warranty-1
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